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HowWeb Intelligence performsbusiness
intelligence over the web

Web Intelligence provides business users with an easy to use interactive
and flexible user interface for building and analyzing reports on corporate
data over the web, on secured intranets and extranets. The Web Intelligence
software is installed by your administrator on a web server on your corporate
network.

To use Web Intelligence from your local computer, you log into the business
intelligence portal InfoView via your Internet browser. Then, depending on
your security profile, you can interact with the reports in corporate documents
or edit or build your own documents using a Web Intelligence report panel
or query panel.

HowWeb Intelligence performsbusiness
intelligence offline

Web Intelligence can be used offline as Web Intelligence Rich Client, a
standalone Microsoft Windows application, equivalent to the Java Report
Panel, that you can install on your computer. Web Intelligence Rich Client
lets you continue to work with Web Intelligence (WID) documents when you
are unable to connect to a CMS, when you want to perform calculations
locally rather than on the server, and when you want to work with Web
Intelligence documents without installing a CMS or application server.

Web Intelligence Rich Client can also be used when connected to a CMS.

InteractingwithWeb Intelligence reports
Depending on your security profile and on how Web Intelligence is deployed
across your organization, you can view, analyze, or enhance and modify the
data displayed on reports.
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Viewing and printing Web Intelligence reports

Once logged into the business intelligence portal InfoView, you can access
Web Intelligence documents and view reports. Onscreen navigation is made
easy with page-to-page navigation buttons and a document map that allows
you to jump from section to section or report to report.

The same document can provide the information adapted to each user due
to prompts that request each user, who opens the document, to specify the
data they want to return to the reports.

When you print, Web Intelligence automatically generates a copy of reports
in Portable Document Format (PDF) format for optimum print quality. You
can print reports directly from the Web Intelligence Java Report Panel or
Web Intelligence Rich Client without exporting to PDF.

Drilling on Web Intelligence reports

Drilling on Web Intelligence reports enables you to analyze the detailed data
behind the displayed results. You can turn the report you are viewing into a
drillable report or drill on a duplicate of the original report to retain a version
of the results before your drill analysis.

Once you have found the information you need, you can save a snapshot
of the drilled report to share the results of your analysis with other Web
Intelligence users, or save the document in Excel or Portable Document
(PDF) format to print or email to other business contacts.

Performing on-report analysis

Viewing Web Intelligence reports in Interactive view format enables you to
enhance reports and fine-tune the data reports contain, to highlight the
information that most interests you on demand.

On-Report Analysis is designed for:

• users who need to build queries and then want to build reports
• report consumers who need to manipulate the reports created by others
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With On-Report Analysis you can:

• view document metadata to understand the data behind reports and see
how reports are structured and filtered

• filter and sort results
• add new tables and charts
• add formulas and create variables
• format and change the layout of charts and tables
• slice and dice results by adding other data to charts and tables

Note:
On-report analysis of Web Intelligence reports in Interactive view format is
only available if your administrator has deployed Web Intelligence in JSP
mode.

Creating and editing Web Intelligence
documents

You can create or edit Web Intelligence documents using the Web Intelligence
HTML Report Panel, Web Intelligence Query - HTML, Web Intelligence in
Interactive mode, the Web Intelligence Java Report Panel and Web
Intelligence Rich Client.

Web Intelligence Query - HTML

Designed for users requiring a pure HTML environment to build queries,
Web Intelligence Query – HTML offers the ability to define the data content
of documents on multiple data sources. You can use Query – HTML to create
new documents from scratch or edit the queries in documents created using
any of the other Web Intelligence tools.

Used together with On-Report Analysis, Query – HTML provides a complete
solution for building queries and designing powerful reports in a pure HTML
environment. Once you have run the queries to generate a standard report,
you can leverage Web Intelligence On-Report Analysis features to format
multiple reports, add formulas, and create variables.
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Note:
Web Intelligence Query – HTML and On-Report Analysis in Interactive view
format are only available, if your administrator has deployed Web Intelligence
in JSP mode.

Web Intelligence Java Report Panel

The Java Report Panel is designed for users who need more flexibility with
designing report layout and defining formulas and variables. A graphical
Formula Editor enables you to build formulas rapidly using drag-and-drop.

Note:
The Web Intelligence Java Report Panel is available if your administrator
has deployed Web Intelligence in ASP mode and if your administrator has
deployed Web Intelligence in JSP mode.

Web Intelligence Rich Client

Web Intelligence Rich Client is a locally installed Microsoft Windows
application that lets you work with Web Intelligence (WID) documents that
are stored locally or in a CMS.

When working without a CMS connection you can work on your local machine
with either CMS-secured or unsecured documents.

Web Intelligence Rich Client is based on the Web Intelligence Java Report
Panel and provides equivalent document creation, editing, formatting, printing
and saving capabilities.

There are a number of reasons for using Web Intelligence Rich Client to
work with WID documents:

• You want to work with Web Intelligence documents but you are unable
to connect to a CMS (while traveling, for example).

• You want to improve calculation performance: Web Intelligence Rich
Client performs calculations locally, rather than on the server, and local
calculations can perform better than server calculations.

• You want to work with Web Intelligence documents without installing a
CMS or application server.
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Web Intelligence HTML Report Panel

Designed for users who need to build basic reports, the HTML Report Panel
provides query and report features in a simple wizard-like interface. Each
document is based on a single data source and can contain multiple reports,
displaying different subsets of information.

In addition, the HTML Report Panel is 508 compliant and can be customized
for specialized deployments.

Note:
The Web Intelligence HTML Report Panel is only available if your
administrator has deployed Web Intelligence in JSP mode.
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Accessing Web Intelligence
from InfoView

2



You access Web Intelligence reports and set global Web Intelligence options
from InfoView, the corporate business intelligence portal.

To log in to InfoView
Before you can use InfoView and Web Intelligence you need the following
information:

• a URL to the InfoView server
• the InfoView server name and port number
• your login and password
• your authentication, which controls the InfoView resources available to

you

Contact your adminstrator for these details if you do not already know them.

Note:
By default the InfoView server name and authentification method are not
displayed on the InfoView logon page. You need to supply this information
only if your administrator has made these options visible.

You access Web Intelligence by using your web browser to log into InfoView,
the corporate business intelligence portal. Once you are in InfoView, you
can analyze and enhance Web Intelligence reports.

1. Launch your web browser.
2. Point your browser to the InfoView bookmark or URL.

The InfoView login page appears.

3. If the System box is blank, type the name of the InfoView server followed
by a colon (:), and then type the port number.

4. In the Username box, type your user name.
5. In the Password box, type your password.
6. In the Authentication box, select the authentication provided to you by

your administrator.
7. Click Log On.

The InfoView home page appears.
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To log out of InfoView
When you finish using InfoView or Web Intelligence you need to log out,
instead of simply closing your web browser.

Logging out of InfoView ensures that any preferences you modified during
your InfoView session are saved. It also lets your administrator track how
many users are logged into the system at any given time and thus optimize
InfoView and Web Intelligence performance.

• Click Log Out.
The login page appears. You are logged out of InfoView

Web Intelligence InfoView options

Web Intelligence document creation and viewing
options

You can set your Web Intelligence options to determine how you create,
view and interact with documents using Web Intelligence.

You create documents using a query editor to build the query to retrieve the
document data. After the query returns the data to the document, you can
view and interact with the data.
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DescriptionDocument creation option

You create documents using the
Java Report Panel, a Java applet
than launches in your Web brows-
er.

The Java Report Panel is a com-
bined query building, report editing
and data analysis environment. If
you choose Advanced as your
document creation option, you also
use the Java Report Panel for
working with the data returned by
the query. The Select a default
view format option is not taken into
account.

The Java Report Panel provides
the richest feature set of all Web
Intelligence query building, report
editing and data analysis environ-
ments.

Advanced

You build queries using Query -
HTML, an HTML-based query editor.Interactive

You build queries, edit reports and
analyze data using Web Intelli-
gence Rich Client, a standalone
version of the Java Report Panel
that runs outside your web browser.

Desktop

You create reports using the HTML
Report Panel, a 508-compliant query
and report building environment.

Web Accessibility

You can use the following view formats to view and interact with existing
Web Intelligence documents, or documents that you have just created using
a query editor:
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DescriptionView format

Use Web (HTML) format when you
want to open reports, answer
prompts, navigate reports, and/or
perform drill analysis.

Web

Use Interactive format when you
want to apply filters, sorts, calcula-
tions, modify formatting and data
displayed on tables and charts,
and/or perform drill analysis.

Use Interactive format if you are us-
ing Query – HTML to define queries,
and you want to format reports based
on those queries and add formulas
and variables.

Interactive format + Query HTML
provides an approximate equivalent
to the Java Report Panel or Web In-
telligence Rich Client, in a pure
HTML environment.

You can also use Interactive format
to view and work with reports gener-
ated from the HTML Report Panel.
Unline Query - HTML, which is a
pure query-building environment, the
HTML Report Panel also allows you
to define reports. After running your
query, you can continue to work with
the report either by using Interactive
format, or by returning to the HTML
Report Panel.

Interactive view format is only avail-
able if your administrator has de-
ployed Web Intelligence in JSP
mode.

Interactive
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DescriptionView format

Use PDF mode when you want to view
static reports.PDF

To select the Web Intelligence query editor

1. Click the Preferences button on the InfoView toolbar.
2. Click Web Intelligence Preferences to display the Web Intelligence

options.
3. Select the query editor beneath Select a default creation/editing tool.
4. Click OK.

To select the Web Intelligence view format

You can select different view formats for Web Intelligence documents
depending on how you want to interact with the information displayed on the
reports. You select your Web Intelligence view options in InfoView. When
you modify your view options, the new settings are implemented the next
time you open a Web Intelligence document.

1. Click the Preferences button on the InfoView toolbar.
2. Click Web Intelligence Preferences to display the Web Intelligence

options.
3. In the Select a view format section, select the view format.

To select a default universe for new documents

1. Click Preferences on the Infoview toolbar.
2. ClickWeb Intelligence Preferences to display the Web Intelligence

options.
3. Click Browse beneath Select a default universe and browse to the

universe you want to select as the default.
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To set Web Intelligence drill options

Drilling on reports lets you look deeper into data to discover the details behind
a good or bad summary result displayed on a table, chart, or section. Before
you begin a drill session, you can set your drill options in InfoView to specify
how reports will change each time you drill.

1. Click Preferences on the Infoview toolbar.
2. Click Web Intelligence Preferences to display the Web Intelligence

options.
3. Select the drill options under Drill options and Start drill session.

Hide drill toolbar option

When you drill on a value displayed on a report, the Drill toolbar appears
and displays the value on which you drilled. The value displayed on the
toolbar filters the results displayed on the drilled report.

For example, if you drill on year 2001, the results displayed on the drilled
table are Q1, Q2, Q3, and Q4 for year 2001. This means that the quarterly
values you drilled to are filtered by 2001.

Note:
If the drilled report includes dimensions from multiple queries, a ToolTip
appears when you rest your cursor on the value displayed on the filter. The
ToolTip displays the name of the query and the dimension for the value.

The Drill toolbar allows you to select alternative values on the same level,
in order to filter the results differently. For example, if you use the Drill toolbar
illustrated above to select “2002, ? the results displayed on the drilled table
would be Q1, Q2, Q3, and Q4 for year 2002.

You can opt to hide the Drill toolbar when you start drill mode. The Drill
toolbar is only useful if you want to select filters during your drill session.

Prompt when drill requires additional data option

When you drill the results displayed on a Web Intelligence report, you may
want to drill to higher- or lower-level information that isn’t included in the
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scope of analysis for the document. When this is the case, Web Intelligence
needs to run a new query to retrieve the additional data from the data source.

Since queries on large selections of data may take a long time to be
completed, you can choose to be prompted with a message every time a
new query is necessary. The prompt message asks you whether you want
to run the additional query or not. In addition, the prompt lets you apply filters
to the extra dimensions you include in the new query. This means you can
restrict the size of the query to only the data necessary for your analysis.

You need permission from your administrator to drill out of the scope of
analysis during a drill session.

Synchronize drill on report blocks option

When you select theSychronize drill on all report blocks option, the display
of all blocks changes to correspond with your drill actions. For example, if
you drill down on a block from year to quarter, and your report also contains
a chart showing data by year, the chart display also changes to display data
by quarter.

If you do not select the option, only the drilled block changes in response to
drill actions.

Start drill session option

The Start drill session option controls how Web Intelligence behaves when
you start drill mode.

Start drill session on existing report option
When you select Start drill session on existing report, the current report
becomes drillable when you start drill mode. When you end drill mode, the
report displays the drilled values.

Start drill session on a duplicate report option
When you select Start drill on a duplicate report, Web Intelligence creates
a duplicate of the current report when you start drill mode, and you drill on
the duplicate. This allows you to compare the results of the original report
with the results you discover during your drill analysis.
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Web Intelligence locale options

Locales determine how Web Intelligence displays its interface (for example,
menu items and button text) and data (for example, date and number
formatting).

Web Intelligence has three locales:

DescriptionLocale

The locale in which the Web Intelli-
gence interface is displayedProduct Locale

The locale of the data currently con-
tained in the documentDocument Locale

The user's preferred locale for display-
ing document dataPreferred Viewing Locale

The InfoView settings determine how the Document Locale and Preferred
Viewing Locale interact to display document data.

Related Topics
• To permanently associate a locale with a document on page 37

The Product Locale

The product locale is used to display the Web Intelligence interface (for
example, menu items and button text).

Note:
The GetLocale function returns the Product Locale.

To set the Product Locale
1. Click Preferences on the main InfoView toolbar.
2. Click General to display the general options.
3. Select the product locale from the Product locale list.
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The Document Locale

The Document Locale formats the data in a document. For example, the
Document Locale determines how Web Intelligence displays dates and
numbers.

If the Web Intelligence settings in InfoView give the user's Preferred Viewing
Locale priority through the Use my Preferred Viewing Locale to format
the data setting, Web Intelligence sets the Document Locale to the Preferred
Viewing Locale when the user opens a document. When the user saves the
document, Web Intelligence saves this Document Locale with the document.

If the Web Intelligence settings do not give the user's Preferred Viewing
Locale Priority, Web Intelligence formats the data according to the Document
Locale saved with the document.

When a user creates a document, Web Intelligence always assigns the user's
Preferred Viewing Locale as the initial Document Locale, whether or not the
Web Intelligence settings in InfoView give the Preferred Viewing Locale
priority.

A user can permanently associate the current Document Locale with a
document by saving the document with thePermanent Regional Formatting
option selected. Once a document has been saved with the option selected,
Web Intelligence ignores the InfoView settings and always formats the
document data using the saved Document Locale. This applies to all users,
not just the user who selected the Permanent Regional Formatting option.

Note:
The GetContentLocale function returns the Document Locale.

Related Topics
• To permanently associate a locale with a document on page 37

To set the Document Locale
1. Click Web Intelligence Preferences to display the Web Intelligence

options.
2. Click Use the document locale to format the data beneath When

viewing a document.
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The Preferred Viewing locale

The Preferred Viewing Locale is a user's preferred locale for displaying
document data. The Document Locale becomes the user's Preferred Viewing
Locale when the InfoView settings give the Preferred Viewing Locale priority.

Note:
The GetPreferredViewingLocale function returns the Preferred Viewing
Locale. The GetLocalized function also uses the Preferred Viewing Locale
to display translated strings.

To set the Preferred Viewing Locale
1. Click Preferences on the main InfoView toolbar.
2. Click General to display the general options.
3. Select the preferred viewing locale from the Preferred viewing locale

list.
4. Click Web Intelligence Preferences to display the Web Intelligence

options.
5. If you want data to be formatted using the preferred viewing locale, click

Use my Preferred Viewing Locale to format the data beneath When
viewing a document.

To permanently associate a locale with a document

1. In Web Intelligence Interactive, select Document > Properties from the
menu to display the" Document Properties" dialog box, then select
Permanent regional formatting.

2. In the Web Intelligence Java Report Panel or Web Intelligence Rich Client,
right-click an empty area of the report, select Document Properties to
display the Document Properties pane, then select Permament
Regional Formatting in the Document Options section of the pane.

3. Save the document.
The current Document Locale is associated permanently with the
document.
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Getting started with Web
Intelligence Rich Client

3



To install Web Intelligence Rich Client
from InfoView

1. Log into InfoView.
2. Click Preferences at the top right of the InfoView screen.
3. Scroll down and click Web Intelligence Preferences.
4. Click Desktop (Web Intelligence Rich Client required) in the Select a

default creation/editing tool section.
5. Click Document List at the top left of the InfoView screen.
6. ClickNew >Web Intelligence Document or select an existing document

to edit.

Web Intelligence Rich Client is downloaded to your computer and launched
to create the document.

Note:
If you install Web Intelligence Rich Client from InfoView, the Web Intelligence
Rich Client online help system is not installed to your local computer. If you
work in Connected mode, Web Intelligence Rich Client displays help pages
stored on the server. If you work in Offline or Standalone mode, help pages
are not available.

Related Topics
• Web Intelligence Rich Client working modes on page 40

To install Web Intelligence Rich Client
from theBusinessObjects EnterpriseCD

• See the Business Objects Enterprise XI 3.1 Installation Guide for full
installation instructions.

Web Intelligence Rich Client working
modes

You can work with Web Intelligence Rich Client in three modes: Connected,
Offline, or Standalone.
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Web Intelligence Rich Client Connected mode

In Connected mode, Web Intelligence Rich Client is connected to a CMS.
You can work with documents on the CMS or with local secured or unsecured
documents. According to your security rights in the CMS, you can do the
following:
• import documents from the CMS
• import universes from the CMS
• open local documents
• create documents
• edit documents
• refresh documents
• save documents locally
• export documents to the CMS

Security in Connected mode

When you work with Web Intelligence documents in Connected mode, the
security rights of your user account are applied by the CMS.

Connecting to the CMS in Connected mode

There are two ways of launching Web Intelligence Rich Client, and each
connects to the CMS differently:

• When you launch from InfoView, Web Intelligence Rich Client connects
to the CMS within the same InfoView session, so no login is required.
Communication with the CMS goes via HTTP to an application server,
which reroutes the calls to the CMS and repository. No local middleware
is required.

• When you launch locally, by logging in to Web Intelligence Rich Client
through the Windows Start menu or by double-clicking a Web Intelligence
document, Web Intelligence Rich Client connects to the CMS in
client-server mode via the OCA/CORBA framework of the Enterprise
SDK. You need the appropriate database middleware on your local
machine.
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Related Topics
• To launch Web Intelligence Rich Client in Connected mode locally on

page 49
• To launchWeb Intelligence Rich Client in Connected mode from InfoView

on page 48

Web Intelligence Rich Client Offline mode

In Offline mode, Web Intelligence Rich Client is not connected to a CMS but
applies CMS security. You can work with local documents and universes
that are secured by the CMS you select at login, or with unsecured local
documents and universes. You can do the following:
• open local documents
• create documents (requires local universe and local connection server)
• edit documents
• refresh documents (requires local universe and local connection server)
• save documents locally

In Offline mode, you cannot import documents from or export documents to
a CMS.

Security in Offline mode

When you connect to a CMS in Connected mode, your security rights in that
CMS are downloaded to your computer. Each document and universe
downloaded from a CMS contains within it an access control list identifying
groups and users that have access rights to the document. In Offline mode,
Web Intelligence Rich Client applies CMS security rights by matching the
access rights for the document or universe against the locally stored security
file. For example, if a document was downloaded from a CMS to your local
machine, and you do not have the right to open the document in the CMS
from which it was downloaded, you cannot open the document on your local
machine.

Note:
Before you can work in Offline mode with documents or universes secured
by a CMS, you must first have connected to that CMS at least once in
Connected mode. This allows Web Intelligence Rich Client to download the
CMS security information to your local machine, and to display the CMS as
a choice in the System list on the login page. You can then log in in Offline
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mode and work with no CMS connection because Web Intelligence Rich
Client reads the CMS security information in the local file.

Technical notes
• When working in Offline mode, you must have the appropriate universes

and database middleware installed on the same machine as Web
Intelligence Rich Client to be able to create or refresh documents. If you
do not, you can still open, edit, and save documents locally as long as
you have the appropriate security rights.

• The security information for a CMS is stored in a local security information
file (extension LSI) in the LocData folder under My Business Objects
Documents in the My Documents folder. One computer can store LSI
files for several CMSs.

Web Intelligence Rich Client Standalone mode

In Standalone mode, Web Intelligence Rich Client is not connected to a CMS
and no security is enforced. You can work with local, unsecured documents
and universes only. You can do the following:

• open documents
• create documents
• edit documents
• refresh documents
• save documents locally

You cannot import documents from or export documents to a CMS.

The middleware required to create and refresh local, unsecured documents
with local, unsecured universes must be installed on the computer with Web
Intelligence Rich Client.

To set user preferences in Web
Intelligence Rich Client

1. Click Tools > Options.
The Preferences dialog box opens.

2. Click one of the tabs:
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• General: to set general preferences
• Viewing: to set document viewing preferences
• Locale: to set preferences for interface and formatting locales and

how to use them
• Drilling: to set document drill preferences

3. Set preferences and click OK.
The preferences are now applied. They are stored in a file in the LocData
folder under the BusinessObjects Enterprise 12.0 installation folder.

Web Intelligence Rich Client general preferences

You set general preferences for Web Intelligence Rich Client by clicking
Tools > Options and clicking the General tab of the Preferences box.

General

In the General section, you choose whether to show the welcome wizard
each time Web Intelligence Rich Client is started. The welcome wizard lets
you select from a list of recently used universes or browse for more data
sources to create a new document.

Select default universe

In this section, you choose whether to select a default universe for new
documents. The default universe is pre-selected in the Universe dialog box
when you create a new document. When creating a document, you can use
the default universe or select another one.

• No default universe means that no universe in the list is pre-selected
when you open the Universe dialog box. You must select a universe from
the list when creating a document.

• The other choice shows the name of the default universe, or None if no
default universe has been selected. To choose a default universe, click
Browse, then browse to and select a universe.

Select default folders

In this section, you choose the default folders in which to store user
documents, universes, and help files. To change the default locations, click
Browse, then browse to and select a folder.
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Note:
If Web Intelligence Rich Client was downloaded and installed from InfoView,
help files are not installed locally. However, they are installed on the InfoView
server. Contact your company's Business Objects administrator to get the
URL of the help files on the server, then enter the URL here for help to be
available.

Select Microsoft Excel format

In this section you choose the format to use when you save a document in
Microsoft Excel format.

• Prioritize easy data processing in the Excel document: the Excel
document will be formatted to ensure efficient data processing.

• Prioritize the format of reports in the Excel document: the Excel
document will be formatted to ensure optimum readability.

Web Intelligence Rich Client viewing preferences

You set general preferences for Web Intelligence Rich Client by clicking
Tools > Options and clicking the Viewing tab of the Preferences box.

General

In this section, you set the unit of measurement for report display: pixel, inch,
or centimeter.

Grid

In this section you set grid options:

• Show grid: When this is selected, a grid is displayed to help align page
elements.

• Snap to grid: When this is selected, page elements align to the grid to
enable accurate repositioning.

• Grid spacing: This defines the distance between lines on the grid.
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Web Intelligence Rich Client locale preferences

You set locale preferences for Web Intelligence Rich Client by clicking Tools
> Options and clicking the Locale tab of the Preferences box.

Locale

In this section, you set preferences for interface and formatting locales. A
locale is a combination of language and geographical area.

• Select interface locale: Select an available locale to set the application
interface language. If you change this setting, you must restart Web
Intelligence Rich Client for the change to be taken into account.

• Select formatting locale: Select an available locale to determine
locale-specific formatting (for example, date and time formats). If you
change this setting, any documents that are open must be closed and
reopened for the new formatting locale to be applied.

When viewing a document

In this section, you set how the formatting locale is decided:

• Use the document locale to format the data: When this is selected,
data is formatted according to the document locale. The document locale
can be saved with the document by means of the permanent regional
formatting option that you can select when saving.

• Use my formatting locale to format the data: When this is selected,
data is formatted according to your formatting locale preference. This
overrides the document locale.

Web Intelligence Rich Client drill preferences

You set drill preferences for Web Intelligence Rich Client by clicking Tools
> Options and clicking the Drilling tab of the Preferences box.

For each new drill session

In this section, you choose how to start a new drill session:

• Start drill on duplicate report: When you start a new drill session, a
duplicate report is opened in the document and you drill on the duplicate.
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When you end drill mode, both the original report and the drilled report
remain in the document.

• Start drill on existing report: When you start a new drill session, the
current report becomes drillable. When you end drill mode, the report
displays the drilled values.

General drill options
• Prompt if drill requires additional data: You are prompted when Web

Intelligence needs to retrieve additional data to complete the drill, and
can decide whether to go ahead. If the amount of data is large, the retrieval
can take time and you may decide not to drill. When this option is not
selected, Web Intelligence retrieves the additional data without prompting
you.

• Synchronize drill on report blocks: When this is selected, drilled values
are shown in all the report blocks in the report. When it is not selected,
drilled values are shown only in the report block selected for the drill.

• Hide drill toolbar: When this is selected, the drill toolbar that is normally
displayed at the top of drilled reports is not shown. The drill toolbar
displays the value on which you drilled. It is only useful if you want to
select filters during your drill session.

To change your password

You can only change your password from Web Intelligence Rich Client if you
are in client-server connection mode: you must have launched Web
Intelligence Rich Client locally rather than from InfoView.

1. Click Tools > Change Password.
2. Type your current password in the Enter Old Password box.
3. Type your new password in the Enter New Password box.
4. Type your new password again in the Confirm New Password box.

Your password is changed to the new password.

Launching Web Intelligence Rich Client
You can launch Web Intelligence Rich Client in any of its three working
modes:

Building Reports with Web Intelligence Rich Client 47

3Getting started with Web Intelligence Rich Client
Launching Web Intelligence Rich Client



• Connected
• Offline
• Standalone

You can run multiple instances of Web Intelligent Rich Client simultaneously,
in any mode and connected to any available CMS.

The CMS connection status and the current Web Intelligence Rich Client
working mode are shown in the status bar on the lower right of the screen.

Related Topics
• Web Intelligence Rich Client working modes on page 40

To launchWeb IntelligenceRichClient inConnected
mode from InfoView

In Connected mode, security is handled by the CMS. You work with reports
in Web Intelligence Rich Client as you do with the Java Report Panel. You
do not need database middleware on your local machine when you launch
in Connected mode from InfoView.

1. Log into InfoView.
2. Click Preferences at the top right of the InfoView screen.
3. On the Preferences page, scroll down and click Web Intelligence

Preferences.
4. In the Select a default creation/editing tool section, clickDesktop (Web

Intelligence Rich Client required).
5. Click OK.
6. At the top left of the screen, click Document List.
7. Open an existing document or click New > Web Intelligence Document

to create a new document.

Web Intelligence Rich Client is launched on your computer in Connected
mode. If it is not yet installed on your computer, it is installed from
InfoView.

If Web Intelligence Rich Client was already running on your computer,
launching from InfoView opens a new instance of the application. The
document is not opened in the application instance that was already open.
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Related Topics
• Web Intelligence Rich Client working modes on page 40

To launchWeb IntelligenceRichClient inConnected
mode locally

To launch Web Intelligence Rich Client in Connected mode locally, Web
Intelligence Rich Client must be installed on your computer. You must have
already connected at least once to the CMS you want to work with using
Web Intelligence Rich Client via InfoView.

You need to have the middleware required to connect to the CMS installed
on your computer.

In Connected mode, security is handled by the CMS. You work with reports
in Web Intelligence Rich Client as you do with the Java Report Panel.

When you launch Web Intelligence Rich Client in Connected mode locally,
you have a client-server connection to the CMS. In this case, you can log
out and log in again within the same application session by clicking Tools
> Login As.

1. Start Web Intelligence Rich Client locally in either of two ways:
• Click Start > Programs > BusinessObjects XI 3.1 >

BusinessObjects Enterprise > Web Intelligence Rich Client
• In Windows Explorer, associate the WID file type with Web Intelligence

Rich Client, and then double-click a Web Intelligence (WID) file.
The Web Intelligence login page opens.

2. Select a CMS in the System list.

An icon shows what kind of connection was used for the last connection
with the CMS:

• An icon of a desktop computer means Web Intelligence Rich Client
last connected to this CMS in client-server mode (local launch from
the client computer). The name of the CMS is the server name.

• An icon of a globe means Web Intelligence Rich Client last connected
to this CMS in HTTP mode (connection via InfoView). The name of
the CMS is the full name of the connected cluster.

3. Enter a valid user name and password.
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4. Select an authentication mode from the list.
Do not choose Standalone if you want to work in Connected mode. When
you choose Standalone authentication you work in Standalone mode,
with no CMS connection.

5. Make sure the Use in Offline Mode option is not selected.
6. Click Log In.

Web Intelligence Rich Client is launched in Connected mode. If Web
Intelligence Rich Client was already running on your computer, launching it
again opens a new instance of the application. If you double-clicked a Web
Intelligence document, the document will not be opened in the application
instance that was already open.

Related Topics
• Web Intelligence Rich Client working modes on page 40

To launch Web Intelligence Rich Client in Offline
mode

To launch Web Intelligence Rich Client in Offline mode, Web Intelligence
Rich Client must be installed on your computer. You must have already
connected at least once to the CMS you want to work with using Web
Intelligence Rich Client via InfoView.

In Offline mode, Web Intelligence Rich Client uses the locally stored security
file of the CMS you want to work with to authenticate documents. You cannot
import to or export from the CMS. To create or refresh documents, you need
to have a connection server installed on your computer.

1. Start Web Intelligence Rich Client in Offline mode in either of two ways:
• Click Start > Programs > BusinessObjects XI 3.1 >

BusinessObjects Enterprise > Web Intelligence Rich Client
• In Windows Explorer, associate the WID file type with Web Intelligence

Rich Client, and then double-click a Web Intelligence (WID) file.
The Web Intelligence login page opens.

2. Select a CMS in the System list.
3. Enter a valid user name and password.
4. Select an authentication mode from the list.
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Do not choose Standalone if you want to work in Connected mode. When
you choose Standalone authentication you work in Standalone mode,
with no CMS connection.

5. Select the Offline Mode option.
6. Click Log In.

Web Intelligence Rich Client is launched in Offline mode. If Web Intelligence
Rich Client was already running on your computer, launching it again opens
a new instance of the application. If you double-clicked a Web Intelligence
document, the document will not be opened in the application instance that
was already open.

Related Topics
• Web Intelligence Rich Client working modes on page 40

To launchWeb IntelligenceRichClient inStandalone
mode

To launch Web Intelligence Rich Client in Standalone mode, Web Intelligence
Rich Client must be installed on your computer.

Any middleware required to work with unsecured documents and universes
must be installed on your computer.

In Standalone mode, you cannot work with documents or universes that have
been secured by a CMS.

1. Start Web Intelligence Rich Client in Standalone mode in either of two
ways:
• Click Start > Programs > BusinessObjects XI 3.1 >

BusinessObjects Enterprise > Web Intelligence Rich Client
• In Windows Explorer, associate the WID file type with Web Intelligence

Rich Client, and then double-click a Web Intelligence (WID) file.
The Web Intelligence login page opens.

2. Select Standalone in the Authentication list.
The System, User Name, and Password boxes, as well as the Use in
Offline Mode option, are grayed.

3. Click Log In.
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Web Intelligence Rich Client is launched in Standalone mode. If Web
Intelligence Rich Client was already running on your computer, launching it
again opens a new instance of the application. If you double-clicked a Web
Intelligence document, the document will not be opened in the application
instance that was already open.

Related Topics
• Web Intelligence Rich Client working modes on page 40

To log into Web Intelligence Rich Client as a
different user

To log into Web Intelligence Rich Client as a different user without exiting
the application, you must have launched Web Intelligence Rich Client via
the Windows Start menu or by double-clicking a local WID file, and then
connected to the CMS in Connected mode.

1. Save any open documents.
2. Click Tools > Login As.

If any documents have not been saved, you are asked if you want to save
them.

3. When you are asked if you are sure you want to log out, click Yes.
Any open documents are closed.

4. In the User Identification box, enter your login information and click OK.

Related Topics
• To launch Web Intelligence Rich Client in Connected mode locally on

page 49
• Web Intelligence Rich Client working modes on page 40
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Working with universes in Web
Intelligence Rich Client

Universe security in Web Intelligence Rich Client

Universe security in Connected mode

When you work with Web Intelligence Rich Client in Connected mode, you
access CMS universes remotely. The CMS applies the security rights directly,
exactly as if you were working with Web Intelligence through InfoView in
your browser.

In Connected mode, you cannot access local, CMS-secured universes. You
must access the CMS universes remotely.

Universe security in Offline mode

To create or refresh a report in Offline mode, you must have first connected
to the CMS in Connected mode. When you work in Connected mode with a
CMS, a local security information (LSI) file is downloaded to your computer
containing your security rights to the resources in the CMS.

When you try to create or refresh a report in Offline mode, you can use:

• locally installed universes that are not secured by the CMS
• locally installed universes which you are authorized to access, as verified

by the LSI file

You cannot access universes on the CMS remotely, because in Offline mode
you are working without a CMS connection.

Note that you need to have a Connection Server installed on your computer
with Web Intelligence Rich Client in order to create or refresh documents in
Offline mode.

Universe security in Standalone mode

In Standalone mode, you work with no security and no connection to the
CMS. You can work with unsecured, locally installed universes only.
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The middleware required to create and refresh local, unsecured documents
with local, unsecured universes must be installed on the computer with Web
Intelligence Rich Client.

Related Topics
• Launching Web Intelligence Rich Client on page 47
• Web Intelligence Rich Client working modes on page 40

To import a universe from the CMS in Web
Intelligence Rich Client

You can import a universe from the CMS in Connected mode only. Import
is automatic to provide a universe that is required to create or refresh a
document. However, you may want to import universes first to be able to
then work with them offline.

1. Click Tools > Universes.
The list of available universes appears in the Universe dialog box. These
include both local and CMS universes. Universes that have already been
imported are indicated with a green check mark.

2. Select one or more universes to import.
3. Click Import.

The universes you selected are imported from the CMS to your computer,
together with their dependencies (derived or core universes).

Related Topics
• To launch Web Intelligence Rich Client in Connected mode locally on

page 49
• To launchWeb Intelligence Rich Client in Connected mode from InfoView

on page 48
• Web Intelligence Rich Client working modes on page 40

To select a universe

1. Select a universe in the Available Universes list.
A description of the universe appears in the Help on selected universe
box.
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2. Click OK.

The query panel opens, showing the universe's data in the Data tab.

You can now use the query panel to build queries in your document.
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Returning data using
queries

4



Creating, editing and saving documents
You create documents using Web Intelligence Rich Client by building a query
on a universe stored in the InfoView repository, a local universe, or a local
non-universe data source.

After you have selected a universe or a non-universe data source you you
its objects to build a query that returns data from the data source to your
Web Intelligence document.

After creating a document you can work with it locally or export it to the
InfoView repository.

Building and working with queries

To build a query on a universe

1. Click File > New
2. SelectUniverse in the "Data Source Selection" dialog box and clickNext.
3. Select the universe in the "Universe" dialog box and click OK.
4. Select the objects you want to include in the query and drag them to the

Result Objects pane.

Note:
To add all the objects in the class, drag the class to the Result Objects
pane.

5. Repeat the previous step until the query contains all the objects you want
to include.

6. Select the objects on which you want to define query filters and drag them
to the Query Filters pane.

7. Set the scope of analysis and other query properties.
8. Click Run Query to run the query.

Related Topics
• Displaying data from an added query on page 62
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How universe objects map to data

Classes and subclasses

Objects are grouped into folders called classes. Each class can also contain
one or more subclasses. Subclasses contain objects that are a further
subcategory of the objects in the upper level of the class.

The role of classes is to organize the objects into logical groups. When you
create queries on the universe, classes help you to find the objects that
represent the information that you want to use in a query.

Dimension object

A dimension object represents data that provides the basis for analysis in a
report. Dimension objects typically retrieve character-type data, for example;
customer names, resort names, or dates.

Dimension objects appear as follows in the Web Intelligence query panel:

Detail object

A detail obect provides descriptive data about a dimension. A detail is always
attached to the dimension for which it provides additional information. For
example, [Age] is a detail object that is associated with the (Customer]
dimension.

Detail objects appear as follows in the Web Intelligence query panel:
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Measure object

The measure object retrieves numeric data that is the result of calculations
on data in the database. For example, [Revenue] is the calculation of the
number of items sold multiplied by item price. Measure objects are often
located in a Measures class.

Measure objects appear as follows in the Web Intelligence query panel:

There are two types of measure:
• classic measures - calculated by Web Intelligence
• smart measures - calculated by the database on which the universe is

based

In certain situations, smart measures impact the way in which Web
Intelligence displays calculations. For more information on smart measures,
see the Using Functions, Formulas and Calculations in Web Intelligence
guide.

To build a query on a text or Excel file

1. Click File > New
2. Select Other data source in the "Data Source Selection", select Text

and Excel files from the list, then click Next.
3. Type the file name in the Name box or click Browse and select the file.

Web Intelligence displays the options relating to the type of file you chose.
These options determine how Web Intelligence interprets the data in the
file and transforms it to result objects for use in the query.

4. Select the options relating to the file type and click Next.
Web Intelligence populates the Result Objects pane in the Query Panel
based on the options you selected.
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5. Click Run Query to run the query.

Related Topics
• Displaying data from an added query on page 62

CSV data source options

You can set the following options when you choose a CSV file as a local
data source. You can edit the options later by clicking Edit Settings in the
Query Definition pane in the Query Panel.

DescriptionOption

The character that separates the data relating to each result
object.
• Tabulation - data is tab-separated
• Space - data is separated by spaces
• Character - data is separated by the character you

specify

Data Separator

The character that delimits the data relating to each result
object.

Text delimeter

Web Intelligence uses the first row in the file as the names
of the result objects.

First row contains
column names

The document localeLocale

The document character setCharset

The date format used in the documentDate format

Excel data source options

You can set the following options when you choose an Excel file as a local
data source. You can edit the options later by clicking Edit Settings in the
Query Definition pane in the Query Panel.

DescriptionOption
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DescriptionOption

The name of the worksheet containing the dataSheet Name

Web Intelligence treats all data in the worksheet as query
data

Field selection - All
fields

Web Intelligence treats the data in the specified range
as query data

Field selection -
Range Definition

Web Intelligence treats the data in the named range as
query data

Field selection -
Range Name

Web Web Intelligence uses the first row in the range as
the names of the result objects.

First row contains
column names

Displaying data from an added query

When a query is not the first query in the document, you need to specify in
the New Query box how its data will be displayed.

DescriptionOption

Display the data on a new report in the
document

Insert a table in a new report

Display the data on the currently selected
report in a new table

Insert a table in the current report

Include the data in the document without
displaying the data on a report. (You can
add the objects returned by the query to the
report later.)

Include the result objects in the
document without generating a
table

To interrupt a query

You can interrupt a query before Web Intelligence has returned all the data
to the document.
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When you interrupt a query, only partial data is returned to the document.
The values displayed in the document do not accurately reflect the definition
in the query.

Before returning the data to the document, Web Intelligence requests you
to choose which version of the data you want retrieved

1. On the "Waiting - Refresh Data" dialog box, click Cancel.
The "Interrupt Data Retrieval" dialog box appears.

2. Select one of the options on the "Interrupt Data Retrieval" dialog box.

DescriptionOption

Web Intelligence restores the values to the
document that were retrieved the last time
the query was run. The values displayed will
not be the most up to data information avail-
able on the database. You can run the query
later to return the up to date values from the
database

Restore the results from
the previous data retrieval

Web Intelligence displays the document
empty of values. The structure and formatting
of the document is retained. You can run the
query later to return the up to date values
from the database

Purge all data from the
document

Web Intelligence displays the new values
retrieved so far in the appropriate parts of the
document. The rest of the document will dis-
play the values retrieved the last time the
query was run

Return the partial results

To remove a query

1. Select a the query you want to remove by right-clicking the appropriate
Query tab.

2. Click Remove.
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To duplicate a query

If you want to build a different query on a universe already included in the
document, you can duplicate the existing query on that universe and then
modify it, instead of starting from scratch.

1. Select the query you want to duplicate by right-clicking the appropriate
Query tab at the bottom of the report panel.

2. Select Duplicate

To edit a query

1. Click Edit Query
2. Edit the query in the Query Panel.

Multiple queries

You can include one or multiple queries in a Web Intelligence document.
When you include multiple queries, those queries can be based on a single
universe or on multiple universes available in InfoView.

For example, you can include product sales data and customer data in the
same document. In this case, your corporate data for product line sales is
available on one universe and data on customers is available on another
universe. You want to present product line sales results and information on
customer age groups in the same report. To do this, you create a single
document that includes two queries; one query on each universe. You can
then include and format results from both queries on the same report.

Defining multiple queries in a single document is necessary when the data
you want to include in a document is available on multiple universes, or when
you want to create several differently-focused queries on the same universe.
You can define multiple queries when you build a new document or add more
queries to an existing document. You can present the information from all
of the queries on a single report or on multiple reports in the same document.
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Multiple queries, combined queries and synchronized queries
compared

Multiple queries can be related in a Web Intelligence document in different
ways.

• Basic multiple queries draw unrelated data from different sources.
• "Synchronized queries" relate the data from different queries around a

dimension that contains data common to both queries. These dimensions
are called merged dimensions.

You merge dimensions in the Web Intelligence reporting interface after
you have created and run your multiple queries.

• "Combined queries" are a special kind of query created in the Web
Intelligence query interface. Combined queries generate SQL containing
the UNION, INTERSECT and MINUS operators (if the database supports
them) or simulate the effect of these operators.

Combined queries allow you to answer complex business questions that
are difficult to formulate using standard queries.

You cannot create combined queries in Query - HTML.

To refresh queries

1. If the report contains one query only, click Refresh Data on the main
toolbar.

2. If the report contains multiple queries, click Refresh All to refresh all
queries, or click the arrow to the right of Refresh All and select the query
from the menu.

Note:
If a query is based on a personal data provider, Web Intelligence Rich Client
searches for the data provider in the following locations:
• The folder where the local data file was stored when the data provider

was created
• The same folder as the Web Intelligence document
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• The default user document folder (C:\Documents and
Settings\%currentUser%\My Documents\My Business Objects
Documents\userDocs)

If the file is not found in any of these folders, Web Intelligence Rich Client
displays an error.

Viewing the SQL generated by a query

When you build a query in Web Intelligence, Web Intelligence generates
SQL to run against the database to return the query result. S(tructured)
Q(uery) L(anguage) is the query language understood by all relational
databases.

You can view and edit the SQL generated by Web Intelligence.

Note:
You cannot view the SQL of queries that call database stored procedures.

To view and edit the generated SQL

Note:
You cannot edit the query SQL when the query contains optional prompts.
Edit the query to remove the optional prompts before attempting to edit the
SQL.

1. Click SQL on the query toolbar to display the "SQL Viewer" dialog box.
When SQL is not editable, values supplied in response to prompts appear
directly in the query.

For example, if "UK" was supplied in response to a prompt on [Country],
a line similar to

Resort_country.country In ('UK')

appears in the query.

If no value has yet been supplied for the prompt, the Web Intelligence
syntax for prompts (described below) appears in the query.

2. Click Use custom SQL to make the generated SQL editable.
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When you make the SQL editable, the Web Intelligence syntax for prompts
appears in the query.

For example, a line similar to

Resort_Country.country = @prompt('Enter Country:','A','Re
sort\Country',
Mono,Free,Persistent,,User:0)

appears in the query.

3. Click Validate after editing the SQL to check that your edits are valid.
4. Click Copy (Java Report Panel and Web Intelligence Rich Client only) to

copy the SQL to the clipboard.
5. Click Print (Query - HTML only) to print the SQL.

Setting the scope of analysis

Scope of analysis

The scope of analysis for a query is extra data that you can retrieve from the
database to give more details on the results returned by each of the objects
in a query. This extra data does not appear in the initial result report, but it
remains available in the data cube, so you can pull this data in to the report
to allow you to access more detail at any time. This process of refining the
data to lower levels of detail is called drilling down on an object.

In the universe, the scope of analysis corresponds to the hierarchical levels
below the object selected for a query. For example, a scope of analysis of
one level down for the object Year, would include the object Quarter, which
appears immediately under Year.

You can set this level when you build a query. It allows objects lower down
the hierarchy to be included in the query, without them appearing in the
Results Objects pane. The hierarchies in a universe allow you to choose
your scope of analysis, and correspondingly the level of drill available.

In the Java Report Panel and in Web Intelligence Rich Client, you can also
create a custom scope of analysis by selecting specific dimensions for the
Scope of Analysis pane.
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Note:
You cannot set the scope of analysis when working in query drill mode
because this drill mode causes Web Intelligence to modify the scope
dynamically in response to drill actions.

Levels of scope of analysis

You can set the following levels for scope of analysis:

DescriptionLevel

Only the objects that appear in the
Results Objects pane are included in
the query.

None

For each object in the Result Objects
pane, one, two, or three objects lower
down the hierarchy tree are included
in the query. The data from these ob-
jects is stored in the cube until you add
them to the document.

• One level down
• Two levels down
• Three levels down

All objects added manually to the
Scope of Analysis panel are included
in the query.

Custom

Note:
This option is available in the Java
Report Panel and in Web Intelligence
Rich Client only.

Including a scope of analysis in a document increases the document size
significantly. This is because the data necessary for the scope you specify
is saved with the document, even though it is not visible in the reports unless
you start drill mode and drill down to the data to display the corresponding
values.

In order to minimize the size of documents and optimize performance, we
recommend that you only include a scope of analysis in documents where
you are certain that users will need to drill.

We suggest the following method because it will be easier for you to set the
scope of analysis seeing the hierarchy of the classes and objects.
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To set the scope of analysis

1. Click the Show/Hide Scope of Analysis Pane button so that it appears
pressed in.
The Scope of Analysis panel appears at the bottom of the Result Objects
pane. The default scope of analysis is None. Each dimension in the Result
Objects pane appears in the Scope of Analysis pane.

2. Click the down arrow in the Scope of Analysis drop-down list box.
3. Select a level for the scope of analysis.

The level appears in the list box and the dimensions that are hierarchically
below each dimension in the Result Objects pane appear in the Scope
of Analysis pane.

4. If you want to add selected dimensions to the scope of analysis or create
a custom scope of analysis, select dimensions in the Query Manager and
drag them across to the Scope of Analysis panel.

Query contexts

What is an ambiguous query?

An ambiguous query is a query that contains one or more objects that can
potentially return two different types of information.

In a universe, certain dimensions may have values that are used for two
different purposes in the database. For example, the [Country] dimension in
the query below can return two types of information:

• Customers and the country in which they spent their vacation.
• Customers and the country for which they have made their reservation.

The role that Country plays in this query is ambiguous. A country can be
either the country where a vacation was sold, or a country where a vacation
is reserved. One is existing information (sales), and the other is future
information (reservations).
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To avoid ambiguities in a query, the universe designer identifies the different
ways that objects can be used in the universe, and implements restrictions
on how these objects can be combined. These restrictions are called contexts.

What is a context?

A context is a defined group of objects that share a common business
purpose. This business purpose is usually the type of information that these
related objects represent. For example, a sales context is a grouping of all
the objects that can be used to create sales queries. A reservations context
is a grouping of all the objects that can be used in reservation queries.
Contexts are defined in a universe by the universe designer.

You can combine any object within the same context to create a query. You
can also combine objects in different contexts. If you use an object that is
common to both contexts, Web Intelligence will try to determine the context
that best fits the other objects in the query.

If it cannot determine a context, you are prompted to choose the context that
you want to apply to the query.

Choosing a context when you run a query

When you create a query or refresh a report, you may be asked to choose
a context before the query can run. Contexts are set up in a universe to avoid
ambiguous queries.

To choose a context when you run a query

1. Run the query containing multiple contexts.
The "Select a Context" dialog box appears.

2. Select the context in the "Select a Context" dialog box.
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Web Intelligence query properties

Allow other users to edit all queries property

When selected, other users who have the appropriate editing rights can
access Query View and modify the queries in the document. When cleared,
only the report creator can modify the queries. This option is selected by
default. Unlike the other query properties, which only apply to the selected
query, this option applies to all of the queries in the document.

Max retrieval time query property

Maximum time that a query can run before the query is stopped. This can
be useful when a query is taking too long due to an excess of data, or network
problems. You can set a time limit so a query can stop within a reasonable
time.

Max rows retrieved query property

The Max rows retrieved query property determines the maximum number
of rows of data that are displayed when a query is run. If you only need a
certain amount of data, you can set this value to limit the number of rows of
data in your document.

Max rows retrieved does not operate at the database level. If you set Max
rows retrieved to 1000, and your query returns 5000 rows, Web Intelligence
initially retrieves all 5000 rows, before discarding 4000 and retaining only
the first 1000 rows.

The Sample result set query property also applies a restriction on the
number of rows in the query, but at the database level. If you set Max rows
retrieved to 2000 and Sample result set to 1000, the query retrieves a
maximum of 1000 rows only.

This setting can be overridden by the limits set by your administrator in your
security profile. For example, if you set the Max rows retrieved setting to
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400 rows, but your security profile limits you to 200 rows, only 200 rows of
data will be retrieved when you run the query.

Query prompt order

Prompts are listed in the list. You can use the up and down arrows to move
a prompt up or down the list to change the order in which they are executed.

Retrieve duplicate rows query property

In a database, the same data may be repeated over many rows. You can
choose to have these repeated rows returned in a query, or to have only
unique rows returned.

Reset contexts on refresh query property

When selected, you are prompted to choose a context each time a query
requiring a context is run. When unselected, Web Intelligence retains the
context specified the first time you run the query.

Clear contexts query property

When this property is selected, Web Intelligence clears the contexts listed
in the list when you next run the query or refresh the data.

Sample result set query property

The Sample result set property determines the maximum number of rows
that a query returns. The property applies this restriction at the database
level. If the database supports sampling, Web Intelligence adds the restriction
to the SQL that Web Intelligence generates to return the data.

If you select the Fixed option, Web Intelligence uses fixed sampling. At each
data refresh, the query returns the same rows. If you do not set the Fixed
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option, Web Intelligence uses random sampling. At each data refresh, the
query returns a different set of sampled rows.

Sample result set is more efficient than the Max rows retrieved property,
which discards rows beyond the maximum limit only after retrieving all the
rows in the query.

Not all databases support fixed and random sampling. If they are not
supported, the properties are disabled (in the Java Report Panel) or invisible
(in Query - HTML). Sampling is not available at all in the HTML Report Panel.
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Filtering data using query
filters

5



Query filters defined
You limit the data returned to the document by applying filters when you
define the query. Using query filters enables you to secure the data that you
don’t want specific user groups to see and limits the size of the documents
that are stored on your network. When you run the query on the document
data, the Web Intelligence returns only the values that meet the query filter
definitions.

Query filters limit the data Web Intelligence returns to a document. They
retrieve a sub-set of the data from the database and return the corresponding
values to the document. You define filters to match business questions. For
example, you can filter the [Year] dimension to view only sales revenue for
Year 2003; or filter the [Annual Income] dimension to view only customers
whose annual income is equal to or greater than $1.5M.

Query filters allow you to:

• retrieve only the data you need to answer a specific business question
• hide the data you don’t want specific users to see when they access the

document
• minimize the quantity of data returned to the document to optimize

performance

Example: In Q4 2002, which stores in my sales region gained margins
above $130K?

As Regional Marketing Manager for Texas, you are only interested in
analyzing margins for Texas, but the sales universe includes data US-wide.
In addition, you only want to view information for stores where margins
reached over your 4Q 2002 quarterly target figure: $130K. To create a
document with only the information you need, you apply a filter on the
[State], [Year], and [Quarter] dimensions and a filter on the [Margin]
measure:
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Year Equal to 2002

AND
Quarter Equal to Q4

State Equal to Texas

Margin Greater than or equal to 130000

To avoid displaying the filtered values Texas, 2002, and Q4 in the table
columns Year, Quarter, and State, you exclude the [Year], [Quarter], and
[State] objects from the Result Objects pane. When you generate the report,
the report values correspond to Texas stores with 4Q 2002 margins greater
than or equal to $130K:

MarginSales RevenueStore name

133,802307,914e-Fashion Houston

136,055316,232e-Fashion Houston
Leighton

Query filters and report filters compared
You can apply filters at two levels within a document:

• query filters – these filters are defined on the query; they limit the data
retrieved from the data source and returned to the Web Intelligence
document.

• report filters – these filters limit the values displayed on reports, tables,
charts, sections within the document, but they don’t modify the data that
is retrieved from the data source; they simply hide values at the report
level.

Types of query filter
You can create the following types of query filter:
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• predefined filters – created by your administrator
• custom filters – you define on the query
• quick filters - a simplified form of custom filter for simple filters
• prompts – you define these dynamic filters to display a question or a list

of values so you or other users can select different filter value(s) at each
run query

You can mix different types of filters on a single query.

Predefined query filters

Predefined filters make the specific data you most typically need for reports
permanently available in Web Intelligence. They are created by an
administrator and saved with the universe. Predefined filters often contain
complex expressions that require a detailed knowledge of the database
structure. Including predefined filters on the universe means you don’t need
to create the same custom filters every time you create new Web Intelligence
documents based on the same universe.

As a Web Intelligence user, you cannot view the component parts of
predefined filters or edit predefined filters.

To select a predefined query filter

• Double-click the predefined filter or drag it to the Query Filters pane.

When you run the query, the data corresponding to the query filters you
selected is returned to the report.

Quick filters

Quick filters allow you to quickly define the values you want to retrieve for a
specific object without launching the Filter Editor. By default, Quick filters
use the Equal to operator if you select a single value or the In list operator
if you select multiple values.

For example:

• If you select the [Payment Status] dimension and the value “unpaid? you
create the filter: [Payment Status] Equal to “unpaid?
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• If you select the [Country] dimension and the values US, Japan, Germany,
you create the filter: [Country] In list “US;Japan;Germany?

To create or remove a quick filter

1. Select the column you want to filter.
2. Click the arrow to the right of Add Filter on the Reporting toolbar and

click Add Quick Filter.
The List of Values dialog box appears. The values for the selected object
are listed.

3. Select the values you want to retrieve from the database.
For example, to filter the query for values in Q1, select the [Quarter]
dimension, then select Q1 from the list of values.

4. Click OK
The new filter appears on the Query Filters pane.

5. To remove the filter, click the arrow to the right of Add Filter and select
Remove Filter.

Custom query filters

You create custom query filters to limit document data to information
corresponding to:

• a specific business question
• the business information needs of a specific group of users

For example, you can create custom filters to retrieve sales results data for
specific dates, products, or services, or to view customer information only
for customers who are high wage earners or who live in a particular region.

To add and remove custom query filters

1. Select the object you want to filter and drag it to the Query Filters pane.
The query filter appears in outline in the Query Filters pane.

2. Click the arrow next to the default operator (In List) and select the query
operator from the list of operators.
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3. Click the arrow on the right of the query filter and select the type of filter
you want to apply: Constant, Value(s) from List, Prompt, Object from
this query, Result from another query, Result from another query
(Any), Result from another query (All).

DescriptionOption

You compare the object against a constant value to
filter the query result.

Constant

You compare the object against values from a list of
values to filter the query result.

Value(s) from list

You create a filter which requires the user to supply
filter values on data refresh.

Prompt

You compare the object against the values returned
by an object from in the same query.

Object from this
query

You compare the object against the values returned
by an object from another query (the filtering query)
to filter the query result.

Result from anoth-
er query

You compare the object against any of the values
returned by an object from another query (the filter-
ing query) to filter the query result.

Result from anoth-
er query (Any)

You compare the object against all of the values
returned by an object from another query (the filter-
ing query) to filter the query result.

Result from anoth-
er query (All)

4. Type/select the constant, list of values or object you want to include in
the filter.

5. To remove the filter, select it and click the Delete key, or click Remove
at the top right corner of the Query Filters pane. To remove all filters,
click Remove All at the top right corner of the Query Filters pane.

Related Topics
• What is a prompt? on page 92
• Filtering a query on values returned from another query on page 81
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Filtering a query on values returned from another query

You can filter a query on values returned from another query. For example,
if you want to return results for all the countries in Query 1 that have a
corresponding country in Query 2, you can filter the [Query 1].[Country]
object on the values of the [Query 2].[Country] object.

The filtered query must be in a universe based on a relational (RDBMS) data
source. The query that supplies the filtering values (filtering query) can be
based on a relational, OLAP or local data source.

When you are building a query on a query, the filtering query does not appear
in the list of queries that can be used as filtering queries until it has been run
or saved.

The filtering query is not refreshed when you refresh the filtered query.

The query filter can filter against all or any of the values returned by the
filtering query. The supported combinations of operator and filter mode appear
in the table below. If you do not choose an operator from the table, theResult
from another query menu item is not available.
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DescriptionFilter
mode

Operator

Keep values in the filtered query that are
equal to any value returned by the filtering
query.

AnyEqual To

Keep values in the filtered query that are dif-
ferent from all the values returned by the fil-
tering query.

AllNot Equal To

Keep values in the filtered query that are
greater than/greater than or equal to any
of the values in the filtering query.

In other words, keep values in the filtered
query that are greater than/greater than or
equal to the minimum value returned by
the filtering query.

AnyGreater Than

Greater Than or
Equal To

Keep values in the filtered query that are
greater than all of the values in the filtering
query.

In other words, keep values in the filtered
query that are greater than/greater than or
equal to the maximum value returned by
the filtering query.

AllGreater Than

Greater Than or
Equal To

Keep values in the filtered query that are
less than/less than or equal to any of the
values in the filtering query.

In other words, keep values in the filtered
query that are less than/less than or equal
to the maximum value returned by the filter-
ing query.

AnyLess Than

Less Than or Equal
To
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DescriptionFilter
mode

Operator

Keep values in the filtered query that are
less than/less than or equal to any of the
values in the filtering query.

In other words, keep values in the filtered
query that are less than/less than or equal
to the minimum value returned by the filter-
ing query.

AllLess Than

Less Than or Equal
To

Keep values in the filtered query that are
equal to any value in the list of values re-
turned by the filtering query.

AnyInList

Keep values in the filtered query that are not
equal to any of the values in the list of values
returned by the filtering query.

AnyNot InList

Query filter and prompt operators

Equal To operator

Use the Equal to operator to obtain data equal to a value.

For example, to return data for the US only, create the filter "County Equal
To US".

Not Equal To operator

Use the Not Equal To operator to obtain data not equal to a value.

For example, to return data for all countries except the US create the filter
"County Not Equal To US".
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Different From operator

Use the Different From operator to retrieve data different from a value.

For example, to retrieve data for all quarters execpt Q4, create the filter
[Quarter] Different From "Q4"

Greater Than operator

Use the Greater Than operator to retrieve data greater than a value.

For example, to retrieve data for customers aged over 60, create the filter
"[Customer Age] Greater than 60".

Greater Than Or Equal To operator

Use the Greater Than Or Equal To operator to retrieve data greater than or
equal to a value.

For example, to retrieve data for revenue starting from $1.5M, create the
filter "[Revenue] Greater than or equal to 1500000".

Less Than operator

Use the Less Than operator to retrieve data lower than a value.

For example, to retrieve data for exam grades lower than 40, create the filter
"[Exam Grade] Less Than 40".

Less Than Or Equal To operator

Use the Less Than Or Equal To operator to retrieve data less than or equal
to a value.

For example, to retrieve data for customers whose age is 30 or less, create
the filter "[Age] Less Than Or Equal To 30".
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Between operator

Use the Between operator to retrieve data between and including two values.

For example, to retrieve data for weeks starting at week 25 and finishing at
36 (including week 25 and week 36), create the filter "[Week] Between 25
and 36".

Not Between operator

Use the Not Between operator to retrieve data outside the range of two
values.

For example; to retrieve data for all the weeks of the year, except for and
not including weeks 25 through 36, create the filter "[Week] Not between 25
and 36".

In List operator

Use the In List operator to retrieve data corresponding to values in a list of
values.

For example, to retrieve data for the US, UK and Japan only, create the filter
[Country] In List ("US";"UK";"Japan").

Not In List operator

Use the Not In List operator to retrieve data that does not correspond to
multiple values.

For example, if you do not want to retrieve data for the US, UK and Japan,
create the filter [Country] Not In ("US";"UK";"Japan").

Matches Pattern operator

Use the Matches Pattern operator to retrieve data that includes a specific
string or part of a string.
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For example, to retrieve customers whose date of birth is 1972, create the
filter [DOB] Matches Pattern "72".

Different From Pattern operator

Use the Different From Pattern operator to return data that doesn't include
a specific string.

For example, to retrieve customers whose date of birth is not 1972, create
the filter [DOB] Different From Pattern '72'.

Both operator

Use the Both operator to retrieve data that corresponds to two values.

For example, to retrieve customers who have both a fixed and a mobile
telephone, create the filter [Account Type] Both 'Fixed' And 'Mobile'.

Except operator

Use the Except operator to retrieve data that corresponds to one value and
excludes another.

For example, to retrieve customers who have a fixed telephone and do not
have a mobile telephone, create the filter [Account Type] 'Fixed' Except
'Mobile'.

The Except operator is more restrictive than Different From or Not In
List. For example, a report that returns customers and that includes the
filter [Lines] Different From 'Accessories' excludes all sales records
where the item sold is part of the 'Accessories' line. If the same customer
has purchased Accessories and non-Accessories items, the customer still
appears in the report, but their spending total includes only non-Accessories
sales.

If the filter is [Lines] Except 'Accessories', only customers who have
bought no accessories are included in the report.

Related Topics
• Not In List operator on page 200
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• Different From operator on page 198

Combining query filters

Combining query filters

Typical business questions require you to retrieve information that matches
more than one criteria. For example, if you are analyzing customer services
data, you will most likely want to focus on customers for a specific time period
and also for a specific region, and probably also for a specific level of
customer service contract. You can retrieve data that answers several criteria
like this by combining filters in the same query.

Example: Analyze sales revenue this year at stores where the floor size
is over 4,000 square feet and sales revenue figures are equal to or less
than $1.5M

In this example, you are an operations manager for a retail chain. You want
to analyze information about the large retail stores in your chain that are
making less than the sales revenue figure your company has set as the
target.

To do this you add a predefined filter on the [Year] dimension to specify
that you only want to retrieve values for this year. Then you create a second
filter on the [Sales Floor Size] dimension to specify that you only want to
retrieve data for stores where the floor size is greater than 4,000 square
feet. After this, you create a third filter on the [Sales Revenue] measure to
specify that you only want to retrieve data for stores where the sales revenue
figures are equal to or less than $1.5M. Finally, you combine these three
filters with the And operator:

Last Year

AND Sales Floor Size Group Greater than or equal to:
4000

Sales Revenue Less than 1,500,000
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When you run the query, only data for stores that satisfy all three criteria
will be returned to the report.

To combine query filters
1. Create the filters and add them to the Query Filters pane.

By default, Web Intelligence combines the filters with the AND operator.

2. Double-click the operator (Java Report Panel, Rich Client and Query -
HTML) or click the arrow next to the operator checkbox and select the
other operator (HTML Report Panel) to toggle between AND and OR.

Nesting query filters

Nesting query filters allows you to create more complex filter conditions than
is possible when you combine filters at the same level.

When you nest filters, you set the order in which Web Intelligence evaluates
them. For example, Web Intelligence can return the data given by two query
filters joined in an OR relationship (where either one filter condition or the
other is true) and then further restrict this data by applying another filter to
it. In this case, the two filters in an OR relationship are nested, then compared
with the other filter in an AND relationship.

The following example illustrates this:

Example: List all sales made in Japan either in Q4 or where the revenue
was greater than 1000000

To answer this question you create the following nested query filter:

Country Equal To Japan

AND Quarter Equal To Q4

OR Revenue Greater Than
1000000
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Web Intelligence first returns sales data where the sale was made in Q4
or the revenue was greater than 1000000, then restricts this data further
by returning only those sales made in Japan.

To nest query filters
1. Drag and drop a report object onto an existing query filter.

A query filter outline on the report object appears in a nested AND
relationship with the existing query filter.

2. Define the new query filter.
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Filtering data using prompts
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What is a prompt?
A prompt is a special type of query filter. It is a dynamic filter that displays a
question every time you refresh the data in a document. You answer prompts
by either typing or selecting the value(s) you want to view before you refresh
the data. Web Intelligence retrieves only the values you specified from the
database and returns those values to the reports within the document.
Prompts allow multiple users viewing a single document to specify a different
sub-set of the database information and display it in the same report tables
and charts. Prompts also reduce the time it takes for the data to be retrieved
from the database.

A prompt contains the following elements:

• a filtered object
• an operator
• a message

For example, to prompt users to select a specific year, you define a prompt
on the [Year] dimension:

Year Equal To ("Which year?°)

In this prompt, the filtered object is [Year], the operator is Equal To, and the
prompt message is "Which year?".

You can define prompts on any dimension, measure, or detail object. For
example, you can filter the [Year] dimension to return values for a specific
year, filter the [Sales Revenue] measure to return values for a range of
revenue figures, or filter the [Year/week] detail to return values for a specific
week in a year.

You can create multiple prompts, related by the AND or OR operators, in
the same query. You can also nest prompts. When the user runs a query,
Web Intelligence displays the prompts.

Prompts appear in the SQL generated by a Web Intelligence query as either
the value supplied in response to the prompt (when the SQL is read-only),
or as Web Intelligence prompt syntax (when the SQL is editable). For
example, a prompt on [Country] can appear in the generated SQL as

Resort_Country.country = @prompt('Enter Country:','A',
'Resort\Country', Mono,Free,Persistent,,User:0)
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or as

Resort_country.country In ('UK')

Prompts can be optional. The user is not obliged to specfy a value for an
optional prompt. If no value is specified, Web Intelligence ignores the prompt.

Merged prompts

When a document contains multiple data providers, any prompts that include
(1) objects with the same data type, (2) operators of the same operator type,
and that (3) use the same prompt text are merged.

When all the data providers are refreshed, a single prompt message appears
for such prompts.

The List of Values displayed by the merged prompt is the list associated with
the object in the prompt that has the most display property constraints.

Cascading prompts
Some objects cause Web Intelligence to display a cascading prompt when
they are included in a prompt definition. The universe designer defines the
lists of values of these objects hierarchically in relation to other object lists
of values in the universe.

Cascading prompts help the user to focus on the object values they want to
include in the prompt without the need to search all possible object values.

Example: Choosing a store

In this example the universe designer has defined the [Store Name], [City]
and [State] objects in a hierarchy. If you include a prompt [Store Name]
Equal To <value>, Web Intelligence displays these objects in a hierarchy
in the Prompts dialog box. In order to select the store, the user must first
select the state in which the store city is found, then the city in which the
store is found, then the store itself. When the user selects the state, Web
Intelligence restricts the values of City to the cities in the state; when the
user selects the city, Web Intelligence restricts the stores to the stores in
the city.
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Hierarchical lists of values
If your universe contains hierararchical lists of values, these lists appear in
tree form. You navigate down through the tree to the items you want.

Whether a list of values appears as a cascading prompt or hierarchically
depends on how the list is configured in the universe. See your administrator
for more information.

Query filter and prompt operators

Equal To operator

Use the Equal to operator to obtain data equal to a value.

For example, to return data for the US only, create the filter "County Equal
To US".

Not Equal To operator

Use the Not Equal To operator to obtain data not equal to a value.

For example, to return data for all countries except the US create the filter
"County Not Equal To US".

Different From operator

Use the Different From operator to retrieve data different from a value.

For example, to retrieve data for all quarters execpt Q4, create the filter
[Quarter] Different From "Q4"
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Greater Than operator

Use the Greater Than operator to retrieve data greater than a value.

For example, to retrieve data for customers aged over 60, create the filter
"[Customer Age] Greater than 60".

Greater Than Or Equal To operator

Use the Greater Than Or Equal To operator to retrieve data greater than or
equal to a value.

For example, to retrieve data for revenue starting from $1.5M, create the
filter "[Revenue] Greater than or equal to 1500000".

Less Than operator

Use the Less Than operator to retrieve data lower than a value.

For example, to retrieve data for exam grades lower than 40, create the filter
"[Exam Grade] Less Than 40".

Less Than Or Equal To operator

Use the Less Than Or Equal To operator to retrieve data less than or equal
to a value.

For example, to retrieve data for customers whose age is 30 or less, create
the filter "[Age] Less Than Or Equal To 30".

Between operator

Use the Between operator to retrieve data between and including two values.
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For example, to retrieve data for weeks starting at week 25 and finishing at
36 (including week 25 and week 36), create the filter "[Week] Between 25
and 36".

Not Between operator

Use the Not Between operator to retrieve data outside the range of two
values.

For example; to retrieve data for all the weeks of the year, except for and
not including weeks 25 through 36, create the filter "[Week] Not between 25
and 36".

In List operator

Use the In List operator to retrieve data corresponding to values in a list of
values.

For example, to retrieve data for the US, UK and Japan only, create the filter
[Country] In List ("US";"UK";"Japan").

Not In List operator

Use the Not In List operator to retrieve data that does not correspond to
multiple values.

For example, if you do not want to retrieve data for the US, UK and Japan,
create the filter [Country] Not In ("US";"UK";"Japan").

Matches Pattern operator

Use the Matches Pattern operator to retrieve data that includes a specific
string or part of a string.

For example, to retrieve customers whose date of birth is 1972, create the
filter [DOB] Matches Pattern "72".
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Different From Pattern operator

Use the Different From Pattern operator to return data that doesn't include
a specific string.

For example, to retrieve customers whose date of birth is not 1972, create
the filter [DOB] Different From Pattern '72'.

Both operator

Use the Both operator to retrieve data that corresponds to two values.

For example, to retrieve customers who have both a fixed and a mobile
telephone, create the filter [Account Type] Both 'Fixed' And 'Mobile'.

Except operator

Use the Except operator to retrieve data that corresponds to one value and
excludes another.

For example, to retrieve customers who have a fixed telephone and do not
have a mobile telephone, create the filter [Account Type] 'Fixed' Except
'Mobile'.

The Except operator is more restrictive than Different From or Not In
List. For example, a report that returns customers and that includes the
filter [Lines] Different From 'Accessories' excludes all sales records
where the item sold is part of the 'Accessories' line. If the same customer
has purchased Accessories and non-Accessories items, the customer still
appears in the report, but their spending total includes only non-Accessories
sales.

If the filter is [Lines] Except 'Accessories', only customers who have
bought no accessories are included in the report.

Related Topics
• Not In List operator on page 200
• Different From operator on page 198
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To create a prompt
1. From the Data tab, drag the object on which you want to apply a prompt

and drop it onto the Query Filters pane.
The query filter appears in outline in the Query Filters pane.

2. Click the arrow at the right of the Query Filter and select Prompt from
the menu.

3. Type the prompt text in the text box.
4. Click the icon next to the text box and use the dialog box that appears to

set the prompt properties.
• If the prompt is for a date and you want users to see the popup

calendar in order to select the date(s) then do not select Prompt with
List of Values

• If the document contains multiple data providers, and there is already
a prompt that includes (1) objects with the same data type, (2)
operators of the same operator type, and (3) that uses the same prompt
text as the new prompt, Web Intelligence displays a warning to tell
you that the two prompts will be merged. This means that whenever
all the data providers are refreshed, a single prompt message will
appear for the two prompts.

5. Select Optional prompt to make the prompt optional.
6. To delete a prompt, right-click it and select Remove from the menu.

The prompt appears at each document refresh.

Related Topics
• Defining how prompts display on page 98
• Merged prompts on page 93

To remove a prompt
• Select the prompt and then click the Delete key.

Defining how prompts display
By default, prompts display a box and a list of values. You answer the prompt
by either typing the value(s) in the box or by selecting value(s) from the list.
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You can modify how prompts display by checking one, some, or all of the
following options:

then...(useful when you...)If you want the prompt
to display...

leave the option selected
by default: Prompt with
List of Values

want to view all the val-
ues for the object and
then select from those
values

the list of values associat-
ed with the filtered dimen-
sion, measure, or detail,

select the option: Keep
last values selected

often reselect the same
value(s) when you re-
fresh the document, but
want the ability to select
a different value when
necessary, such as the
name of the current
month

the value(s) specified the
last time the prompt was
answered (users can se-
lect a different value(s)),

select the option: Set de-
fault value(s)

almost always reselect
the same value(s) when
you refresh the docu-
ment, but want the ability
to select a different value
when necessary, such as
the number for the cur-
rent year

the value(s) you specify
as the default (users can
select a different val-
ue(s)),

select the option: Select
only from List

prevent users from typing
a value that might not ex-
ist on the database

a list of values from which
users select a value(s),

To make the prompt optional, selectOptional prompt. The user is not obliged
to specify a value for the prompt. In this case, Web Intelligence ignores the
prompt.

Note:
If the prompt is for a date and you want users to see the popup calendar in
order to select the date(s) then do not select Prompt with List of Values
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Combining prompts
Combining multiple prompts on a single query enables you to filter the data
returned to the document so that each person viewing the reports sees only
the information relevant to their business need. For example, you can
combine the following three prompts on a Customer Accounts document:

• Which customer?
• Which account?
• Which calendar period: from? to?

This enables each accounts manager viewing the document to view report
values for a specific customer account during a specific period.

You combine prompts in the same way that you combine query filters.

Combining prompts with query filters

Combining prompts and filters on a single query enables you decide the
values for some of the selected objects on the query using filters and allow
users to decide the values of other selected objects using prompts. For
example, if you combine the following filters and prompts on a HR document:

• [Year] Equal to This Year
• [Job title] Not equal to Senior Executive
• Which employee?

Users viewing the document can choose which employee they view
information for, but they can only view data for the current year and they
can’t view data for senior executives.

To change the order of prompts
1. Click the Properties tab in the Query Panel.
2. Select the prompt you want to move up or down in the prompt order in

the Prompt Order box, then press the Up or Down arrow next to the box.
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Combined queries defined
A combined query is a group of queries that work together to return a single
result. All queries in the group must be based on the same universe.

Types of combined query
You can combine queries in three relationships:

• union
• intersection
• minus

In a union combination, Web Intelligence takes the all the data from both
queries, eliminates duplicate rows, and builds a combined data set.

In an intersection combination, Web Intelligence returns the data that is
common to both queries.

In a minus combination, Web Intelligence returns the data in the first query
that does not appear in the second.

Example: Union, intersect and minus queries

In this example you have two queries that return lists of countries as shown
in the following table:

ValuesQuery

US; UK; Germany; FranceQuery 1

US; SpainQuery 2

Depending on the type of combined query, Web Intelligence returns the
following values:

ValuesCombination type

US; UK; Germany; France;SpainUNION
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ValuesCombination type

US;INTERSECTION

UK; Germany; FranceMINUS

What can you dowith combined queries?
Combined queries allow you to answer questions that are otherwise difficult
or impossible to frame in a single Web Intelligence query.

Example: Return a data set using a combined query

The Island Resorts Marketing sample universe contains the dimension
Year, which returns guests who have already stayed in a resort, and
Reservation Year, which returns guests who have reserved to stay in the
future. Because of the structure of the database and universe, these objects
are incompatible, which means that you cannot include them in the same
block in a report.

What if you want to return a single list of years that includes those years
where more than n guests stayed in a resort and those years where more
than n guests reserved to stay in a resort? You can do this using a combined
query, as follows:

ReturnsQuery

Years where more than n guests
stayed in a resortQuery 1

UNION

Years where more than n guests re-
served to stay in a resortQuery 2

The union between these two queries returns the list of years that you want.
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How does Web Intelligence generate
combined queries?

If your database supports the type of combination in your query, combined
queries work at the database level: they alter the query that Web Intelligence
submits to the database. They do so by generating SQL (Structured Query
Language) queries containing UNION, INTERSECT and MINUS operators.

Note:
SQL is the standard query language of relational databases, although each
database has its own dialect.

If your database does not support the type of combination in your query,
Web Intelligence performs the query at the report level by generating multiple
SQL queries whose data it resolves after retrieval from the database.

To build a combined query
1. Create an initial query in the Query Panel.
2. Click Add a combined query on the toolbar.

Web Intelligence adds a copy of the initial query to the data provider. The
second query has the following characteristics:
• It contains the same report objects as the original query.
• It does not contain the filters defined on the original query.
• It is combined with the original query in a UNION relationship.

3. To switch to a query, click Combined Query n in the bottom left pane of
the Query Panel.
The individual queries in the combined queries are named Combined
Query n.

4. To delete a query, right-click the Combined Query n you want to delete,
then select Remove on the menu.

5. To change the combination type, double-click on the operator. The
operator moves through the sequence UNION, INTERSECTION, MINUS.

6. Build each query within the combined query as you build any normal Web
Intelligence query.

7. Click Run Query.
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Combined query structure
The queries within a combined query must return the same number of objects
of the same data type and the objects must be in the same order. You cannot
combine queries when the number of objects in the query results and the
data types of those objects are not identical. For example, you cannot
combine a query than returns Year with a query that returns Year and
Revenue, and you cannot combine a query that returns Year with a query
that returns Revenue.

You must also pay attention to the semantics of your combined queries.
While it is possible to combine a query that returns Year with a query that
returns Region if both dimensions are of the same data type, the result - a
mixed list of years and regions - is unlikely to be meaningful. Typically, if
your first query contains a Year dimension, your second query also contains
a dimension that returns a list of years.

To return a list of years and reservation years based
on the number of guests

This example describes the workflow for the query described in the example
Return a data set using a combined query. You want to build a query that
returns a list of years consisting of years where more than n guests stayed
in a resort and years where more than n guests reserved to stay in a resort.

1. Select the Island Resorts Marketing universe in the list of universes to
open the Query Panel.

2. Drag the Year object to the Result Objects pane.
3. Drag the Number of Guests object to the Query Filters pane and create

a report filter that restricts Number of Guests to greater than n.
4. Click Combined Query.

TheCombined Query pane appears in the bottom left of the Query panel
with the two queries joined by UNION.

5. Click on the second query and remove the Year and Number of Guests
objects.

6. Drag the Reservation Year object to the Result Objects pane.
7. Drag the Future Guests object to the Query Filters pane and create a

report filter that restricts the future guests to greater than n.
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8. Click Run Query.

The query returns the combined list of years and reservation years.

Related Topics
• Return a data set using a combined query on page 103

Combined query precedence
The order in which Web Intelligence executes query combinations in a
combined query is crucial in determining the final result.

In the simplest form of combined query you combine two or more queries in
a relationship as follows:

Query 1

Query 2INTERSECTION

Query 3

In such a case, Web Intelligence first finds the set of data that represents
the union/intersection/minus between Combined Query n and Combined
Query n + 1, then finds the union/intersection/minus between that data set
and the data returned by Combined Query n + 2. Web Intelligence continues
in this way through all the queries in the relationship. This gives the following
result for the above example:

DataQuery

US; UK; France; GermanyQuery 1

US; France; FinlandQuery 2

US; FranceINTERSECTION of 1 and 2

US; SpainQuery 3

USFinal INTERSECTION
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Multiple combined queries

You can combine multiple queries in complex relationships to determine the
order of execution, as in the following example:

Combined Query 1

MINUS

Combined Query 2INTERSEC
TION

Combined
Query 3

Web Intelligence processes query groups from right to left as they appear
in the Query Panel, and from top to bottom within each group.
(Higher-precedence groups, such as the MINUS group in the above example,
appear indented to the right in the Query Panel.) In the above query Web
Intelligence first determines the result of the minus combination then finds
the intersection of this result with the result of Combined Query 3 as shown
in the following table:

ResultQuery

US; UK; Spain; GermanyQuery 1

GermanyQuery 2

US; UK; SpainQuery 1 MINUS Query 2

US; Spain; FinlandQuery 3

US; Spain

(Query 1 MINUS Query 2)

INTERSECTION

Query 3
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Note:
If your database directly supports the type of combined query you wish to
execute, Web Intelligence generates SQL containing combination operators.
In this case the order of precedence depends on the order of precedence
defined in the database. See your Web Intelligence administrator for more
details.

To set the order of precedence of combined queries
in the Java Report Panel

1. Build the first query in the Query Panel.
2. Click Combined Query.
3. Repeat these steps until you have built all the component queries.
4. To increase the precedence of a pair of queries, drag and drop a query

on to the query with which you want to associate it in the
higher-precedence pair.
Web Intelligence indents the source and target queries in the
drag-and-drop operation and combines them by default in a UNION.

5. Continue adding queries to the higher-precedence group by dragging
and dropping them on to the space between any two queries already in
the group.

6. To create further higher-precedence groups within an existing
higher-precedence group, repeat the previous two steps.

7. Double-click the combination operators of all the groups in the query to
change them as required.

8. Click Run Query.
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What is a subquery?
A subquery is a more flexible kind of query filter that allows you to restrict
values in more sophisticated ways than is possible with a ordinary query
filters.

Subqueries are more powerful than ordinary query filters for the following
reasons:

• They allow you to compare the values of the object whose values are
used to restrict the query with values from other objects.

• They allow you to restrict the values returned by the subquery with a
WHERE clause.

What can you do with subqueries?
Subqueries allow you to pose complex questions that are difficult or
impossible to formulate with simple query filters. For example: what is the
list of customers and their associated revenue where the customer purchased
a service that had previously been reserved (by any customer) in Q1 of 2003?

How do subqueries work?
Subqueries work by modifying the SQL that Web Intelligence generates to
retrieve the query data. Web Intelligence generates SQL containining a
subquery that restricts the data returned by an outer query. For more
information on SQL subqueries, see any book on SQL.

Note:
SQL is the query language supported by all relational databases (RDBMS),
although each database has its own syntax.

To build a subquery
1. Add the objects that you want to appear in the query to theResult Objects

pane.
2. Select the object in the Result Objects pane that you want to filter with a

subquery and click Add a subquery at the top right of the Query Filters
pane.
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The subquery outline appears in the Query Filters pane. By default the
object you selected appears as the Filter object and Filter By object.

3. To add a WHERE condition to the subquery, drag a report object to the
area of the subquery below the Drop an object here boxes.

4. To add a WHERE condition to the subquery, drag a report object to the
area of the subquery below the Drop an object here boxes.
You can use an existing subquery or standard query filter as a WHERE
condition in a subquery. To do so, drag and drop the existing filter or
subquery to the area of the subquery below the Drop an object here
boxes. To copy rather than move the existing filter to the WHERE
condition, hold down the Control key while dragging and dropping. In this
case the existing filter remains in its initial place and becomes part of the
WHERE condition of the subquery.

5. Select the operator and values used to filter the object in the WHERE
condition.

6. Click Subquery to add an additional subquery to the query filter.
In addition to linking subqueries in AND or OR relationships, you can nest
them (create subqueries within subqueries) by dragging an existing
subquery to the area beneath the Drop an object here boxes. In this
case the inner subquery becomes part of the WHERE condition of the
outer subquery. To copy rather than move the subquery to the WHERE
condition, hold down the Control key while dragging and dropping. In this
case the second subquery remains at the same level as the first, and
becomes part of the WHERE clause of the first.
By default the two subqueries are linked in an AND relationship. Click the
AND operator to toggle between AND and OR.

7. To nest a subquery (create a subquery within a subquery), drag an existing
subquery to the area beneath the Drop an object here boxes.
To copy rather than move the subquery to the WHERE condition, hold
down the Control key while dragging and dropping. In this case the second
subquery remains at the same level as the first, and becomes part of the
WHERE clause of the first
The inner subquery becomes part of the WHERE condition of the outer
subquery.
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To find out which customers bought a service that
had previously been reserved inQ1 of 2003, and how
much revenue have they generated

1. Drag the Customer and Revenue objects to the Result Objects pane of
the Query Panel.

2. Select the Service object.
3. Click Subquery.

The subquery outline appears in the Query Filters pane.

Note:
The selected object appears in both boxes in the subquery outline. You
often use the same object in both boxes, although this is not required. If
the objects do not return any common values, the subquery returns no
values, and the query therefore returns no values.

4. Drag the Reservation Year object to the area of the subquery outline
beneath the Service objects.
Web Intelligence adds a WHERE condition on the Reservation Year
object.

5. Set the Reservation Year condition operator to Equal To.
6. Type ‘FY2003’ in the Type a constant box.
7. Drag the Reservation Quarter object to the area of the subquery outline

beneath the Service objects.
Web Intelligence adds the Reservation Quarter object to the WHERE
condition.

8. Set the Reservation Quarter condition operator to Equal To.
9. Type ‘Q1’ in the Type a constant box.
10. Click Run Query to run the query.

Subquery parameters
A subquery or set of subqueries contains the following parameters:
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DescriptionParameter

The object whose values are used to
filter the result objects.

You can include more than one Filter
Object. If you do, Web Intelligence
concatenates the values of the ob-
jects you specify.

Filter Object(s)

The object that determines which
Filter Object values the subquery re-
turns.

You can include more than one Filter
By object. If you do, Web Intelligence
concatenates the values of the ob-
jects you specify.

Filter By Object(s)

The operator that specifies the rela-
tionship between the Filter object and
the Filter By object.

Because of database restrictions you
cannot use certain combinations of
operators and Filter By objects togeth-
er. For example, if you use the Equal
To operator with a Filter By object
that returns multiple values, the
database rejects the SQL because
this type of subquery requires the
Filter By object to return one value
only.

In cases where the generated SQL
is rejected by the database, you see
an error message showing the error
description returned by the database

Operator
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DescriptionParameter

An additional condition that con-
strains the list of values of the Filter
By object. You can use ordinary re-
port objects, predefined conditions
or existing query filters (including
subqueries) in the WHERE condition.

WHERE condition (optional)

If there is more than one subquery,
determines the relationship between
the subqueries.

AND - the conditions in all of the
subqueries must be satisfied.

OR - the conditions in any one of the
subqueries must be satisfied.

Relationship operator
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Ranking data using
database ranking
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What is database ranking?
When you rank data you sort and filter it according to ranking criteria. Web
Intelligence allows you to return unranked data from a database, then rank
it in Web Intelligence.

A database ranking allows you to specify a ranking at the query and database
level so that the data returned to Web Intelligence by the query is already
ranked.

Database rankings allow you to answer questions like Return the top 3
customers based on the revenue they generated for each year? at the query
level, without the need to return data that falls outside the ranking to Web
Intelligence and then filter it using a Web Intelligence ranking.

Database ranking has the following advantages:

• Ranking data can be processing-intensive. By ranking at the database
level you allow the server, which is typically far more powerful than the
client machine, to perform this processing.

• Pre-ranking data reduces the amount of data retrieved across the network
and stored in Web Intelligence.

A database ranking works by modifying the SQL that Web Intelligence
generates to retrieve the query data. If your database supports ranking, Web
Intelligence generates SQL to rank the data. Web Intelligence uses the
SQL-99 Rank function in ranking SQL. (SQL is the query language supported
by all relational databases (RDBMS), although each database has its own
syntax.)

Note:
You can perform a database ranking only if your database supports it. If this
is not the case, theAdd a database ranking button is disabled on the Query
Panel toolbar. Databases that support ranking are Oracle, DB2, Terradata
and Redbrick.

Related Topics
• Ranking data on page 266
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Database ranking parameters
A database ranking appears as follows in the Query Filters pane of the Query
Panel:

The following table describes the parameters from left to right in the ranking:

DescriptionParameter

Ranking order.
• Top - ranks in descending order.
• Bottom - ranks in ascending order.

Top/Bottom

The number of records to return in the
ranking. For example, the top 10.Number of records

The dimension used in the ranking. For
example, if the dimension is Region
and the ranking is Top 10, the ranking
returns the top 10 regions.

Ranking dimension

The measure by which the ranking di-
mension is ranked. For example, if the
measure is Revenue and the dimen-
sion is Region, Web Intelligence ranks
regions by the amount of revenue they
generate

Based on

Dimension that specifies additional
calculation context for the ranking. For
example, if the ranking dimension is
Region, the measure is Revenue and
the For Each dimension is Country,
Web Intelligence ranks regions by rev-
enue within each country.

For Each (optional)
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DescriptionParameter

Additional restriction on the values re-
turned in the ranking that appears be-
low the other parameters. For example,
a ranking of regions with a condition
that restricts Country to “USA ? ranks
only those regions in the USA.

WHERE condition (optional)

To create a database ranking
1. Add the objects that you want to appear in your query to the Result Objects

pane of the Query Panel.
2. Select the dimension that you want to rank by.
3. Click Add a database ranking on the toolbar at the top of the Query

Filters pane.
The ranking outline appears in the Query Filters pane. The dimension
you selected appears as the ranking dimension and the first measure in
the query appears as the ranking measure in the Based on box.

Note:
The Add a database ranking button is disabled if your database does
not support ranking.

4. Select the ranking direction (Top or Bottom).
5. Type the number of records you want the ranking to return in the box next

to Top/Bottom.
You can specify a prompt instead of a constant by clicking on the arrow
next to the number. When you select a prompt the user must enter the
ranking number when the query is run.

6. Drag the dimension that provides the calculation context for the measure
to the For Each box.
This dimension is optional. To display the For Each box, click the arrow
to the right of the Based on measure.

7. Drag any dimensions that you want to include in the WHERE restriction
to the area at the bottom of the ranking.

8. Click Run Query.
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Related Topics
• What is a subquery? on page 110

To create a report that returns the top 10 employees
based on salary, and calculated by department

1. Drag the Department, Employee Name, and Salary objects to the Report
Objects pane within the Query Panel.

2. Select the Employee Name object.
3. Click Add a database ranking on the toolbar.

Web Intelligence adds an outline database rank to the Query Filters pane.
The ranking dimension is Employee Name and the ranking measure is
Salary.

4. Set the ranking direction to Top.
5. Set the ranking number to 10.
6. Click the arrow next to the Based on measure if the For Each box is not

already visible.
7. Set the For Each dimension to Department by dragging and dropping the

dimension.
The ranking now looks like this:

8. Click Run Query.
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The Java Report Panel
reporting interface

10



By default, the Java Report Panel report interface appears as follows:
• Report tabs - a collection of four tabs at the left of the screen that you

use to work with reports.

DescriptionTab

Displays the universe objects, formulas and variables that
can be included in the report.

Data

Displays the tables, charts and cells that can be included in
the report.

Templates

Displays a hierarchical map of the report components (for
examples tables, cells, sections, filters).

Map

Displays the editable properties used to configure the appear-
ance and behavior of the report. The list of properties varies
depending on the report component selected.

Properties

• Toolbars

DescriptionToolbar

You use the main toolbar to switch between query view
and report view, to save and print documents, and to ac-
tivate data tracking and drill mode, and to configure the
report interface.

The main toolbar is always visible. All the other toolbars
can be hidden.

Main

You use the formatting toolbar to format text and report
objects.

Formatting

You use the report toolbar to add reporting features (for ex-
ample filters, variables, rankings, calculations).

Reporting

You use the page navigation toolbar to navigate through the
pages in a report.

Page Naviga-
tion

• Reports - by default the reports contained in the Web Intelligence
document appear to the right of the report tabs and below the toolbars.
Each report appears on its own
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You can configure the report interface (for example by hiding toolbars or
changing the position of the report tabs) by selecting options from the
Configure View menu on the main toolbar.
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Web Intelligence viewing
modes
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To switch between viewing modes
You can view Web Intelligence reports in different modes depending on how
you want to work with data and how you want the data to appear.

1. In Web Intelligence Interactive, select the report tab of the report you
want to view.

2. Click the arrow next to the View button on the main toolbar above the
report.

3. Select the viewing mode.
Web Intelligence Interactive displays the report in the selected viewing
mode.

4. In the Java Report Panel or Web Intelligence Rich Client, use Switch
Page/Quick Display on theReporting toolbar to alternate between Page
mode and Quick Display mode.

Draft mode

Draft mode displays just the tables, reports, and free standing cells in reports.

Use Draft mode when you want to focus on analyzing results, add calculations
or formulas, or add breaks or sorts to tables to organize results.

Page mode

Page mode displays the page layout of reports, including page margins,
headers, and footers.

Use Page mode when you want to fine-tune the formatting of tables and
charts and the layout of report pages.

PDF mode

PDF mode displays the report in PDF format.
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Use PDF mode when you want to view the report in PDF format or print the
report from within Adobe® Acrobat® Reader®.

Quick Display mode

Quick Display mode is the default display mode in Web Intelligence. It is a
pagination mode that is based on the data, rather than the physical size of
report pages. Quick Display mode displays just the tables, reports, and free
standing cells in reports and displays a maximum number of records vertically
and horizontally, depending on the Quick Display settings. Quick Display
mode also specifies the minimum page width and height and the amount of
padding around the edges of the report.

Because Quick display mode retricts the number of horizontal and vertical
rows, a report might not contain all possible data.

Use Quick Display mode when you want to focus on analyzing results, add
calculations or formulas, or add breaks or sorts to tables to organize results.

The Quick Display mode properties are configurable either by your
administrator in the CMC, or directly in Web Intelligence.

NotesWhere
config-
ured

Property

CMCMaximum verti-
cal records

CMCMaximum hori-
zontal records

CMCMinimum page
width

CMCMinimum page
height

CMCRight padding
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NotesWhere
config-
ured

Property

CMCBottom padding

• Impacts horizontal tables and crosstabs only
• Horizontal tables are never cut vertically
• The number of rows in a horizontal table is

ignored in vertical records calculation

Web Intelli-
gence

Vertical records
per page

• Impacts vertical tables, forms and crosstabs
only

• The number of rows in a vertical table is ig-
nored in horizontal records calculation

Web Intelli-
gence

Horizontal
records per
page

Other notes:
• Table headers and footers do not count as rows.
• Free standing cells and charts do not count as rows.
• Section cells do not count as rows when the section is not empty.
• Sections cells count as vertical rows when the section is empty.
• The Avoid Page Break in Block option has no effect in Quick Display

mode

To change Quick Display mode settings in Web Intelligence

You can change the number of horizontal and vertical records per page in
Quick Display mode in Web Intelligence.

1. In the Java Report Panel, set the Page Content > Vertical Records per
page and Page Content > Horizontal Records per page properties.

2. In Web Intelligence Interactive, right-click the report background, select
Format Report to display the "Format Report" dialog box, and set the
Number of vertical records per page and Number of horizontal
records per page in the General tab.

3. As a shortcut, vou can also use the icons on the Page Navigation toolbar
(Java Report Panel) or main toolbar (Web Intelligence Interactive) to
increase or decrease these settings by increments of 50.
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To select Enhanced Viewing mode

Your administrator can define minimum page margins, headers and footers
that are applied only when you view reports onscreen. This means that the
maximum amount of information on report pages is visible when you view
reports via your computer screen. To apply the page definition set up by your
administrator you need to select Enhanced Viewing mode.

1. Select Document > Properties (in Web Intelligence Interactive) or
right-click a report and select Document Properties (in the Java Report
Panel or Web Intelligence Rich Client).

2. Select Enhanced viewing mode.
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Displaying and hiding report
data
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You can hide and display report data by folding and unfolding the display of
different report elements.

You can fold and unfold sections, breaks and tables. Web Intelligence
conceals and displays data in different ways depending on the report element.

ResultReport ele-
ment

When a section is folded, section details are hidden and
free cells only are displayed.

Section

When a table or break is folded, the rows are concealed and
headers and footers only are displayed. (Tables must have
headers and footers to be folded and unfolded.)

Vertical tables and crosstabs only can be folded and unfold-
ed.

Note:
Folding and unfolding tables and breaks is supported by the
Web Intelligence Java Report Panel and Web Intelligence Rich
Client only.

Table or break

To display and hide report data
1. Click Fold/Unfold on the report toolbar.

The Fold/Unfold bar appears to the left of the report.

2. User the icons on the bar, which correspond to and are aligned with
individual report elements, to fold and unfold specific report elements.

3. Use the icons at the bottom of the bar to fold and unfold all instances of
a type of report element.
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Tables in Web Intelligence
When you create a new document and run the query the first time to display
the results, Web Intelligence generates a report that includes all of the results
in a vertical table. You can modify how the table is organized, remove or add
data, change the table type to display the results differently or insert other
tables. You can also insert free standing cells to display results in a single
cell.

Table types in Web Intelligence
A Web Intelligence report displays results in a block. You can format the
block as a specific type of table.

Vertical table

Vertical tables display header cells at the top of the table and the
corresponding data in columns. By default, the header cells display the names
of the dimensions, details, and measures included in the table. The body
cells display the corresponding values.
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Horizontal table

Horizontal tables display header cells at the left of the table and the
corresponding data in rows. By default, the header cells display the names
of the dimensions, details, and measures included in the table. The body
cells display the corresponding values.

Crosstab

Crosstabs display values for dimensions across the top axis and on the left
axis. The body displays the values of a measure that correspond to the
cross-section of the dimensions. For example, this crosstab displays values
for [Quarter] across the top axis and displays values for [State] on the left
axis. The body displays values that [Sales Revenue] for each quarter in each
state.

You can include multiple dimensions in crosstabs. For example, this crosstab
displays two dimensions. The values for the [Sales Revenue] measure are
values each state by quarter for each line.
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When you create crosstabs that include a dimension(s) in the body, the body
cell values are calculated according to a multi-dimensional data model. The
values displayed in the body are calculated according to all of the coordinates
on the table axes, whether or not there is a row for the specific coordinate
in the SQL result.

Forms

Forms are useful in your report if you want to display detailed information
per customer, product, or partner. For example, a form is a useful way of
displaying individual customer records with information such as the customer
account, name, address, and so on.

Forms are also useful for formatting address labels for envelopes.
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Structure View and Results View
The Web Intelligence Java Report Panel allows you to make modifications
to documents and preview those changes in Structure View, without
implementing each change on the Web Intelligence server. This enables you
to make multiple formatting changes quickly and preview them. When you
return to Results View, Web Intelligence requests the server to apply the
changes and returns the modified format in a single operation.

You can create and format tables in either Structure View or Results View.
If you have several modifications to make, however, we recommend you
make the modifications in Structure View.

Creating and editing tables

To create a table by dragging objects onto a report

1. If the report is empty, select either a single object or a class folder on the
Data tab, and then drag and drop the object or class onto the report.
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2. If the report already contains tables or charts, press the Alt key, then with
the Alt key pressed, drag an object onto an empty area of the report.
A new table header and body cell appears on the report. The table header
displays the name of the object.

3. To add another object to the table, drag another object from the Data tab
and place it to the left or right of the existing column header.

4. When the “Drop here to insert a cell ? ToolTip appears, drop the object
onto the left or right of the table header.
A second column appears before or after the first column. The new column
header displays the name of the object.

Web Intelligence displays the values in a vertical table. You can quickly turn
the vertical table to a different table format, such as a crosstab by using the
Turn To feature.

To create a table by selecting a template

1. Click View Structure.

Working in Structure View allows you to define and preview the new table
without requesting the server to apply each of your modifications. You
then apply all your modifications and display the results in the new table,
by returning to Results View.

2. Click the Templates tab.
3. Drag a template from the Template tab onto a blank area of the report.

The template appears on the report.

4. Click the Data tab.
The objects and variables that the document contains appear here. You
can add any of these objects or variables to the table.

5. Drag an object or variable onto an empty header or body cell of the table.
6. When the ToolTip “Drop here to replace cell ? appears, drop the object

onto the table.
The empty cell is replaced by the object. If you are working in Results
View, the values of the objects display on the table. If you are working in
Structure View, the name of the object displays on the table.

7. To add more objects to the template, drag an object from the Data tab
and drop it onto the template.
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Once you have allocated objects to each part of the table template, you
can add more objects to increase the size of the table. Each additional
object inserts more columns or rows onto the table.

8. To add another object and create an additional table column or row, drag
an object from the Data tab and drop it onto a row or column.
• If you drop the object onto the left of a column, you create a new

column before the existing column.
• If you drop the object onto the right of a column, you create a new

column after the existing column.
• If you drop the object onto the top edge of a row, you create a new

row above the existing row.
• If you drop the object onto the bottom edge of a row, you create a new

row below the existing row.

9. If you are working in Structure View, click View Results to display the
values in the new table.

To duplicate a table

1. Select a table on a report.
A gray border appears around the table, when the table is selected.

2. Keep your pointer pressed in and press the Ctrl key.
Web Intelligence creates a duplicate table on top of the original table.

3. With your pointer and the Ctrl key pressed in, drag the duplicate table to
an empty area of the report.
The duplicate table appears on the report.

To apply a different template to a table by using drag
and drop

1. Select the report tab that contains the table you want to modify.
2. Click the Templates tab.

If the Templates tab is hidden, click the Show/Hide Manager button on
the Report toolbar. The Templates appear.

3. Drag a template from the Template tab onto a table. You must drop the
template directly on the existing report block.
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Web Intelligence applies the new template to the table values.

To apply a different template to a tablewith Turn To

1. To select the table you want to reformat, click the top edge of the table.
A gray border appears around the table.

2. Right-click the report block.
3. On the shortcut menu, click Turn To.

The "Turn To" dialog box appears.

4. On the Tables tab or on one of the Chart tabs, select the table or chart
template you want to apply to the table.

5. Click OK.

If you turned a table to a chart, the unicode font is not retained in the chart
if the font for the text on the table was unicode, and if unicode is not defined
as your default font for charts. You need to format the chart with the unicode
font, if this font is available on your computer. If this is not the case, you need
to contact your administrator to configure the Web Intelligence server and
your computer appropriately.

To add rows or columns to tables usingdrag anddrop

• Drag the object you want to add to the table from the Data tab, and drop
the object where you want to add it:
• To add the object into a new column to the left of an existing column,

drag the object onto the left edge of a column header.
• To add the object into a new column to the right of an existing column

, drag the object onto the right edge of a column header.
• To add the object into a new row before an existing row, drag the

object onto the top edge of a row header.
• To add the object into a new row after an existing row, drag the object

onto the bottom edge of a row header.
The name of the object appears in the new column or row header, and
the values appear in the new body cells.
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To add table rows or columns using the Insert row
or column toolbar menu

1. Select the table you want to reformat.
2. Select the column or row next to which you want to insert the new column

or row.
3. The Insert column or row button automatically displays one of the insert

options.
4. Click the displayed option or click the arrow next to the Insert button, and

then select the appropriate option from the drop-down menu.
Web Intelligence adds a blank column or row to the table.

5. Drag an object from the Data tab, and drop the object onto the blank
column or row.
Web Intelligence allocates the selected object to the new column or row.
The name of the object displays in the column or row header, and the
values for the object display on the body cells.

To remove table rows or columns

• Right-click the table column or row you want to remove and select
Remove Row, Remove Column or Remove from the shortcut menu.

To move a row or column

• Drag the selected column or row and drop it before or after another column
or row on the table.
When you drag a row or column, the column or row header displays next
to your pointer.

To swap a row or column

• Drag the selected column or row onto the column or row with which you
want to make the swap
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Web Intelligence swaps the two columns or rows.

To replace a row or column

1. Select the report tab that contains the table you want to modify.
2. Click the Data tab.
3. Drag the object you want to add to the table from the Data tab, and then

drop the object onto the row, column, or body you want to replace.
The values for the new object display on the table.

To clear cell contents from a table

You can clear cell contents and then use the empty cells to display images,
hyperlinks, formulas, or text you type.

You can clear the following types of cell in a table:
• header cells – you can clear each header cell separately
• footer cells – you can clear each footer cell separately
• related body cells – when you clear one body cell, you automatically clear

all of the body cells in the same column or row of the table

1. To select the cell you want to clear, click the cell.
The cell borders are highlighted.

2. Right-click the selected cell.
The shortcut menu appears.

3. The shortcut menu appears.
4. Click Clear Cell Contents.

Web Intelligence clears the contents from the selected cell(s).

To remove a table

1. To select the table you want to remove, click the top edge of the table.
A gray border appears around the table.
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2. Press the Delete key, or right-click the selected table and select Remove
from the shortcut menu.

Formatting tables and table cells

To select a background color for the table

1. Select the table or table cell for which you want to format a background.
2. Right-click the table border, then select Format, or right-click within the

table, then select Format > Table from the shortcut menu.
The Properties tab displays the table formatting options.

3. Select the drop-down arrow next to Appearance > Background color.
A list of available colors appears.

4. Click the color you want to apply to the selected table or table cell, or click
Custom, and then create a custom color, using the Swatches, HSB
(Hue, Saturation, Brightness), or RGB (Red, Green, Blue) tab, and click
OK.
If you know the RGB hexadecimal color reference, you can type the
reference into the combo boxes next to the + and - buttons on the RGB
tab.
Web Intelligence applies the background color to the selected table or
cell.

Todefine alternate row and column colors for a table

1. Select the table for which you want to format alternate row colors.
When the table is selected, a gray border appears around the table.

2. Right-click the table border, then select Format, or right-click within the
table, then select Format > Table from the shortcut menu.
The Properties tab displays the table formatting options.

3. Open the Appearance > Alternate Row/Column color property group.
4. Set the frequency for the alternate row color in the combo box next to

Frequency by clicking the + or - sign, or by entering a number.
5. Click the arrow next to Color.
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6. Select a color from the list of colors, or click Custom, and then create a
custom color, using the Swatches, HSB (Hue, Saturation, Brightness),
or RGB (Red, Green, Blue) tab, and click OK.
If you know the RGB hexadecimal color reference, you can type the
reference into the combo boxes next to the + and - buttons on the RGB
tab.

To insert an image or skin in a table

1. Right-click the table border, then select Format, or right-click within the
table, then select Format > Table from the shortcut menu.
The Properties tab displays the table formatting options.

2. Click the ... button next toBackground image in theAppearance property
sub-group to display the "Background Image" dialog box.

3. To display a skin, select Skin then select the skin from the list.
4. To reference an image using a URL, select Image from URL then type

the URL.
• To access an image on the corporate Web Intelligence server, type

the image name. Web Intelligence inserts boimg:// when you click
Apply.

• To access an image file directly, click Image from file, then click
Browse to browse to the file.

5. If you chose to reference an image file, use the Display and Position
lists to determine how the image appears.

To format table or cell borders

1. Right-click the table or cell, then select Format > Table or Format > Cell
from the shortcut menu.
The Properties tab displays the table or cell formatting options depending
on which option you selected.

2. Click the ... button next the the Text Format > Borders property.
3. Use the buttons in the "Border Editor" dialog box to set the border style.

You can also set the borders of header cells, body cells and footer cells
in the table properties. To do so, click the ... button next to the Borders
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property in the Header cells, Body cells and Footer cells property
sub-groups.

To format text in table cells

1. Right-click the table border, then select Format, or right-click within the
table, then select Format > Table from the shortcut menu.
The Properties tab displays the table formatting options.

2. Click the ... button next to the the Text format property in theAppearance
> Header cells/Body cells/Footer cells property sub-group.

3. Format the text in the Format Text dialog box.
You can also format cell text by selecting the cell then setting the
Appearance > Text Format property in the Properties tab.

To set cell height and width

You can define the height and width of cells by using drag and drop or
specifying the size of cells on the Properties tab.

If you want to hide cell contents on reports, you can set the cell width to 0.1
cm so that the cell width can be modified to display the cell contents later.

1. Drag the cell borders until the cell is the height and width you want, or:
2. Click the table.

The Properties tab displays the table formatting options.

3. Set the Width and Height properties in the Display properties group.
4. If you want to set the cell to autofit, select Autofit Width and/or Autofit

Height.

Some Web Intelligence functions are incompatible with AutoFit cells. If
you place any of these functions in an AutoFit cell, Web Intelligence
returns the #RECURSIVE error message as the function output.

You can also set AutoFit cell width and height by double-clicking the cell
borders.
• To set AutoFit cell width, double-click the right border of the cell
• To set AutoFit cell height, double-click the bottom border of the cell
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AutoFit retains the current cell size as the minimum size and enlarges
the cell size, if the string or image that the cell contains is larger than the
minimum size specified.

Documents that contain tables with the cell size set to AutoFit, take longer
to display in the Java Report Panel or InfoView than documents where
tables contain cells with a fixed cell width and cell height. We recommend
that for large documents, you specify a fixed sized for cell width and cell
height for tables.

Effects of autofit and wrap text

The following table lists the effects of the autofit and wrap text features, when
used seperately and in combination:

EffectFeature

Text is wrapped at the end of the cell.Wrap text

Cell width is adjusted to display all the text.Autofit width

Cell height is adjusted to display all the text.Autofit height

Cell width and height is adjusted to display all the textAutofit width + autofit
height

Cell width is adjusted to accomodate the longest word.
Because the cell height is not adjusted to the number
of lines of text, text might be truncated vertically.

Wrap text + autofit width

Cell height is adjusted to accommodate the number
of lines of text created by the wrap text. Because the
cell width is not adjusted to the longest word, text
might be truncated horizontally.

Wrap text + autofit
height

Cell height and width is adjusted to the text and there
is no horizontal or vertical truncation.

Wrap text + autofit
height + autofit width

To copy formatting using the Format Painter

You can quickly apply the formatting from a report, table or cell to other
reports, tables or cells using the Format Painter.
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The formatting options applied depend on the objects you choose as the
source and target. In general, only properties that affect the visual formatting
(for example font style, background color) are applied. Properties that affect
the display of data (for example, table properties such as "Avoid duplicate
row aggregation" property) are not applied.

1. Select the report, table or cell whose formatting you want to apply.
2. Click the Format Painter to apply the formatting once, or double-click to

apply the formatting multiple times.

The Format Painter is the button furthest to the right on the Formatting
toolbar.

3. Click the report, table or cell to which you want to apply the formatting.

Web Intelligence applies the formatting to the report, table or cell you
selected. If you single-clicked the Format Painter, it is deactivated.

If you double-clicked the Format Painter, it remains activated.

4. If you double-clicked, click the Format Painter again or press Esc to cancel
the formatting operation. (You can do this before applying the formatting
for the first time if you decide to abandon the formatting operation.)

To set the position of a table or chart on the report
page

1. Select the border of the table or chart.
The properties appear in the Properties tab.

2. Open the Page layout > Relative Position property group on the
Properties tab, then click ... next to the property.

3. Use the "Relative Position" dialog box to set the position.

To layer tables and cells

Layering determines how tables and cells appear when they occupy the
same space in a report. An object further forward in the layering order appears
over an object further backward in the layering order.

1. Select the table or cell whose layer you want to set.
2. Right-click, click Order and click the layering option.
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DescriptionOption

Make the table or cell the first object in the layering or-
der.

Bring to front

Make the table or cell the last object in the layering or-
der.

Send to back

Bring the table or cell one layer forward in the layering
order.

Bring forward

Send the table or cell one layer backward in the layering
order.

Send backward

To merge table cells

1. Select the cells you want to merge by holding down the Ctrl button and
clicking the cells.

2. Select Yes next to the Appearance > Text Format > Merge Cells
property on the Properties tab.
When you merge cells the merged cell contains the data from the first
cell you selected only. Data from all the other cells is lost.

Modifying tables to create crosstabs

To create a crosstab by adding an object to a vertical
or horizontal table

1. Drag an object from the Data tab onto the top edge of the table or the left
side of the table where you want to create the new axis and form the
crosstab.

2. When the ToolTip “Drop here to create a crosstab ? appears, drop the
selected object onto the report.
Web Intelligence creates a second axis to form a crosstab and inserts
the object on the new axis.
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To create a crosstab by moving a column or row

1. Select the table column or row you want to move to create the crosstab.
2. Drag the selected column or row onto the top edge of the table or the left

side of the table where you want to create the new axis and form the
crosstab.

3. Drop the column or row onto the header.
Web Intelligence creates a second axis to form a crosstab, and displays
the data of the column or row you moved on the new axis.

Controlling data display in tables

Showing or hiding empty tables, rows or columns

Sometimes tables or specific rows and columns display no values. For
example, if a sales of a specific product are discontinued, table rows or
columns that normally show results for that product appear empty. By default,
Web Intelligence displays such empty rows, columns, or tables. You can
choose to display or hide empty tables, rows or columns.

To show or hide empty tables, rows or columns

1. Select within the table, right-click and select Format > Table on the menu.
The Properties tab displays the table formatting options.

2. Select Display > Show when empty to display empty tables.
3. Select Display > Show rows/columns with empty measure values to

display rows or columns with empty measure values.
4. Select Display > Show rows/columns with empty dimension values

to display rows/columns with empty dimension values.
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Aggregating duplicate rows

When rows contain duplicate data, Web Intelligence aggregates measure
values by default.

To avoid duplicate row aggregation

1. Select within the table, right-click and select Format > Table on the menu.
The Properties tab displays the crosstab formatting options.

2. Select Display > Avoid duplicate row aggregation.

To show or hide headers and footers

1. Select within the table, right-click and select Format > Table on the menu.
The Properties tab displays the crosstab formatting options.

2. Select Display > Show table headers to display the headers.
3. Select Display > Show table footers to display the footers.

To start tables on a new report page

1. Select within the table, right-click and select Format > Table on the menu.
The Properties tab displays the crosstab formatting options.

2. Select Page Layout > Relative Position > Start on a new page.

To display object names in headers on crosstabs

1. Select within the table, right-click and select Format > Table on the menu.
The Properties tab displays the crosstab formatting options.

2. Click Display > Show object name to display the object names in
additional headers on the crosstab.
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To avoid page breaks in tables

1. Select within the table, right-click and select Format > Table on the menu.
The Properties tab displays the crosstab formatting options.

2. Select Page Layout > Relative Position > Avoid page breaks in table.

To repeat table headers or footers on report pages

1. Select within the table, right-click and select Format > Table on the menu.
The Properties tab displays the crosstab formatting options.

2. Select Page Layout > Relative Position > Repeat header on every
page to repeat the header on every page.

3. Select Page Layout >Relative Position >Repeat footer on every page
to repeat the footer on every page.

Copying tables

To copy a table

You can copy and paste tables within a report or into external applications
such as Microsoft Word and Excel. You cannot copy tables from one instance
of Web Intelligence to another.
1. Select the table, right-click and select Copy on the menu.
2. To paste the table to another part of the report, right-click where you want

the table to appear and click Paste on the menu.
3. To paste the table into another application, paste the contents of the

clipboard from within the other application.
You can also copy a table into another application by dragging and
dropping the table directly into the open document in the target application.
The table appears as a picture in the open document if pasted to another
application.
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To copy a table as text

You can copy the data in a table as plain text into another application. For
example, if you copy a table as text into Microsoft Excel, Web Intelligence
copies the text in each table cell to a cell in the Excel worksheet. Web
Intelligence copies the text to the clipboard as tab-separated text.
1. Select the table, right-click and select Copy as text on the menu.
2. Paste the contents of the clipboard into the target application.

If you choose Copy as text, then paste the table into the current Web
Intelligence report, the table appears as a normal Web Intelligence table.
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Free-standing cells defined
Free-standing cells are single cells that stand alone in a report. You can
place any text or formula in a blank free-standing cell, or you can use
pre-defined free standing cells that display specific information.

The free-standing cells are available in the Templates tab in the Java Report
Panel and Web Intelligence Rich Client, or in the Table, chart and cell types
tab in the Left Panel in the Web Intelligence HTML viewer.

The available free-standing cells are listed below.
• Formula and Text Cells:

• Blank Cell - Empty cell in which you can enter any text or formula.
• Drill Filters - Uses the DrillFilters function to display details of the

drill filters applied to the report.
• Last Refresh Date - Uses the LastExecutionDate function to display

the last date when the document was refreshed.
• Document Name - Uses the DocumentName function to display the

document name.
• Query Summary - Uses the QuerySummary function to display details

of the queries in the document.
• Prompt Summary - Uses the PromptSummary function to display details

of the prompts in the document.
• Report Filter Summary - Uses the ReportFilterSummary function to

display the report filters applied to the report.
• Page Number Cells:

• Page Number - Uses the Page function to display the number of pages
in the report.

• Page Number/Total Pages - Uses the Page and NumberOfPages
functions to display the current page number and the total number of
pages in the report.

• Total Number of Pages - Uses the NumberOfPages function to display
the total number of pages in the report.

For more information on the functions used in free-standing cells, see the
Using Functions, Formulas and Calculations in Web Intelligence guide, or
see the online help.
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To insert a free-standing cell in a report
1. Ensure that the Templates tab is displayed.

You can display the Templates tab by selecting Configure View > Data
on the main menu.

2. Expand the Report Elements > Free-Standing Cells element in the
Templates tab to display the free-standing cells.
The free-standing cells are divided into two groups: Formula and Text
Cells and Page Number Cells.

3. Drag the free-standing cell you want onto the report.
4. Add your own text or formula iif the cell you inserted is a blank cell.
5. Right-click the cell and select Edit Format to display the cell format

properties on the Properties tab.
6. Set the properties on the Properties tab to format the cell.
7. To delete the cell, select it and click the Delete button.

To copy a free-standing cell
You can copy and paste free-standing cells within a report or into external
applications such as Microsoft Word and Excel. You cannot copy
free-standing cells from one instance of Web Intelligence to another.
1. Select the free-standing cell, right-click and select Copy on the menu.
2. To paste the free-standing cell to another part of the report, right-click

where you want the free-standing cell to appear and click Paste on the
menu.

3. To paste the free-standing cell into another application, paste the contents
of the clipboard from within the application.
You can also copy a free-standing cell into another application by dragging
and dropping the free-standing cell directly into the open document in the
target application.
The free-standing cell appears as a picture in the open document if pasted
to another application.
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To copy a free-standing cell to another
application as text

You can copy the data in a free-standing cell as plain text into another
application. For example, if you copy a free-standing cell as text into Microsoft
Excel, Web Intelligence copies the text in the free-standing cell to a cell in
the Excel worksheet.
1. Select the free-standing cell, right-click and select Copy as text on the

menu.
2. Paste the contents of the clipboard into the target application.

If you choose Copy as text, then paste the free-standing cell into the
current Web Intelligence report, the free-standing cell appears as a normal
Web Intelligence free-standing cell.
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Using sections to group data

Grouping information with sections

Sections allow you to split report information into smaller, more
comprehensible parts.

Example: Grouping quarterly revenue results into sections on a report

You are the regional sales manager in Texas. You receive a report showing
2003 annual revenue for stores in your region, broken down by cities and
quarters.

Sales revenueQuarterCity

314430Q1Austin

273608Q2Austin

294798Q3Austin

252644Q4Austin

215874Q1Dallas

194689Q2Dallas

204066Q3Dallas

188791Q4Dallas

572177Q1Houston

619924Q2Houston

533765Q3Houston

520332Q4Houston
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To make a comparison of the results for each city per quarter, you set
[Quarter] as a section value. The report is broken up into four separate
sections by quarter.

Q1

Sales revenueCity

314430Austin

215874Dallas

572177Houston

Q2

Sales revenueCity

273608Austin

194689Dallas

619924Houston

Q3

Sales revenueCity

294798Austin

204066Dallas

533765Houston

Q4
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Sales revenueCity

252644Austin

188791Dallas

520332Houston

You can create a single section or include multiple sections with subsections
in a report. You can also remove and reposition sections within a report.

You can create a section from one of two sources:

• on a dimension already displayed on a table or chart
• on a dimension included in the document but not displayed on a table or

chart

You cannot create a section with a measure object.

Sections in Structure View

The following illustration shows a report with sections in Structure View.
When you view a report in Structure View, each section is clearly indicated
by a section divider.It is easier to format sections when you work in Structure
View.
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Creating and removing sections and subsections

To create a section by moving a cell from a table

1. Verify you are viewing the report in Report View.
2. Select the header cell on the table that displays the name of the

dimension, or select a body cell on the table that displays a value for the
dimension.
For example, if you want a section for each state, either select the header
cell labelled “State ? or select one of the cells that displays the name of
a state.

3. Drag the selected cell above the table and drop it onto the report
background.
A section is created for each value of the selected dimension.

To create a section by adding a dimension from the Data tab

1. Click the Data tab.
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2. Select a dimension object and, then drag the dimension over to an empty
area of the report.

3. Position and drop the dimension where you want the section cell to appear.
If the report includes tables or charts, then drop the section cell above
the tables and charts that you want to be included in the section.
• If you are in Results View, a cell containing one value for each unique

value for the added object appears above the table or crosstab. The
data in the table or crosstab is automatically sorted according to the
cell value.

• If you are in Structure View, a cell is added above the table or crosstab.

4. If you are in Structure View, click View Results to see the results.
Web Intelligence applies the section to the report and displays the results.

Creating subsections

You can create a report with multiple sections. You create multiple sections
in the same way you create a section:

• by moving a cell from a table and dropping the cell below an existing
section cell

• by selecting a dimension object listed on the Data tab (in the Java Report
Panel or Web Intelligence Rich Client) , and then dragging and dropping
the dimension below an existing section cell.

To remove a section cell or section

1. To delete a section, click the beginning or end divider of the section, then
press the Delete key.

2. To delete a section cell, right-click the cell, then select Remove from the
menu.

Section properties

You can set the following properties for a section:

• name the section
• specify your criteria for when you consider a section to be empty. (For

example, you may consider a section of no interest for your analysis
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whenever a specific table or chart within that section is empty. In this
case you can choose to specify that the section is to be considered empty.
)

• hide or show sections that you consider empty
• include links to sections in the report map so you can jump from

section-to-section when navigating the report

To set the section display properties

1. Make sure you are in Report View.
2. Click View Structure.

In Structure View you can see the start and end divider of each section
on the report. This makes it easy for you to select a specific section and
then choose the properties you want to apply to the selected section.

3. Right-click the section divider.
The Properties tab shows the properties relevant to sections

4. Set the section properties.

then...If you want to...

type a name for the section in the
General > Name property.

Name of the section with a different
name from the name of the dimen-
sion selected for the section,

Check the components in the drop-
down list next to the Display > Hide
section when empty property.

Specify the component(s) of the sec-
tion that will qualify the entire section
as an “empty section, ? if there is no
data on the database for that compo-
nent(s),

check Show when empty. (To hide
empty sections, uncheck this option.)

Show the section when there is no
data on the database for this section,

5. Click the View Results button to view the properties applied to the results
on the report.
Web Intelligence applies the properties to the section and displays the
results on the report.
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To set the page layout for a section

1. To set the cell position, right-click the section cell then click Format on
the menu, then set the Page Layout > Relative Position > Left edge
and Top edge properties on the Properties tab.

2. To control the section page breaks, select the section divider, then set
the Page Layout > Avoid page break in section property in the
Properties tab.

3. To repeat the section cell on each new page, select the section, then
select Page Layout > Start on new page on the Properties tab.

Using breaks

Breaks defined

A break is a division within a block in which data is grouped according to a
selected dimension, detail, or measure into self contained sections. These
sections are represented as smaller tables within the same block of data.

You use breaks to display all the data for each unique value of an object in
separate parts.

Using breaks has two main advantages:

• You can more efficiently organize how your data is represented.
• You can display subtotals.

Breaks compared to sections

A section breaks up the data into multiple free-standing cells called section
headers. Each section header contains one value for a dimension, with a
block of data that corresponds to the dimension value.

A break divides the data up within one block. One column contains the values
for a dimension, detail, or measure, which are repeated for each other row
of values in the block.
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Default sort order in breaks

When you insert a break on an object, the values for the object are
automatically sorted in ascending order as follows:

• If the values are numeric, the lowest value appears in the first row of the
table, the highest in the last row.

• If the values are alphabetical characters, then the values are sorted in
alphabetical order from top to bottom.

You can change this sort order at any time.

You can set multiple breaks and set a sort priority on each break, so that
you control how the data is displayed when you insert multiple breaks across
several dimensions details, or measures.

To insert a break

1. Click a table cell in the column or row where you want to insert a break.
2. Click Insert/Remove Break on the Reporting toolbar.

Web Intelligence divides the table up into as many mini tables as there
are unique values for the selected cell. Web Intelligence inserts a footer
at the end of each break.

To prioritize breaks

A table can contain multiple breaks that you can prioritize. For example, you
can decide to break on [Year] then on [Quarter], or on [Quarter] then on
[Year].

1. Right-click the table that contains multiple breaks and select Format >
Table.
The Properties tab shows the properties relevant to a table.

2. Click the ... button next to the Breaks > Break priority property to display
the "Breaks" dilaog box

3. Click Vertical breaks or Horizontal breaks to display the type of break
you want to prioritize.
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• If the selected table is a vertical table, then all the breaks are applied
to columns. These are called Vertical breaks.

• If the selected table is a horizontal table, then all the breaks are applied
to rows. These are called Horizontal breaks.

• If the selected table is a crosstab, then breaks can be applied to rows
or to columns. You can choose the priority for the Horizontal breaks
and for the Vertical breaks.

4. Select the break whose priority you want to change and click the Up/Down
buttons to promote/demote the break in the list of breaks.

To define display properties of a break

You can define the following display properties of a break:

DescriptionProperty

A header is displayed for each part of
the table, crosstab, or form when you
insert a break.

Show break header

A footer is added after the last row for
a table or column for a crosstab when
you insert a break. When you apply a
calculation to the data, the result is
shown in the footer.

Show break footer

Removes all duplicate values from the
data in a table or crosstab when you
insert a break. Each value is only
shown once.

Remove duplicate values

Active when Remove Duplicates is
selected. It merges empty cells and
centers the value name over the
merged cells.

Center values across break

Apply implicit sort to values
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DescriptionProperty

Displays each part of the table
crosstab, or form created by a break
on a new page.

Start on a new page

Where possible, keeps each break
section on the same page. This option
is not taken into account when a block
is larger than one page.

Avoid page breaks in tables

Repeats the header at the top of the
table on every new page when a table
goes over onto a new page.

Repeat header on every page

Repeats the footer at the bottom of the
table on every new page when a table
goes over onto a new page.

Repeat footer on every page

Repeats the current value on each new
page.Repeat break value on a new page

1. Click a cell in the column/row on which you have defined a break.
2. Open the Breaks property group in the Properties tab.
3. Set the break properties in the Breaks property group.

Some of the properties are contained in the Breaks > Page layout
property subgroup.

To remove a break

1. Select the column that contains the break.
2. Click Insert/Remove Break on the Reporting toolbar.
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Using sorts to organize data

Sorting the results displayed on reports

You can apply sorts to the values displayed in tables and sections to organize
the order in which values are displayed in a report.

The following sort orders are available:

DescriptionSort order

This is sometimes referred to as the
natural order. Depending on the type
of data in the column or row, the re-
sults are sorted as follows:
• ascending numeric order for numer-

ic data
• ascending chronological order for

date
• Chronological order for months
• alphabetical order for alphanumeric

data

Default

When selected, results are arranged
in ascending order: The smallest
value at the top of the column moving
to the highest value at the bottom.

For example: 100, 200, 300 or Cali-
fornia, Colorado, Florida.

Ascending
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DescriptionSort order

When selected, results are arranged
in descending order: The highest
value at the top of the column moving
to the smallest value at the bottom.

For example: 300, 200, 100 or Flori-
da, Colorado, California.

Descending

You define your own sort order.Custom (available in the Java Report
Panel)

To apply an ascending or descending sort

1. Select the section cell or table cells you want to sort.
2. Click the down arrow next to theApply/Remove Sort button on the Report

toolbar and then, select Ascending or Descending from the drop-down
list.

3. Repeat the previous step to apply multiple sorts.

To apply a custom sort

1. Select the section cell or table cells you want to sort.
2. Click the down arrow next to theApply/Remove Sort button on the Report

toolbar then select Custom sort from the drop-down list.
3. Select a value in the list of sorted values and click the Up and Down

buttons to promote/demote it in the sort order.
4. To add an additional temporary value to the list of sorted values, type the

value in the Temporary Values box, then click >> to add it to the sort
list.
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To prioritize multiple sorts

1. Right-click the table and select Format > Table to display the Properties
tab.

2. Click the ... button next to the Sorts > Sort priority property to display
the "Sorts" dialog box.

3. Click Vertical sorts to display the vertical sorts or Horizontal sorts to
display the horizontal sorts.

4. Select the sort whose priority you want to change and click the Up/Down
buttons to promote/demote it in the list of sorts.
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Creating charts
You can include one or multiple charts on the reports in a Web Intelligence
document. You can create a chart when you build or new document or insert
charts into an existing document.

If you are building a new document, you need to define the data definition
of the document by building a query before you select a chart template.

Once you have defined the query you go to Report View to define the chart(s)
on report(s).

To create a chart, you follow three steps:
• select a chart template
• allocate dimensions and measures to the chart axes
• view the results displayed on the chart

If you want to create a chart that displays the same data as a table on a
report, you can copy the table first and then turn the duplicate table into a
chart using the "Turn To" dialog box.

Chart types in Web Intelligence
A Web Intelligence report displays results in a block. You can format the
block as a specific type of chart.

Bar charts

Bar charts display data in bar form, either vertically or horizontally. Bar charts
are useful if you want to compare similar groups of data; for example one
time period to another. There are five types of bar charts: grouped, bar and
line, stacked, percent, and 3D.
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2D bar charts include the optional Z-Axis. Including data on the Z-Axis
enables you to show an additional break down of the results displayed on
the chart bars.

3D bar charts do not include an axis legend. You can clearly see what
information is displayed on the chart bars by looking at the axis labels.

Line charts

Line charts connect specific data values with lines, either horizontally or
vertically. Line charts are useful if you want to show trends or changes in
data over time. There are five types of line charts: mixed, stacked, percent,
3D, and 3D surface.

Area charts

Area charts are line charts in which the area between the lines and axis are
filled in. Area charts are useful if you want to emphasize the size of the total
data in a report, as opposed to the changes in the data. You may not want
to use an area chart if you have a sharp contrast between specific data
points. Use a line chart instead.

You can use more than one measure object on the Y-axis as long as the
measures are of the same type and scale; for example, Number of Guests,
and Future Guests. There are five types of area charts: absolute, stacked,
percent, 3D area, and 3D surface.
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Pie charts

Pie charts display data as segments of a whole. Pie charts are useful if you
want to show how each part of your report data contributes to the total.

Pie charts have a single axis displayed on the body of the pie. This is the
Y-Axis. Each segment of the pie chart displays a value for the measure on
the Y-Axis. The pie chart legend indicates the dimension on the X-Axis.

You can only include one measure object in a pie chart. If you have several
measures in your report, you should choose another chart type. There are
four types of pie charts: pie, 3D pie, ring, 3D ring.

Radar, polar and scatter charts

In radar charts, the X- and Y-axis connect at the chart’s center. Radar charts
are useful if you want to look at several different factors related to one item.
For example, you could use a radar chart to display revenue data for different
services within a hotel. On one axis, you could display revenue for the rooms.
On another you could display revenue for the restaurant, and so on.

Scatter charts are similar to line graphs, except that the data points are
plotted without a line connecting them. Scatter charts are useful if you want
to make a comparison between specific data points.

There are four types of radar, polar, and scatter charts: radar line, stacked
radar, polar, and scatter.

3D charts

3D charts include three axes: the Y-Axis always displays values for measures
(such as sales totals, margins, quantities and so on); the X- and Z-Axis
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display values for dimensions (that is, key indicators, such as time,
geography, service lines, and so on). In the 3d bar chart displayed below,
the chart bars display sales revenue per quarter, per year. The [Sales
revenue] measure is on the Y-Axis, the [Quarter] dimension is on the X-Axis,
and the [Year] dimension is on the Z-Axis

The same data can be displayed in a 2D bar chart.

Related Topics
• 2D charts on page 175

2D charts

The 2D bar chart below includes an optional Z-Axis with the values for quarter.
Including data on the Z-Axis enables you to show an additional break down
of the results displayed on the chart bars. The [Sales revenue] measure is
on the Y-Axis, the [Year] dimension is on the X-Axis, and the [Quarter]
dimension is on the Z-Axis. Notice that because the Z-Axis cannot be
represented graphically on a 2D chart, the legend provides the information
for the Z-Axis values.
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The same data can be displayed in a 3D bar chart.

Related Topics
• 3D charts on page 174

Adding, copying and removing charts

To add a chart to a report

It is recommended you work in Structure View when you insert a new chart.
This is because Results View is designed to display the data contained in
reports. Therefore, you can only view charts in Results View after you have
allocated dimensions and measures to the empty chart template.

1. Click View Structure on the report panel toolbar.
2. Click the Templates tab.
3. Select the chart template drag it onto an empty area of the report.

The empty template appears on the report.

4. Click the Data tab.
5. Drag a dimension or measure object onto the chart axis, where you want

the results for that dimension or measure to appear on the chart.
6. Drop the dimension or measure onto the axis when the “Place dimension

objects here ? or the “Place measure objects here ? ToolTip appears.

176 Building Reports with Web Intelligence Rich Client

Displaying data in charts16 Adding, copying and removing charts



7. To allocate more dimension and measure objects to each chart axis,
repeat the previous two steps.

8. To display the results in the chart, click the View Results button on the
Report toolbar.
The chart displays the results corresponding to the objects you allocated
to the chart axes.

To copy a chart

1. Select the chart, right-click and select Copy on the menu.
Web Intelligence copies the chart to the clipboard.

2. To paste the chart to another part of the report, right-click where you want
the chart to appear then click Paste on the menu.

3. To paste the chart into another application, paste the contents of the
clipboard from within the other application.
You can also copy a chart into another application by dragging and
dropping it directly into the open document in the target application.
The chart appears as a picture in the open document if pasted to another
application.

To remove a chart

• Right-click the chart and click Remove, or verify that the Data tab is
displayed, then drag the chart from the Document pane and drop it onto
the Data tab.

Changing the chart type

To change the chart type by using drag and drop

1. Click the Templates tab.
2. Drag a template onto the chart or table you want to modify. You must

drop the template directly on the existing report block. If you drop the
template outside the existing report block, you create a separate chart.

Building Reports with Web Intelligence Rich Client 177

16Displaying data in charts
Changing the chart type



3. If you want to move the dimensions or measures to different axes, click
the View Structure button on the report panel toolbar, then drag the
objects you want to move onto the Data tab, and then drag and drop the
objects you want to display on the chart from the Data tab onto each chart
axis

To change the chart type by using TurnTo

1. Right-click the table or chart.
2. Click Turn To.

The "Turn To" dialog box appears.

3. Click the tab corresponding to the chart type you want, then click a format.
4. Click OK.

If the new chart type does not have data allocated to both the X-axis and
the Y-axis, the chart will not appear when you view the report in Results
View or in Drill mode. In this case, click the View Structure button on the
report panel toolbar, and then click the Data tab and drag the appropriate
dimensions or measures onto the axes on the new chart template. When
you click View Results, the chart appears.

If the font for the text on the table was unicode, and if unicode is not
defined as your default font for charts, the unicode font is not retained in
the chart. You need to format the chart with the unicode font if available
on your computer. If this is not the case, you need to contact your
administrator to configure the Web Intelligence server and your computer
appropriately.

Web Intelligence applies the selected template to the block and displays
the data in the chart type you chose.

Positioning and sizing charts

To set the position of a table or chart on the report
page

1. Select the border of the table or chart.
The properties appear in the Properties tab.
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2. Open the Page layout > Relative Position property group on the
Properties tab, then click ... next to the property.

3. Use the "Relative Position" dialog box to set the position.

Toposition a chart in relation to another chart or table

If you have more than one block (table, chart, or form) in your report, you
can use relative positioning. Relative positioning allows you to position a
selected block (for example, a chart) in relation to other blocks in the report.

If new data on the database modifies the size of the tables or charts, relative
positioning ensures that the different tables and charts display correctly
without overlapping each other.

Note:
If you position a chart in relation to another block (that is, a chart, table, or
form), the position of the related block changes automatically, if you reposition
the chart.

1. Right-click the chart and click Format.
2. Open the Page layout > Relative Position property group on the

Properties tab.
3. Click ... next to the Relative Position property to open the Relative

Position dialog box.
If the report does not contain multiple elements, the Relative Position
dialog box is not available.

4. Select the distance of the upper left point of the chart in relation to another
report element by entering - the number of pixels; the part of the other
report element from which you want to measure the pixels (in the first
drop-down list); the report element from which you want to measure the
pixels (in the second drop-down list).

5. Repeat this for the distance of the lower left point of the chart.

To resize a chart

1. Right-click the chart and click Format.
2. Open the Display property group on the Properties tab.
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3. Type the chart width in the Width property and the height in the Height
property.

Formatting charts

To insert and format a chart title

1. Right-click the chart and click Format.
2. Click Yes next to theAppearance > Title property.

The property becomes a property group.

3. Open the Title property group and type the title in the Text property.
4. Click ... next to Text Format and use the Format Text dialog box to

format the title.
5. Click ... next to Borders and use the Border Editor dialog box to format

the title borders.
6. Select the title background color from the Background color list.

To display a chart with a 3D look

1. Right-click the chart and click Format.
2. Open the Display property group on the Properties tab.
3. Select 3D look.

To add background colors to a chart

1. Right-click the chart and click Format.
2. Open the Appearance property group on the Properties tab.
3. Click the arrow next to Background color to display the color palette.
4. Select a color from the color palette or click More Colors to display the

Choose Color dialog box.
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To modify chart borders

1. Right-click the chart and click Format.
2. Click ... next to Appearance > Borders.
3. Use the Border Editor dialog box to format the borders.

To select and format chart floors and walls

Floors and walls give depth to charts and help to set off the data displayed
on the chart bars or lines. 3D charts have a floor, a left wall, and a right wall.
2D charts just have a floor. You can specify a color for the floor and walls.
1. Right-click the chart and click Format.
2. Open the Display property group on the Properties tab.
3. Select Show floor to display the chart floor, Show left wall to display

the chart left wall and Show right wall to display the chart right wall.
The availability of these options depends on the type of chart.

4. Set the wall and floor color by clicking the Wall color and Floor color
properties in theAppearance property group and using the "Color Palette"
or the "Choose Color" dialog box to set the color.

To show and format axis legends

1. Right-click the report and select Format.
2. Click Yes next to theAppearance > Legend property.

The property becomes a property group.

3. Open the property group and select the legend position from the Position
list.

4. Use the Title and Values subgroups to set the legend title and format
the title and legend values.

To avoid page breaks in charts

1. Right-click the chart and click Format.
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2. Open thePage Layout property group on the Properties tab.
3. Select Avoid page breaks in chart.

To show axis labels on pie charts

1. Right-click the chart and select Format.
2. Open the Appearance > Data > Values property group.
3. Select Show segment labels.

To format axis label text, borders, and background

1. Right-click the chart and click Format.
2. Click Yes next to the Appearance > X/Y/Z Axis > Label property.

The property becomes a property group and the object name appears
on the label.

3. Select Show object name to show the object name on the label.
4. Type the text into Other label if you want to assign custom text to the

label in place of the object name.
5. To format the text, click ... next to Text Format to open the "Text Format"

dialog box.
6. Use the "Text Format" dialog box to format the text.

You can set many of the properties in the "Text Format " dialog box directly
from the property list, where they appear beneath Text Format.

7. Click ... next to Borders and use the "Border Editor" to format the label
borders.

To show, hide or format the axes grid

1. Right-click the chart and select Format.
2. Click Yes next to Appearance > X/Y/Z > Grid in the Properties tab to

show the grid.
3. Select Appearance > X/Y/Z > Grid > Show markers to show the grid

markers.
4. SelectAppearance > X/Y/Z > Grid > Grid color to select the grid color.
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Displaying and formatting chart data

To show a chart when empty

Sometimes charts display no values. For example, if sales of a specific
product are discontinued, a chart that normally displays results for that product
will appear empty. By default, Web Intelligence displays such empty charts
on reports. If wished, you set Web Intelligence to hide charts whenever they
are empty.
1. Right-click the chart and click Format.
2. Open the Display property group in the Properties tab.
3. Select Show when empty.

To specify a color palette for the chart data

1. Right-click the report and select Edit.
2. Open the Appearance > Data property group in the Properties tab.
3. Click ... next to Palette to display the "Choose Palette" dialog box and

select one of the predefined palettes in the Predefined Palettes list.
4. To edit a pallete, select the pallete, then click Edit Pallete.

The "Edit Palette" dialog box opens

5. Select a color in the palette.
The "Custom Color" dialog box opens.

6. Create a custom color using the Custom Color dialog box, then click
OK.

7. To set all the colors in the palette to the same color, click Set All Colors.

To format axis values numbers and text

1. Select the chart and click Format.
2. Open the Appearance > Values property group in the Properties tab.
3. Click ... next to the Number format property to display the Number

Format dialog box.
4. Use the "Number Format" dialog box to define the format.
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5. Click ... next to the Text Format property to display the "Text Format"
dialog box.

6. Use the "Text Format" dialog box to format the text.
You can set many of the properties in the "Text Format" dialog box directly
from the property list, where they appear beneath Text Format.

To define the axis value frequency

1. Right-click the chart and click ormat.
2. Open the Appearance > X/Y/Z Axis > Values property group in the

Properties tab.
3. Select Automatic frequency to set the frequency to automatic.
4. Type the frequency in Frequency to set the frequency to a specific value.

Automatic frequency must be unselected before you can type a custom
frequency.
When you set the frequency to n, Web Intelligence displays every n values
on the axis.

To show a specific range of axis values

1. Right-click the report and click Format.
2. Open the Appearance > X/Y/Z Axis > Scale property group on the

Properties tab.
3. Enter the minimum value in Min. value and the maximum value in Max.

value.
Web Intelligence displays the minimum and/or maximum values you
specified on the axis.

To show or hide data values

1. Right-click the chart and select Format.
2. Open the Appearance > Data > Values group in the Properties tab.
3. Select Show data to show the data.
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To vary the data markers for each result

1. Right-click the chart and select Format.
2. Open theAppearance > Data property group in the Properties tab.
3. Select Vary data markers.

You can only vary the data markers for each result on the following chart
types: 2D Line charts, 2D Bar and Line charts, and Radar charts.

Linear and logarithmic axes scales

By default, Web Intelligence displays the Y-axis on charts as a linear scale.
You can set the axis to a logarithmic scale. Logarithmic scales allow you to
examine values that span many orders of magnitude without losing
information on the smaller scales.

In a linear scale, the axis markers are evenly spaced. Linear scales are
based on addition. Consider, for example, the linear sequence: 1, 3, 5, 7, 9

To get the next number in the sequence, you add 2 to the previous number.

Logarithmic scales are based on multiplication rather than addition. In a
logarithmic scale, the steps increase or decrease in size. Logarithmic scales
are based on multiplication (or division). Consider, for example, the
logarithmic sequence: 2, 4, 8, 16, 32

To get the next number in the sequence, you multiply the previous number
by 2. We can say that this sequence represents ``base 2.''

Consider the following sequence: 1, 10, 100, 1000, 10000

This sequence represents ``base 10,'' because you get the next term in the
sequence by multiplying the previous term by 10.

To display the Y Axis logarithmically
1. Right-click the chart and select Edit Format.
2. Open theAppearance > YAxis > Scale property group in the Properties

tab.
3. Select Logarithmic.
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A logarithmic scale uniformly presents percent changes rather than point
changes. In other words, the distance from 1 to 2 (100% increase) is the
same as the distance from 2 to 4 (another 100% increase).
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Formatting numbers and
dates

17



Predefined and custom formats
You can change how values display in specific cells or on chart axes. You
do this by applying predefined formats available in Web Intelligence or by
creating your own custom formats. You can save your custom formats for
reuse on multiple blocks and reports in the same document.

Predefined formats

You can change how values display in specific cells or on chart axes. You
do this by applying predefined formats available in Web Intelligence or by
creating your own custom formats. You can save your custom formats for
reuse on multiple blocks and reports in the same document.

The following predefined formats are available for cells:

DescriptionFormat

The format defined for the object on
the universe.Default

Formats for decimal or integer values.Number

Formats for currency values.Currency

Date and time formats.Date/Time

Formats for true and false values.Boolean

Related Topics
• To apply a custom number format to a cell on page 193
• To define a custom format on page 192

To apply a predefined format to a cell

1. Right-click a cell and click Format Number on the shortcut menu.
The "Format Number" dialog box appears.
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2. Click a format in the Format Type list.
The available formats for the format type you selected appear in the
Properties pane.

3. Click OK.
Web Intelligence applies the new format to the cell.

Custom formats

You can use the Custom format type to define a customized format for any
cell. The following table lists the strings you can use to create custom formats:

ExampleDisplay(s)Character(s)

‘12345’ with the format
#,##0 gives ‘12,345’ (if
your locale defines the
grouping separator as a
comma) or ‘12 345’ (if
your locale defines the
grouping separator as a
space)

The corresponding digit.
If the number has less
digits than the number of
# characters used to
specify the format, no
leading zeros are insert-
ed.

#

‘123’ with the format
#0,000 gives ‘0,123’

The corresponding digit.
If the number has less
digits than the number of
0 characters used to
specify the format, a
leading zero(s) is inserted
before the number.

0

‘1234567’ with the format
#,##0 gives ‘1,234,567’
(if you locale defines the
grouping separator as a
comma) or ‘1 234 567’ (if
your locale defines the
grouping separator as a
non-breaking space)

The grouping separator
as defined by your locale.,
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ExampleDisplay(s)Character(s)

‘12.34’ with the format
#.#0 gives ‘12.34’ (if your
locale defines the decimal
separator as a period) or
‘12,34’ (if your locale de-
fines the decimal separa-
tor as a comma)

The decimal separator as
defined by your locale..

Displays a percentage
sign (%) after the result

and multiplies the result
by 100.

[%]%

The % sign after the re-
sult, but does not multiply
the result by 100.

%

‘1234567’ with the format
# ##0 gives ‘1234 567’A non-breaking space ( )

‘705.15’ with the format
$#.#0 gives ‘$705.15’ or
with the format #,#0 €
gives ‘705,15 €’

The alphanumeric charac-
ter.

1, 2, 3, a, b, c, $, £, €
(and so on)

‘150’ with the format
#,##0[Red] gives ‘150’
#,##0[Blue] gives -’150’

The value in the specified
color.

[Red], [Blue], [Green],
[Yellow], [Gray], [White],
[Dark Red], [Dark Blue],
[Dark Green]

The first day of a month
with the format d gives ‘1’

The number of the day in
the month with no leading
zeros. If the date for day
is less than two charac-
ters, the date displays
without a zero before it.

d
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ExampleDisplay(s)Character(s)

The first day of a month
with the format dd gives
‘01’

The number of the day
with leading zeros. If the
date for day is less than
two characters, the date
displays with a zero be-
fore it.

dd

Monday’ with the format
ddd gives ‘Mon’

The name of the day ab-
breviated. The first letter
is capitalized.

ddd

‘Monday’ with the format
dddd gives ‘Monday’

The name of the day in
full. The first letter is cap-
italized.

dddd

‘Monday’ with the format
dddd dd gives ‘Monday
01’

The day of the week fol-
lowed by a space and the
number of the day.

dddd dd

‘January’ with the format
M gives '1'

The number of the month
with no leading zeros. If
the number for month is
less than two characters,
the number displays
without a zero before it.

M

‘January’ with the format
MM gives 01

The number of the month
with leading zeros. If the
number for month is less
than two characters, the
number displays with a
zero before it.

MM

‘January’ with the format
mmm gives Jan

The name of the month
abbreviated. The first let-
ter is capitalized.

mmm

‘January’ with the format
mmmm gives January

The name of the month
in full. The first letter is
capitalized.

mmmm
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ExampleDisplay(s)Character(s)

‘2003’ with the format yy
gives ‘03’

The last two digits for
year.yy

‘2003’ with the format
yyyy gives ‘2003’All four digits for year.yyyy

‘21:05:03’ with the format
h:mm:ss a gives ‘9:05:03
PM’

The hour with no leading
zeros and the minutes
and seconds with leading
zeros. The “a ? charac-
ter displays AM or PM af-
ter the time.

h:mm:ss a

‘21:00’ with the format HH
gives ‘21’

The hour according to the
24-hour clock.HH

‘21:00’ with the format hh
gives ‘09’

The hour according to the
12-hour clock.hh

‘7.15 am’ with the format
HH:mm gives ‘07:15’

The hour and minutes
with leading zeros.HH:mm

‘7.15 am’ with the format
HH:mm:ss gives
‘07:15:00’

The hour, minutes, and
seconds with leading ze-
ros.

HH:mm:ss

‘07:15:03’ with the format
mm:ss gives ‘15:03’

The minutes, and sec-
onds with leading zeros.mm:ss

To define a custom format

1. Right-click the cell(s) to which you want to apply a custom format.
2. Select Format Number.

The "Number Format" dialog box appears.

3. In the Format Type list, select the format category that corresponds to
the data type in the selected cell.

4. Select the Custom check box.
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Text boxes appear for you to type your custom format(s).

5. Select a format listed in the Properties pane, and then edit the selected
format by typing additional characters in one or more text boxes.
For example, if you want to create a custom format for Number values,
type the custom format you want in the Positive, Negative, and Equal
to Zero boxes. If you want to create a custom format for Boolean values,
type the custom format you want in the True and False boxes.

6. Click Add.
You cannot delete or edit custom formats. To change a custom format,
you need to create a new custom format and apply the new format to the
selected cell(s). Any custom formats not applied to cells in a document
are deleted automatically when you close the Web Intelligence Java
Report Panel.

To apply a custom number format to a cell

1. Right-click the cell(s) to which you want to apply the custom format.
2. Select Format Number.

The Number Format dialog box appears.

3. Select Custom.
4. The list of custom formats already included in the document appears in

the Properties pane.
5. Select the custom format you want.
6. Click OK.

Web Intelligence applies the custom format to the selected cell(s).
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Filtering report data

18



Report filters defined
You can filter reports to limit the results that are displayed to specific
information that interests you. For example, you can limit the displayed results
to information for a specific customer or a sales period. The data you filter
out remains within the Web Intelligence document; it is simply not displayed
in the report tables or charts. This means you can change or remove report
filters in order to view the hidden values, without modifying the query definition
behind the document.

You can apply different filters to different parts of a report. For example, you
can limit the results in the entire report to a specific product line and then
limit results in a table or chart further to focus on results for a specific region
or customer profile.

To create a report filter, you need to specify three elements:
• a filtered object
• an operator
• a value(s)

You can include multiple filters in a report.

Applying filters to sections

You can apply section filters based on the values in the section header or
on values that appear within the section.

Applying a section filter to the section header

If you have a report with a section on [Country], the filter [Country] = "US"
filters out all sections on countries other than the US.

Applying a section filter to the section data

If you have a report with a section on [Region] and you apply the filter
[Product]="Drinks" to the section, Web Intelligence retains all sections
that contain the product "Drinks".

In this case, the sections remaining in the report contain products other than
drinks if these products were sold in these regions. This is because the
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section filter retains regions in which drinks were sold, but does not exclude
other products from the data in the section.

In other words, Web Intelligence bases the filter on the data in the section,
but applies it indirectly to the data in the section header.

Types of report filter
There are three types of report filter in Web Intelligence:

• Standard report filters (available in all forms of Web Intelligence).

Standard report filters are the most flexible type of report filter. They can
use any filter operator and can filter on single values or lists of values.

• Quick filters (available in the Java Report Panel and Web Intelligence
Rich Client).

Quick filters provide an easy way to create filters using the Equal To
operator. They can filter on single values or lists of values.

• Simple report filters (available in the Web Intelligence HTML viewer, the
Java Report Panel and Web Intelligence Rich Client).

Simple report filters provide an easy way to create filters using the Equal
To operator. They can filter on single values only.

Query filters and report filters compared
You can apply filters at two levels within a document:

• query filters – these filters are defined on the query; they limit the data
retrieved from the data source and returned to the Web Intelligence
document.

• report filters – these filters limit the values displayed on reports, tables,
charts, sections within the document, but they don’t modify the data that
is retrieved from the data source; they simply hide values at the report
level.
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Report filter operators

Equal To operator

Use the Equal to operator to obtain data equal to a value.

For example, to return data for the US only, create the filter "County Equal
To US".

Not Equal To operator

Use the Not Equal To operator to obtain data not equal to a value.

For example, to return data for all countries except the US create the filter
"County Not Equal To US".

Different From operator

Use the Different From operator to retrieve data different from a value.

For example, to retrieve data for all quarters execpt Q4, create the filter
[Quarter] Different From "Q4"

Greater Than operator

Use the Greater Than operator to retrieve data greater than a value.

For example, to retrieve data for customers aged over 60, create the filter
"[Customer Age] Greater than 60".

Greater Than Or Equal To operator

Use the Greater Than Or Equal To operator to retrieve data greater than or
equal to a value.
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For example, to retrieve data for revenue starting from $1.5M, create the
filter "[Revenue] Greater than or equal to 1500000".

Less Than operator

Use the Less Than operator to retrieve data lower than a value.

For example, to retrieve data for exam grades lower than 40, create the filter
"[Exam Grade] Less Than 40".

Less Than Or Equal To operator

Use the Less Than Or Equal To operator to retrieve data less than or equal
to a value.

For example, to retrieve data for customers whose age is 30 or less, create
the filter "[Age] Less Than Or Equal To 30".

Between operator

Use the Between operator to retrieve data between and including two values.

For example, to retrieve data for weeks starting at week 25 and finishing at
36 (including week 25 and week 36), create the filter "[Week] Between 25
and 36".

Not Between operator

Use the Not Between operator to retrieve data outside the range of two
values.

For example; to retrieve data for all the weeks of the year, except for and
not including weeks 25 through 36, create the filter "[Week] Not between 25
and 36".
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In List operator

Use the In List operator to retrieve data corresponding to values in a list of
values.

For example, to retrieve data for the US, UK and Japan only, create the filter
[Country] In List ("US";"UK";"Japan").

Not In List operator

Use the Not In List operator to retrieve data that does not correspond to
multiple values.

For example, if you do not want to retrieve data for the US, UK and Japan,
create the filter [Country] Not In ("US";"UK";"Japan").

Is Null operator

Use the Is Null operator to retrieve data for which there are no values in the
database.

For example, to retrieve customers without children (the children column in
the database has no value), create the filter [Children] Is Null.

Is Not Null operator

Use the Is Not Null operator to return data for which there is a value in the
database.

For example, to return customers with children, create the filter [Children] Is
not Null.
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Creating, editing and deleting report
filters

To create a report filter using the Quick Filter option

1. Click the report tab of the report you want to filter.
2. If you want to filter a block (that is, a table, chart, or form), then click the

top edge of the block to select it. If you want to filter a section, and not
just the section cell, click View Structure and then select either the start
section or end section divider.

3. Click the arrow to the right of the Add Filter button on the Report toolbar
and select Add Quick Filter.
The List of Values dialog box appears. The values for the selected section
or block are listed.

4. Select the value(s) you want to display in the section or block.
5. Click OK.

The selected section or block only displays values that correspond to the
value you selected.

6. To delete the quick filter, click the arrow to the right of Add Filter and
select Remove Filter.

To create a report filter using the Filter Editor

1. Click the report tab of the report you want to filter.
2. On the Report toolbar, click the Show/Hide Filter Pane button to display

the Report Filters pane.
3. Select the part of the report you want to filter.

The Report Filters pane displays the name of the selected part of the
report. For example, if you select a table, the Report Filter pane displays
the name of the selected table.

4. In the Data tab, select the object you want to filter.
5. Drag the selected object onto the Report Filters pane.

The Filter Editor appears. The name of the object you selected is displayed
below Filtered Object.
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6. Select the operator.
7. Select Constant or Value(s) from list.

When you define filters on measures or variables, you cannot select
value(s) from the list of values; you need to type a constant(s).

8. If you selected Constant, type the value(s), you want to retrieve, in the
Constant box. If you selected Value(s), select the value(s), you want to
retrieve, from the displayed List of Values and add them to the Values
Selected box, by clicking the >> button.

9. Click OK to confirm the filter definition.
The selected report, section, or table, chart, or form displays only the
values you specified in the custom filter.

To combine multiple filters on a report

1. Create each filter.
By default Web Intelligence combines all the filters with the AND operator.

2. Double-click the AND operator to toggle between AND or OR.

Related Topics
• To create a report filter using the Quick Filter option on page 201
• To create a report filter using the Filter Editor on page 201

To edit a report filter

1. Click the Show/Hide Filter Pane button on the Report toolbar to display
the Report Filters pane.

2. Click the area of the report for which you edit the filters.
The filters on the selected area display in the Report Filters pane.

3. Double-click the filter you want to edit.
The Filter Editor appears. The name of the filtered object is listed under
Filtered Object.

4. Edit the filter using the Filter Editor.
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To edit a report filter from the report map

1. Select the Map tab.
2. Click Structure at the top of the tab.
3. Click the report element on which the filter is applied in the report structure.
4. Click Filters at the top of the tab.
5. Right-click the filter and select Edit Filter to display the filter editor.
6. Edit the filter using the Filter Editor.

To delete a report filter

1. Click the Show/Hide Filter Pane button on the Report toolbar to display
the Report Filters pane.

2. Click the area of the report from which you want to remove the filters.
The filters on the selected area display in the Report Filters pane.

3. Select the filter you want to delete and press Delete.
4. You can also delete filter by selecting the filtered object, selecting the

arrow to the right of the Filter button on the Reporting toolbar, and
selecting Remove filter.

To create simple report filters

The Report Filter toolbar provides a quick method for adding simple report
filters to reports.

Simple report filters have the form <report_object>=<value>. They can
contain the "=" operator only and can filter on a single value only.

For more complex filters, use quick filters (which can contain the "=" or "Inlist"
operators) or standard report filters (which can contain any operator).

Note:
You also use the Report Filter toolbar when drilling on reports. In the context
of Drill, the Report Filter toolbar is known as the Drill toolbar.

1. Click Show/hide Report Filter toolbar on the main menu to display the
toolbar.
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2. In Web Intelligence HTML, click the icon on the toolbar and select the
object on which you want to filter from the menu.
You can add multiple objects to the toolbar to create multiple filters.

3. In the Java Report Panel or Web Intelligence Rich Client, drag the object
on which you want to filter to the toolbar.
You can add multiple objects to the toolbar to create multiple filters.

4. Select the value on which you want to filter from the drop down list of
values.
Web Intelligence filters the report on the value of the object you selected.
For example, if you selected "US" from the list of values of the Country
object, Web Intelligence filters the report to exclude all rows where Country
does not have the value "US".

5. To remove a filter, select it and click Delete.

To view the filters on a report

1. Click on the area of the report for which you want to see filters. (To view
filters defined on the entire report, click outside any table, chart or section.)

2. Click the Map tab, then click Filters.
Web Intelligence displays the filters on the area of the report you clicked.
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To enter values to answer a prompt
1. With a report in a Web Intelligence document open, click Refresh Data

on the right of the main toolbar above the report.
The "Prompts" dialog box appears.

2. Select a prompt question.
If the prompts are organized hierarchically in a tree, you need to select
the prompt at the lowest level of the hierarchy first. This type of prompt
is referred to as a cascading prompt.
The values you can choose are listed in the pane on the lower left.

If the list of values is not available, click Refresh values to display it. The
list of values now appears together with the date on which it was last
refreshed.

If the prompt has been answered previously, the values selected the last
time appear in the prompt answer pane on the right. You can either leave
those values selected or use << to remove them.

The options you see when you answer prompts depend on (1) whether
this is the first time the results have been refreshed or not and (2) the
properties set for the prompts when they were created.

3. Select the values from the list of choices in the pane on the left, for which
you want to view results, or type the values into the text box, and click
the >> to add them to the prompt answer box on the right.
If you type multiple values, you need to separate each value with a
semi-colon (;). For example: Florida;Texas.

4. Click Run Query.
Web Intelligence retrieves the data for the values you specified, and
returns the results to the reports.

Note:
If the prompt is optional, click Run Query without supplying a value. Web
Intelligence ignores the prompt.

To enter dates to answer a prompt
1. With a report in a Web Intelligence document open, click Refresh Data

on the right of the main toolbar above the report.
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The "Prompts" dialog box appears.

2. To select a date, click the arrow to the right of the text box, select a date
from the popup calendar, and then click >> to add the date you selected
to the list on the right.
If the prompt has been answered previously, the values selected the last
time appear in the prompt answer pane on the right. You can either leave
those values selected or use << to remove them.

3. If the prompt allows you to select multiple dates, and you want to view
results for more than one date, repeat the previous step.

4. Click Run Query.
Web Intelligence retrieves the data for the values you specified, and
returns the results to the reports.

Note:
If the prompt is optional, click Run Query without supplying a value. Web
Intelligence ignores the prompt.
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Filtering data using input
controls

20



Input controls defined
Input controls provide a convenient, easily-accessible method for filtering
and analyzing report data. You define input controls using standard windows
controls such as text boxes and radio buttons. You associate these controls
with report elements such as tables or section headers, and use the controls
to filter the data in the report elements. When you select values in the input
control, Web Intelligence filters the values in the associated report elements.

You can also define tables and charts as input controls. When you select a
value in the table or chart, Web Intelligence filters the values in the associated
report elements.

You can use input controls to analyze different scenarios by changing the
value of variables. You define a variable with a constant value, then assign
an input control, for example a slider, to the variable. You can then change
the value of the variable using the slider control; if the variable is part of a
formula, you can use the slider control to examine different formula results
based on the variable value.

Input controls are report-specific. They are grouped on the Input Controls
tab.

To add an input control
You must have sufficient document modification rights to add input controls.

1. Select the Input Controls tab.
2. Click New at the top of the Input Controls pane, or right-click an object

in a table or chart and select New input control to display the input
controls wizard.

If you selected an entire table or chart before clicking New, you can select
Include objects from selected block only to restrict the list of objects
in the wizard to the objects in the table or chart you selected. If you did
not select a table or chart, or if you used the New input control menu to
display the input controls wizard, this option is not available.

3. Select the report object to supply values for the input control, then click
Next.
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If you right-clicked an object and selected New input control from the
menu, the object you right-clicked is already selected.

4. Select the input control type.
The list of control types is determined by the data type of the report object.

5. Define the input control properties.
The available properties are determined by the control type and whether
you are using Web Intelligence Interactive or the Web Intelligence Java
Report Panel/Web Intelligence Rich Client.

DescriptionProperty

The name of the input controlLabel

The description of the input controlDescription

The list of values available in the input control. You can
use all values of the report object on which the input
control is based (the default) or define your own custom
list of values.

List of values

If you define a custom list of values for the report
object, this setting filters the data in the report ele-
ment you assign to the input control based on this
list of values. Even when no values are selected in
the input control, Web Intelligence excludes any val-
ues not in the restricted list from the report element
filtered by the input control.

For example, if an input control based on the [Coun-
try] dimension is restricted to the values "US" and
"France", a table filtered by the input control shows
data for US and France only, even when no value is
selected in the input control.

If you deselect Use restricted list of values, all val-
ues of [Country] appear in the table when no value
is selected in the input control.

Use restricted
list of values

The operator that the input control uses to filter the as-
sociated report elements

Operator

The default values that the input control uses to filter
the associated report element

Default values
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DescriptionProperty

The number of lines that the input control displays in
the Input Control pane. For example a list of five radio
buttons with Number of lines set to 3 displays three
radio buttons only by default. You access the other two
radio buttons by using the scrollbar.

Number of lines

The minimum numerical value you can select in the input
control

Minimum value

The maximum numerical value you can select in the
input control

Maximum value

The amount by which the input control increases/de-
screased a numerical value when you are choosing a
value

Increment

6. Click Next to display the Assign Report Elements wizard step.
7. Select the report elements you want the input control to filter.

Note:
Each time you save a document, Web Intelligence removes any input
controls that have no associated report elements.

8. Click Finish.
The input control appears on the Input Controls pane.

To edit an input control
1. Select the Input Controls tab.
2. Click Edit on the input control to display the Edit Input Control dialog

box.
3. Edit the input control properties on the Properties tab.
4. Edit the report elements associated with the input control on the

Dependencies tab.

To highlight input control dependencies
1. Select the Input Controls tab.
2. Click Highlight dependencies on the input control.
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The report elements associated with the input control are highlighted.

To organize input controls
1. Select the Input Controls tab.
2. Drag and drop input controls to move them up or down on the Input

Controls pane in Web Intelligence Java Report Panel and Web
Intelligence Rich Client. Select an input control, then click Move the
selected input control up/down at the top of the Input Controls pane
to move the control up or down in Web Intelligence Interactive.

3. Select an input control, then click Remove at the top of the control to
remove it from the Input Controls pane.

To view the input controls map
1. Select the Input Controls tab.
2. Click Map at the top of the Input Controls tab (Web Intelligence

Interactive) or select the Map tab, then click Input controls at the top of
the tab (Web Intelligence Java Report Panel and Rich Client).

Using tables and charts as input controls
You can define tables and charts as input controls. Table- and chart-based
input controls appear in the Input Controls panel in the same way as regular
input controls, but you select values in the table or chart itself to filter the
dependent report elements. When you select cells, columns or rows in tables,
or clickable data areas in charts, Web Intelligence filters the values in the
associated report elements according to the values you selected.

When you click on a table or chart-based control in the Input Controls panel,
Web Intelligence highlights the table or chart used as an input control.

When a report is in drill mode, table- and chart-based input controls are
disabled. They are re-enabled when drill mode is deactivated.

To define a table or chart as an input control

1. Select the table or chart, right-click and select Define as input control.
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2. Select All objects to define all the objects in the table or chart as the
filtering objects, or select Single object and select the object to define a
single object in the table or chart as the filtering object.

Note:
You can select dimensions only as filtering objects when you define a
table or chart as an input control.

3. Click Next and type a name and a description for the input control.
4. ClickNext and select the report elements to be filtered by the input control.

Note:
You cannot select the table or chart that you are defining as an input
control from the list of report elements.

5. Click Finish.
The table or chart input control appears in the Input Controls pane. When
you click on the control, Web intelligence highlights the table or chart
defined as the input control.

Related Topics
• To edit an input control on page 212

To filter data using input controls
1. Display the Input Controls pane by selecting the Input Controls tab.

Note:
The input control displays the message "No dependent report elements"
if the report elements filtered by the input control are no longer in the
report.

2. Select values in the input control.
Web Intelligence filters the associated report elements based on the
values you select. For example, if you select the "US" value of the
[Country] dimension, the filter operator is Equal To, and there is a table
associated with the input control, Web Intelligence filters the table on the
condition [Country] = "US".

3. To filter using a table or chart defined as an input control, select dimension
values in the table (rows, columns or cells) or chart (clickable data areas).
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Note:
• Tables or charts defined as input controls can filter using dimension

values only.
• The input control shows the message "The table or chart is not in the

report" if the table or chart is no longer in the report.
• The input control shows the message "Filtering dimensions not

available" if the filtering dimensions are no longer in the table or chart.
The input control becomes usable again if you add the dimensions to
the table or chart.

• The input control shows the message "Control not usuable while the
report is in drill mode" if the report is in drill mode. Drill mode must be
turned off to make the input control usable.

• Table- and chart-based input controls are indicated by an icon in the
top right-hand corner of the table or chart. Right-clicking the icon
displays the following menu:

DescriptionCommand

Edits the input controlEdit

Highlights the report elements filtered by the input
control

Highlight dependen-
cies

Removes the filters applied by the input controlReset

Disables or enables the input controlDisable/Enable

4. To remove all filters applied by input controls, click Reset at the top of
the Input Controls pane.
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Enhancing reports with
calculations, formulas and
variables

21



Calculations, formulas and variables
You can add calculations, formulas and variables (named formulas) to your
Web Intelligence reports. For detailed information on the calculation power
that calculations, formulas and variables add to your reports, see the Using
Functions, Formulas and Calculations in Web Intelligence guide or the online
help.

Working with standard calculations

To insert a standard calculation in a table or crosstab

You can insert standard calculations in tables or crosstabs to make quick
calculations on table data. For more information on the standard calculations
available in Web Intelligence, see the Using Functions, Formulas and
Calculations in Web Intelligence guide or in the online help.

You can insert multiple calculations in a table or crosstab. When you apply
two calculations to a table or crosstab, a footer is added for each calculation
result. You insert multiple calculations in a table or crosstab in the same way
that you insert one calculation, but you repeat the procedure for as many
calculations as you want to insert.

1. Click Configure View > Toolbars > Reporting (Java Report Panel) or
View > Toolbars > Report (Web Intelligence Interactive) to display the
Report toolbar.

2. Click the table cell that contains the data you want to calculate.
3. Click the arrow at the right of the Insert calculation-name button (where

calculation-name is the currently-selected calculation) on the Report
toolbar, then select the calculation you want to insert from the drop-down
menu. You can also click the button directly to insert the currently-selected
calculation.
The currently-selected calculation is shown by the mathematical symbol
on the button, and changes according to the type of data you select. For
example, if the calculation is Sum, the button displays the Σ symbol.

Note:
If you insert a percentage calculation, the results of the percentage are
displayed in an additional column or row of the table.
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4. To insert other calculations, click the arrow at the right of the button and
select the calculation from the drop-down menu.

A new row is added at the bottom of the table. The aggregated value
appears in the new row cell.

To remove a standard calculation

1. Right-click the cell that contains the calculation.
2. Depending on the table type, select Remove > Row or Remove > Col

umn from the shortcut menu.

Working with formulas

The Formula toolbar

You display the Formula toolbar by clicking the Show/Hide Formula Toolbar
button on the Reporting toolbar (Java Report Panel) or View > Toolbars >
Formula (Web Intelligence Interactive). Now, when you select a cell, its
formula appears in the Formula toolbar.

The Formula toolbar has the following buttons (the order is different
depending on the type of Web Intelligence you are using):

DescriptionButton

Opens the Formula Editor which allows
you to build a formula using a graphical
interface

Open Formula Editor

Allows you to save a formula as a vari-
ableCreate variable

Clears all changes made to the formula
since the last save or validationClear changes

Verifies the formula syntax and re-
places the current formulaValidate formula
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To enter a formula directly into the Formula toolbar without using the Variable
Editor, you can type the formula or drag report objects (Java Report Panel
only) to the formula toolbar.

To enter a formula in the Formula toolbar by typing the formula

1. Click Show/Hide Formula Toolbar (Java Report Panel or Web
Intelligence Rich Client) or View > Toolbars > Formula (Web Intelligence
Interactive) to display the Formula toolbar.

2. In the Formula toolbar, type the formula.
For example, to calculate the average revenue generated per item sold,
type: =[Sales Revenue]/[Quantity Sold].
Web Intelligence gives you suggestions for completing the component of
the formula you are typing. To select a Web Intelligence suggestion, press
the down arrow button to highlight it, then press Return, or select the
suggestion with your cursor.

3. To select a Web Intelligence suggestion, press the down arrow button to
highlight it, then press Return.

To enter a formula in the Formula toolbar by using drag and drop

• Drag reports objects onto the Formula toolbar.

Note:
You cannot drag objects to the Formula toolbar in Web Intelligence
Interactive.

When you release an object, it appears in the Formula toolbar at the
cursor position as if you had typed it directly.

To build a formula using the Formula Editor

1. Click the Open Formula Editor button on the Formula toolbar to display
the Formula Editor.

2. Select the cell on the report where you want to include the formula.
3. In the Data, Functions and Operators panes, double-click the report

objects, functions and operators you want to include in the formula, or
type the formula directly.
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For example, to create the formula =Average([Revenue]), double-click
the Average() function, then double-click the Revenue object.
When you double-click a function to include it in a formula, Web
Intelligence places the cursor between the function parentheses.

Working with variables

To create a variable from a formula

1. Display the Formula toolbar.
2. Type your formula in the Formula toolbar or select a cell containing a

formula.
3. Click Create variable on the Formula toolbar

The "Create Variable" (Java Report Panel or Web Intelligence Rich Client)
or "Variable Editor" (Web Intelligence Interactive) dialog box appears.

4. Type the variable name in the Name box.
5. Select the variable type by selecting Dimension, Measure or Detail.
6. If you select Detail, an "Associated Dimension" box appears. Click ...

next to the box to open the "Objects and Variables" dialog box and select
the dimension you want to associate with the detail.

7. Click OK.
The variable appears in the list of report variables in the Data tab.

To create a variable using the Variable Editor

1. Click Show Variable Editor on theReporting toolbar (Java Report Panel
or Web Intelligence Rich Client) or Variable > New on the Available
Objects tab of the Left Panel (Web Intelligence Interactive).

2. Type your formula in the Formula pane or use the functions and operators
on the Functions and Operators tab to build the formula.

3. Type the variable name in the Name box.
4. Select the variable type by selecting Dimension, Measure or Detail.
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5. If you select Detail, an Associated Dimension box appears. Click ...
next to the box to open the Objects and Variables dialog box and select
the dimension you want to associate with the detail.

6. Click OK.
The variable appears in the list of report variables.

To edit a variable

1. Select the variable in the list of report variables (on the Data tab in the
Java Report Panel/Web Intelligence Rich Client or the Available Objects
tab on the Left Panel in Web Intelligence Interactive).

2. Click the right mouse button and click Edit (Variable) on the shortcut
menu.
The Variable Editor appears.

3. Edit the variable.
4. Click OK to save the new variable definition.

To delete a variable

1. Select the variable in the list of report variables (on the Data tab in the
Java Report Panel/Web Intelligence Rich Client or the Available Objects
tab on the Left Panel in Web Intelligence Interactive).

2. Click the right mouse button and click Delete on the shortcut menu.
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Drilling on report data
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What is drill?
You use drill to analyze the results displayed in reports. Drilling on reports
lets you look deeper into your data to discover the details behind a good or
bad summary result displayed in tables, charts, or sections.

Example: Why did sales of accessories, outwear, and overcoats rise in
Q3?

You work for a US national fashion retail chain, and are in charge of sales
of accessories, outerwear and overcoat clothing lines in western states.
You see that revenue is much higher for Q3 than the other quarters.

To understand why, you drill down to look at the factors behind the result.
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You see that jewelry sales escalated in July (month #7).

Scope of analysis

The scope of analysis for a query is extra data that you can retrieve from the
database to give more details on the results returned by each of the objects
in a query. This extra data does not appear in the initial result report, but it
remains available in the data cube, so you can pull this data in to the report
to allow you to access more detail at any time. This process of refining the
data to lower levels of detail is called drilling down on an object.

In the universe, the scope of analysis corresponds to the hierarchical levels
below the object selected for a query. For example, a scope of analysis of
one level down for the object Year, would include the object Quarter, which
appears immediately under Year.

You can set this level when you build a query. It allows objects lower down
the hierarchy to be included in the query, without them appearing in the
Results Objects pane. The hierarchies in a universe allow you to choose
your scope of analysis, and correspondingly the level of drill available.
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In the Java Report Panel and in Web Intelligence Rich Client, you can also
create a custom scope of analysis by selecting specific dimensions for the
Scope of Analysis pane.

Note:
You cannot set the scope of analysis when working in query drill mode
because this drill mode causes Web Intelligence to modify the scope
dynamically in response to drill actions.

Levels of scope of analysis

You can set the following levels for scope of analysis:

DescriptionLevel

Only the objects that appear in the
Results Objects pane are included in
the query.

None

For each object in the Result Objects
pane, one, two, or three objects lower
down the hierarchy tree are included
in the query. The data from these ob-
jects is stored in the cube until you add
them to the document.

• One level down
• Two levels down
• Three levels down

All objects added manually to the
Scope of Analysis panel are included
in the query.

Custom

Note:
This option is available in the Java
Report Panel and in Web Intelligence
Rich Client only.

Including a scope of analysis in a document increases the document size
significantly. This is because the data necessary for the scope you specify
is saved with the document, even though it is not visible in the reports unless
you start drill mode and drill down to the data to display the corresponding
values.
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In order to minimize the size of documents and optimize performance, we
recommend that you only include a scope of analysis in documents where
you are certain that users will need to drill.

We suggest the following method because it will be easier for you to set the
scope of analysis seeing the hierarchy of the classes and objects.

To set the scope of analysis

1. ClickShow/Hide Scope of Analysis Pane on the Query toolbar to display
the Scope of Analysis pane.
All the dimensions in the Result Objects pane appear in the Scope of
Analysis pane. This corresponds to the default scope of analysis - None.
(There are no additional levels available for analysis.)

2. Select the analysis level from the Scope level list at the top-right corner
of the Scope of Analysis pane.
The objects hierarchically below the objects in the Result Objects pane
appear in the Scope of Analysis pane down to the number of levels you
selected.

3. To add selected dimensions to the scope of analysis or create a custom
scope of analysis, select dimensions in the Query Manager and drag
them across to the Scope of Analysis pane.

Drill paths and hierarchies

When you analyze data in drill mode, you move along a drill path. These
paths are based on the dimension hierarchies set by the designer of the
universe. Universe designers organize objects in classes in a hierarchy with
the most summary objects at the top and the most detailed at the bottom.
So if you want to make a high-level report, you know that your query should
include objects at the top of the list. If you want to see more detailed
information, you can then switch to Drill mode and drill down on each
dimension value displayed in the reports.

For example, if the data from [Quarter] did not sufficiently explain a result,
you could drill down to [Month] or [Week], depending on how the universe
designer set up the hierarchy. When you drill to a different level, measures,
such as a [Revenue] or [Margin], are recalculated accordingly.
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Drill paths usually follow the same hierarchy order as the classes on a
universe. For example, a class called Time typically includes the [Year]
dimension at the top of the class, followed by the [Quarter], [Month], and
[Week] dimensions. The hierarchies for drill within the Time hierarchy typically
follow the same order, because users want to drill annual results to analyze
details for quarter, month, and so on. However, the universe designer can
also define custom hierarchies.

Note:
A dimension can belong to several hierarchies. When you drill a result on a
dimension that belongs to more than one hierarchy, Web Intelligence prompts
you to select the drill path.

To view drill hierarchies

1. Open a document in Edit mode.
2. Verify you are in Query View.
3. Click the Data tab.
4. Click the Hierarchies radio button.

To switch to drill mode
To start drilling on a report you either switch to Drill mode or, if the report is
saved in Drill mode, drill directly.

1. With a document open, verify you are in Report View.
2. Select the report you want to drill.

The Drill button appears in the Web Intelligence toolbar.

3. Click the Drill button (you can also select Analysis > Drill in Web
Intelligence Rich Client).

Note:
When you open a document that was saved in Drill mode, the document
opens in Drill mode if you have the right to drill on documents. If not, it
opens in Results view..

By default, a drill icon appears on the tab of the drillable report. Depending
on the drill options you selected on the Web Intelligence Document
Preferences page in InfoView, Web Intelligence either makes the selected
report drillable or creates a duplicate of the selected report, in drill mode.
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Related Topics
• Start drill session on a duplicate report option on page 34

Retrieving more levels of data to the
report

When you are drilling a Web Intelligence report, you may want to drill up or
down to a dimension that lies outside the scope of analysis defined for the
document. To return the additional data, Web Intelligence must run a new
query that includes the additional dimension(s) you specify. This is called
extending the scope of analysis.

You can extend the scope of analysis during your drill sessions only if your
security profile allows you to do so. Your security profile is controlled by your
BusinessObjects Enterprise administrator.

If your Drill options are not set to display the Extend the Scope of Analysis
prompt message during drill, you will not be given the option to select filters
if you drill beyond the data already available in the document. In this case,
Web Intelligence immediately runs a new query and returns data for all the
values on the dimensions you are drilling.

To drill out of the scope of analysis

1. Hold your mouse cursor over a dimension value that is at the end of the
scope of analysis.
A ToolTip informs you that a new query is necessary to return the
additional data to the document.

2. Drill on the dimension.

If your Drill options are set for Web Intelligence to prompt you when a
drill action requires a new query, the Extend the Scope of Analysis dialog
box appears.

The dialog box lists the dimensions in the hierarchy above and below the
drilled value. The dimensions already included in the document are
checked. The dialog box also displays the filters that you can select to
filter the new query.

3. Select the check boxes next to the dimensions you want to drill.

Building Reports with Web Intelligence Rich Client 229

22Drilling on report data
Retrieving more levels of data to the report



4. Select the check boxes next to the filters you want to use to filter the
query.

5. Click OK.
Web Intelligence runs a new query and returns the additional data to the
document and the results for the dimension you drilled to appear on the
table.

To choose a drill path when more than
one is available

A dimension can belong to multiple hierarchies. When you drill down on such
a dimension value, Web Intelligence does not know which drill path to follow.
You must define the drill path.

Note:
If the dimension value you choose to drill on is the result of a previous drill,
the drill path is already known. Therefore you do not need to select a drill
path.

1. Drill on the dimension.
The "Select Drill Path" dialog box appears. The dialog box lists the
dimensions in the hierarchy above and below the drilled value. A check
box appears next to each dimensions below the current dimension you
are drilling, so that you can select which of these dimensions you want
to retrieve from the database, in order to continue your drill action. The
dialog box also displays the filters that you can select to filter the new
query.

2. Select the path you want to drill.
3. Click OK.

To take a drill snapshot
• Click Snapshot on the main toolbar.

Web Intelligence makes a copy of the current state of the drilled report
as a seperate report.
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Drilling on dimensions in tables and
sections

Dimensions typically represent character-type data, such as customer or
business names, and dates. Web Intelligence makes calculations based on
the dimensions in a report. For example, if you create a report that calculates
a region’s total sales revenue for a given year, Web Intelligence calculates
the [Sales revenue] measure based on the two dimensions: [State] and
[Year].

When you drill on a dimension to see the more data behind the displayed
result, the sales revenue is calculated according to the values to which you
drill. If you drill on [Year] in the above example, Web Intelligence calculates
and displays sales revenue by state and quarter, because [Quarter] is the
next dimension in the time hierarchy below [Year].

Note:
You cannot drill on detail objects.

Drilling down

You drill down to see the lower-level data that makes up the summary results
displayed on reports. This helps explain why high or low results occurred.

Example: Using drill analysis to find out why sales decreased dramatically
in 2003

In this example, you receive a report that shows sales revenue results for
the accessories line at the eFashion retail store. The following crosstab
shows that the Accessories line decreased in 2003.

To analyze more precisely when the decrease occurred, you drill down on
the cell value 2003, to view the detailed data for each quarter.
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When you drill down on the cell value 2003, a filter appears in the Drill
toolbar to show that the quarterly values you have drilled to are filtered for
the year 2003. The drilled chart clearly shows that the problem arose in Q4
of 2003.

To find out which of the of the categories within the Accessories line was
responsible for the drop in revenue, you drill down again on the cell value
Accessories.

The drilled crosstab shows which categories were responsible for low
revenue in Q4.

Note:
If you try to drill to a dimension that is already displayed in another column or
row of the same table, Web Intelligence automatically displays the next available
dimension in the drill path.
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To drill down on a dimension value in a table or section cell

1. Verify you are in Drill mode
2. On a table or section cell, place your pointer over the dimension value

on which you want to drill.
A ToolTip appears, showing the next dimension in the drill path. If the
drilled report includes dimensions from multiple data providers, the ToolTip
displays the name of the query and the dimension for the value.

3. Click the value.
The drilled table or section displays data one dimension level down. The
Drill toolbar, at the top of the report, displays the values from which you
drilled. These values filter the values displayed on the drilled table.

Drilling up

You drill up on a dimension value to see how the more detailed data
aggregates to a higher-level result. For example, you may have drilled down
on Year to examine data for each quarter. If you want to see how this data
aggregates to yearly results, you can drill up.

When you drill up on a dimension value, you move along the drill path from
lower- to higher-level data. For example, you may have drilled down on [Year]
to [Quarter]. If you drill up on [Quarter], you return to [Year].

You can only drill up on a dimension value if you have previously drilled down
to that dimension, or you have defined the appropriate drill path in the scope
of analysis.

To drill up on a dimension value

1. Verify you are in Drill mode.
2. On a table or section cell, right-click the dimension value on which you

want to drill up, then on the shortcut menu click Drill up , or click the Drill
Up icon next to the dimension value you want to drill up.
If the table is a crosstab without headers that display the names of the
dimensions on the table, then the Drill Up icon appears next to each value
from which you can drill up.
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The report now displays data one dimension level up. The filters that
filtered the value you drilled up from, are removed from the Drill toolbar.

Drilling by

When you drill down or up, you move through a hierarchy one dimension at
a time. However, you can get another view of the data by slicing it in a
different way, and then look at the data in other hierarchies. To do this, you
drill by the other dimensions that interest you.

Note:
You can only Drill by to a dimension that is included in the scope of analysis
of the document.

Example: Drilling by the Products hierarchy to slice sales revenue results
by product

You work as regional manager for California in a retail clothing store, and
have been sent the following report that shows quarterly sales revenue by
state:

You are only interested in analyzing the results in the state of California.
In addition, you want to analyze the sales revenue broken down by each
product line you sell. To drill on California data, you place your pointer on
the table cell that says California.
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If you drilled down now, however, you would drill to results for each city
within California, because [City] is the dimension below [State]. Instead,
you select Drill by from the drill menu and then you navigate through the
dimensions on the Products hierarchy by selecting the sub-menus until you
reach the [Lines] dimension.

The drilled report displays the detailed sales revenue results for each
product line sold in California.
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To drill by a dimension value

1. Verify you are in Drill mode.
2. On a table or section cell, right-click the dimension value you want to drill

by.
A shortcut menu appears, displaying the available drill paths.

3. Place your pointer on Drill by, then on the class to which you want to
drill.

4. Click the dimension to which you want to drill.
The report now displays data for the dimension to which you drilled.

Drilling on measures in tables and
sections

When you drill on a measure value, Web Intelligence performs the drill action
one level down for each related dimension in the block and displays the new
measure calculation for the displayed dimensions.

Example: Drill on annual sales revenue results to see the breakdown by
city and quarter

For example, you drill down on the year 2003 sales revenue value for
California, which is displayed on a crosstab that shows sales revenue by
year in by state.

The drilled report displays sales revenue by quarter by city for California –
the state on which you drilled.

To drill down on a measure value

1. Verify you are in Drill mode.
2. Place your pointer over the measure value on which you want to drill.
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A ToolTip appears, displaying the next dimension(s) in each related drill
path

3. Click the measure value.
Your report now displays data one dimension level down. The table
headers display the names of the dimensions you drilled to and the drill
up arrow, which indicates you can drill back up to the summary results if
wished. The Drill toolbar displays the values that filter the results displayed
on the drilled table or section.

To drill up on a measure value

1. Verify you are in Drill mode.
2. Right-click the measure value on which you want to drill up, then click the

Drill up option on the shortcut menu, or click the Drill Up icon next to the
measure value you want to analyze.
The drilled table now displays data one dimension level up.

Synchronizingdrill acrossmultiple tables
and charts

A Web Intelligence report can contain several tables or charts. The generic
term used to refer to tables and charts in this guide is a block. There are two
ways to drill on a report with multiple blocks:

• drill simultaneously on each block in the report the contains the drilled
dimension

• drill on only the current block of data

You set how Web Intelligence performs drill on reports with the Synchronize
drill on report blocks option.

If you set Web Intelligence to synchronize drilling across a report, you drill
on each block in the report containing that drilled dimension. The next
dimension in the drill path replaces the previous dimension in all blocks of
the report.

If you set Web Intelligence not to synchronize drilling on all blocks in a report,
the next dimension in the drill path replaces the previous dimension only in
the current block of the report.
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Related Topics
• Synchronize drill on report blocks option on page 34

Drilling on charts
Drilling down, up, or by on a chart, provides you with a graphical explanation
for why summary results are particularly high or low.

You can drill on:

• dimensions – by drilling on chart axes
• dimensions – by drilling on the chart legend
• measures – by drilling on the data bars or markers in the body of the chart

You cannot Drill by dimensions on chart axes. However, you can Drill by
dimensions on chart legends.

Related Topics
• Drilling on axis legends on page 241

Drilling on dimensions via chart axes

On 2D charts, you can drill on dimensions via the X-Axis. On 3D charts, you
can drill on dimensions via the X-Axis and the Z-Axis. Charts can contain
one or multiple dimensions on a single axis. When an axis contains multiple
dimensions, each possible combination of the dimension values appear on
the axis (this is sometimes referred to as a cartesian product).

When you drill on an axis value with multiple dimensions, the drilled results
are filtered by both dimensions.

To drill on a chart axis

1. Verify you are in Drill mode.
2. Place your pointer over the dimension value on which you want to drill.
3. If you want to drill down on the dimension value, click the value. If you

want to drill up on the dimension value, right-click the value then select
Drill Up. If you want to drill down on the dimension value, right-click the
value then select Drill Down. If you want to drill by the dimension value,
right-click the value then select Drill By
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Note:
Drill by is not available if the axis has multiple dimensions.

Drilling on measures in charts

You can drill on the measures displayed on the following types of chart:

• bar charts – by drilling on the bars
• line and radar line charts – by drilling on the data markers
• pie chart – by drilling on the segments

When you drill on measures, Web Intelligence performs the drill action on
each dimension displayed on the chart axes. The new measure calculations
displayed on the bars or data markers on the drilled chart, correspond to the
lower- or higher-level dimensions to which you drilled. The chart axis labels
display the names of the drilled dimensions.

Example: Analyze detailed information for the sales revenue measure on
a chart

For example, this 3D bar chart displays values for the [State] dimension on
the X-Axis and displays values for the [Lines] dimension on the Z-Axis. This
means that the chart bars display values for sales revenue per state per
line.
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As the example below shows, when you drill down on the bar for “City
Trousers ? in “California ? you also drill down from [State] to [City] on the
X-Axis and from [Lines] to [Category] on the Y-Axis.

The drilled chart displays sales revenue per city per category for the “City
Trousers ? clothing line.

To drill on a measure in a chart

1. Verify you are in Drill mode.
2. Place your pointer on the measure value on which you want to drill.

On charts, each measure is represented by a bar (on bar charts) or by a
data marker (on a line charts and radar line charts).

3. If you want to drill down on the measure value, click the bar or data
marker. If you want to drill up on the measure value, right-click the bar or
data marker, and then click Drill up.

Limitations when drilling measures on charts

When you drill on charts that are not bar charts, Web Intelligence may perform
the drill action only on certain dimensions instead of performing the drill action
on all of the dimensions on the chart axes. When you drill on measures in
the following chart types, Web Intelligence only performs the drill action on
the values in the axis legend:
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• area charts – 2D, 3D, and stacked
• radar and scatter charts – all types

Note:
You cannot drill on measures in 3D surface charts.

Drilling on axis legends

You can drill on charts via the chart legend whenever the legend lists the
dimensions displayed on the chart. When the chart legend lists the measures
displayed on the chart, drilling on the legend is not possible.

Drilling on a legend is useful, if you are working with a pie chart, because
the axis labels, which display the names of the dimensions represented by
each pie segment, are not often displayed.

Note:
You can only Drill by on a chart legend, if there is a single dimension on the
axis.

To drill on an axis legend

1. Verify you are in Drill mode.
2. Place your pointer over the value on which you want to drill.
3. To drill down the dimension value, click the color associated with the

value. To drill up the dimension value, right-click the color associated with
the value, then click Drill up ; or click the Drill Up icon. To drill by the
dimension value, right-click the color associated with the value, then click
Drill by .

Using filters when you drill
When you drill on a dimension or measure value in a table or chart, Web
Intelligence filters the drilled results by the dimension or measure you drilled
on. The filter is applied to all of the results displayed on the drilled report.

Filters appear as list boxes in the Drill toolbar. Each list box contains the
values associated with that filter. You select the data displayed in a table or
chart by choosing the appropriate values from the list boxes.
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Note:
You can also use the Drill toolbar outside Drill mode to quickly add simple
report filters to reports. In this context the toolbar is known as the Report
Filter toolbar.

Example: Filtering drilled reports by different US states

For example, if you drill down on a table cell displaying “California, ? to
view results for cities in California, Web Intelligence filters the values in the
entire report for California and only displays results for California in the
report.

By changing the value of each filter, you can then see data for other values
on the drilled dimension. For example, you can select Colorado in the filter
on State.

Note:
If the drilled report includes dimensions from multiple data providers, a ToolTip
appears when you rest your cursor on the value displayed on the filter. The
ToolTip displays the name of the query and the dimension for the value.

Related Topics
• To create simple report filters on page 203

To change a filter value on the Drill toolbar

1. Verify you are in Drill mode.
2. In the Drill toolbar, click the drop-down arrow relating to the dimension

you want to filter.
3. Click the value you want.

To add or remove a drill filter

1. Verify you are in Drill mode.
2. Drag the dimension containing the values around which you want to filter

your report and drop it onto the Drill toolbar.
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A list box for the new filter appears on the Drill toolbar. You can select a
value from the list of values to filter the results displayed on the drilled
table, chart, or report.

3. To remove a drill filter, drag the dimension away from the Drill toolbar.

Saving reports with drill filters
When you save a document with reports in drill mode, Web Intelligence
maintains any filters that have been generated during drill. When you open
a document saved in drill mode, Web Intelligence displays the Drill toolbar
on the drilled reports showing the filters generated during the last drill session.

Note:
Documents saved in drill mode take longer to open than documents saved
in results mode.

Refreshing data in a drilled report with
prompts

Some Web Intelligence reports contain prompts. When you refresh the
document, the prompt(s) require(s) you to specify the value(s) you want to
retrieve from the database and return to the report(s) in the document. For
example, a prompt can require you to specify a year, for which you want to
retrieve data. This drilled report shows values for Year 2003 – the year
selected for the prompt.

If the drilled report is filtered for Year 2003, and you then refresh the document
and select year 2002 to answer the prompt, Web Intelligence retrieves results
for 2002 instead of 2003. The drilled report then displays values for 2002.

Drilling with query drill

Query drill defined

You can set Web Intelligence to drill in query drill mode, which behaves
differently from the standard drill mode described so far in this chapter. When
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you activate query drill, Web Intelligence drills by modifying the underlying
query (adding and removing dimensions and query filters) in addition to
applying drill filters.

Example: Drilling down from month to week

In this example, Month is the lowest dimension currently available in the
query from a time hierarchy, and Week is the dimension immediately below
it in the hierarchy.

If you drill down on Month = January, three things happen:

• Web Intelligence adds Week to the query scope of analysis.
• Web Intelligence adds a query filter to restrict Month to January.
• Web Intelligence adds a drill filter to restrict Month to January.

If you drill up from Week to Month, the process is reversed:

• Web Intelligence removes Week from the query scope of analysis.
• Web Intelligence removes the query filter.
• Web Intelligence removes the drill filter.

Note:
Drill filters are not strictly necessary in query drill mode. Web Intelligence applies
them for consistency with standard drill mode. For example, the DrillFilters
function returns the correct value in query drill mode because Web Intelligence
applies drill filters to match the query filters.

When do you use query drill?

You use query drill when your report contains aggregate measures calculated
at the database level. It is designed in particular to provide a drill mode
adapted to databases such as Oracle 9i OLAP, which contain aggregate
functions that Web Intelligence either does not support, or cannot calculate
accurately at the report level during a drill session.

The kinds of aggregate functions that are candidates for drilling in query drill
mode are: percentages, distinct counts, ranks, standard deviations and
variances, running aggregates, lead and lag functions. Because query drill
modifies the query at each drill operation, it ensures that these aggregates
are recalculated by the server each time you drill.
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Query drill is also useful for reducing the amount of data that Web Intelligence
must store locally during a drill session. Because query drill reduces the
scope of analysis when you drill up, Web Intelligence is able to purge
unecessary data.

To activate query drill

1. Right-click on the document anywhere outside a table or chart and click
Document Properties to display the Document Properties pane.

2. Open the Document Options group within the tab.
3. Check Use query drill.

If your report already has a scope of analysis defined, you see a message
telling you to clear the scope of analysis before activating query drill.

Drilling with query drill

Drilling down with query drill
When you drill down, query drill behaves similarly to standard drill at the
point where the data moves outside the scope of analysis.

When Web Intelligence filters a drilled dimension in query drill mode it does
so by adding a query filter in addition to a drill filter. For example, if you drill
on Year=2001, Web Intelligence adds a filter at the query level to restrict the
Year dimension to 2001. For this reason, the only value that appears in the
drill toolbar for the drilled dimension is the value on which you drilled (in this
case 2001). This is different from standard drill mode, in which all values of
the dimension are visible in the toolbar. As a result, you cannot change filter
values in query drill mode (for example, drill on Year=2001 then switch to
Year=2003) as you can in standard drill mode.

Because query drill automatically extends the scope of analysis, you can
use it only if your BusinessObjects XI administrator has granted you the the
right to drill outside the scope. See your administrator for more details.

Drilling up with query drill
When you drill up, query drill removes dimensions from the query. For
example, if you drill up from Month to Quarter, Web Intelligence removes
Month from the query. This has two consequences:

• Query drill is incompatible with drill snapshots.
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• Web Intelligence does not allow you to drill up beyond any dimension
that appears as one of the report objects. For example, if your report
displays Year, Quarter and Revenue, you cannot drill up from Quarter to
Year because this would remove quarter from the list of report objects.

Related Topics
• Query drill and drill snapshots on page 246

Query drill and drill snapshots
Do not use drill snapshots when working in query drill mode, because query
drill means that snapshots cannot be guaranteed to stay the same.

In query drill mode, snapshots change when you drill up beyond a dimension
that you included in a snapshot. Because the drill up removes the dimension
from the underlying query, it also removes the dimension from the snapshot.

Query drill and other reports based on the same data provider
If your document contains other reports that contain dimensions on which
you drill in query drill mode, these reports are affected because the query
drill modifies the dimensions they contain.

You can avoid this (at the cost of retrieving duplicate data into Web
Intelligence) by creating a new data provider and rebuilding the other report
against it. Now when you drill in query drill mode, the other report remains
unaffected.

Example: Drilling on a dimension that appears in another report

If you have two reports based on a query that contains Year, Quarter and
Sales Revenue, and you use query drill to drill down to Year = 2001 on the
first report, Web Intelligence also filters the data for Year in the second
report to include 2001 only.
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Merged dimensions defined
You can include multiple data providers in a Web Intelligence document.
You often need to synchronize the data returned by these data providers.
You do this by incorporating common dimensions into a merged dimension.

Merged dimensions and data synchronization were introduced in Web
Intelligence XI R2. They enormously increase the power and flexibility of
Web Intelligence by allowing you to synthesise data from different sources
in the same report, rather than simply including the data.

For example, if you have one database that contains detailed customer
information and another database that contains sales data, you can
synchronize the two data sources around the customer.

When to merge dimensions
You merge dimensions when your report draws related data from different
data providers. For example, you have a report showing revenue and sales
targets. The report contains sections based on the year, and each section
shows revenue and sales targets. If revenue and sales target data comes
from two different data providers, Web Intelligence does not know that it is
related. You tell Web Intelligence that the data is related by merging the two
data providers on the common dimension, year.

When you merge dimensions, Web Intelligence creates a new dimension
that contains all the values from the original dimensions that make up the
merged dimension. You use this dimension in reports as you use any other
report object. You can add report objects from all the data providers
synchronized through the merged dimension in the same block as the merged
dimension.

Choosing which dimensions to merge
The only restriction that Web Intelligence imposes on merged dimensions
is that they must be of the same data type: for example, character data. But
it does not make sense to merge unrelated dimensions even when their data
types are the same. For example, it does not make sense to merge a
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dimension containing customer names with a dimension containing sales
regions.

Merged dimensions often have the same name in both data sources, but
this is not obligatory. It can make sense to merge dimensions with different
names if they contain related data.

To merge dimensions correctly you need to be aware of the semantics of
the data (what the data refers to) in the different data sources. The dimension
data types and names are an approximate guide only to dimensions’ suitability
for merging.

Merged dimension example
The following example with two data providers illustrates the effect of merging
dimensions:

Example: Merging City dimensions

Data Provider 1:

CityCountry

New YorkUS

Los AngelesUS

ParisFrance

ToulouseFrance

Data Provider 2:

RevenueCity

100000New York

75000Los Angeles

90000Paris
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RevenueCity

60000Toulouse

If you merge the City dimensions and display the Country, merged City
dimensions and Revenue measure in a table, Web Intelligence returns the
following result:

If the City dimensions are not merged, Web Intelligence displays the
following result:

RevenueCityCountry

325000New YorkUS

325000Los AngelesUS

325000ParisFrance

325000ToulouseFrance

Because there is no link between the two data providers through a merged
dimension, Web Intelligence is unable to relate the city revenues to
countries. As a result Web Intelligence displays the total revenue against
each Country/City pair.

If the City dimensions are merged, Web Intelligence displays the following
result:

RevenueCityCountry

100000New YorkUS

75000Los AngelesUS

90000ParisFrance

60000ToulouseFrance

250 Building Reports with Web Intelligence Rich Client

Merging dimensions from multiple data providers23 Merged dimension example



Forcing merged calculations with the
ForceMerge function

By default, Web Intelligence does not account for merged dimensions in
calculations if the merged dimensions do not explicitly appear in the
calculation context.

Example: Calculating revenue with ForceMerge

This example has two data providers as follows:

Data Provider 1:

CityCountry

New YorkUS

Los AngelesUS

ParisFrance

ToulouseFrance

Data Provider 2:

RevenueCity

100000New York

75000Los Angeles

90000Paris

60000Toulouse

If you merge the [City] dimensions, then create a table with [Country] and
[Revenue], Web Intelligence displays the following result:
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RevenueCountry

325000US

325000US

325000France

325000France

Because [City], the merged dimension, does not appear in the table, Web
Intelligence does not take the merge into account when calculating revenue.
Web Intelligence lists the total revenue in the second data provider against
each country.

To display the correct result, replace [Revenue] in the second column with
the formula ForceMerge([Revenue]):

RevenueCity

175000US

175000US

150000France

150000France

Web Intelligence now takes the relationship between countries and cities
into account when calculating revenue.

Note:
If [Revenue] is a smart measure in the above example, ForceMerge([Rev
enue]) returns #MULTIVALUE. This is because the grouping set (Country)
does not exist for the [Revenue] measure. ForceMerge([smart_measure])
always returns #MULTIVALUE, unless by chance no aggregation is required
to calculate the measure.
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Creating, editing and deleting merged
dimensions

To merge dimensions

1. ClickMerge Dimensions on the toolbar (you can also selectData >Merge
Dimensions in Web Intelligence Rich Client).
The "Merge Dimensions" dialog box appears.

2. Select the dimensions you want to merge in the boxes at the top of the
dialog box.
When you select a dimension, all dimensions of different data types are
disabled because you cannot merge dimensions of different data types.

3. Click Values to view the values associated with the dimensions.
4. Click Merge.

The "Create Merged Dimension" dialog box appears. You use this dialog
box to specify the properties of the merged dimension.

5. Select the dimension in the Source Dimension drop-down list.
The source dimension provides the default name, description and number
formats for the merged dimension.

6. Type the merged dimension name in the Merged Dimension Name box
and the merged dimension description in the Description box.

7. Click OK.
The merged dimension name appears in the "Merged Dimensions" box
and the dimensions that are part of the merged dimension appear in the
boxes alongside it. Because an original dimension can be part of one
merged dimension only, it no longer appears in the box above that lists
the original dimensions in the query.

8. Click OK to close the "Merged Dimensions" dialog box.
Web Intelligenceadds the merged dimensions to the list of merged
dimensions in the Data tab.
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To define a merged dimension

You define a merged dimension in the "Create Merged Dimension" dialog
box.

1. Type the merged dimension name in the Merged Dimension Name box.
2. Type the merged dimension description in the Description box
3. To use the name and description of one of the source dimensions in the

merged dimension, select the source dimension from the Source
Dimension list.

4. Click OK.

To merge dimensions automatically

You can set Web Intelligence to merge dimensions automatically under the
following circumstances:

• The dimensions have the same name
• The dimensions have the same data type
• The dimensions are in the same universe
1. Right-click outside any block or chart and click Document Properties

on the popup menu.
2. Click Auto-merge dimensions.

To edit a merged dimension

1. In the Data tab, select the dimension in the Merged Dimensions folder
and click the right mouse button.

2. Select Edit Merged Dimension from the menu.
The "Merged Dimensions" dialog box appears.

3. Edit the merged dimension.

Related Topics
• To merge dimensions on page 253
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To delete a merged dimension

1. Select the dimension in the Merged Dimensions folder in the Data tab
and click the right mouse button.

2. Select Delete Merged Dimension from the menu.

Understanding the effects of merged
dimensions

Data synchronization through merged dimensions adds enormous power to
Web Intelligence. Merged dimensions also have implications for the results
that Web Intelligence displays in certain situations. You need to understand
these implications to work effectively with merged dimensions and
synchronized data.

Synchronizing data providers with different
aggregation levels

You can synchronize data providers with different aggregation levels. This
can have implications for the way in which Web Intelligence calculates
measures.

Example: Synchronizing data providers with different aggregation levels

In this example you have two data providers as follows:

RevenueYearCustomer

15002004Jones

20002005Jones

12002005Smith
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Number of salesCustomer

12Jones

10Smith

If you merge the two data providers and the table properties Avoid
duplicate rows aggregation and Show rows with empty dimension
values are unchecked, Web Intelligence returns the following:

Number of salesRevenueYearCustomer

1215002004Jones

1212002005Jones

1012002005Smith

Web Intelligence cannot determine the number of sales per year for
customer Jones because the data provider that stores the number of sales
does not break them down by year. Web Intelligence therefore reproduces
the total number of sales on each row.

Note:
Although the Number of Sales values are duplicated, if you add a standard
calculation to the bottom of the column (for example a Sum or Average
calculation), the result is correct.

One way of adressing this issue is to add the dimensions to the second
data provider that allow Web Intelligence to calculate to the appropriate
level of data. If this is not possible, you must be aware of any situations
where Web Intelligence cannot aggregate the data to the necessary level
of detail.

Detail objects and merged dimensions

Detail objects are associated with dimensions and provide additional
information about the dimension.

256 Building Reports with Web Intelligence Rich Client

Merging dimensions from multiple data providers23 Understanding the effects of merged dimensions



Web Intelligence XI R2 requires a one-to-one relationship between
dimensions and details (this means that a detail object can have one value
only for each value of its associated dimension) and does not take detail
objects into account when synchronizing data. The following example
illustrates why this is necessary.

Previous versions of Web Intelligence, as well as Desktop Intelligence and
BusinessObjects, allow a one-to-many relationship between dimensions and
details. If you migrate a report created using any of these products and the
detail object contains multiple values, Web Intelligence places the
#MULTIVALUE error in the detail cell.

Example: Synchronizing data providers with detail objects

In this example you have two data providers, and [Address] is a detail object
related to [Customer]:

RevenueAddressCustomer

10000LondonJohn

15000LiverpoolPaul

Telephone NumberCustomer

1234John

5678Paul

If you create a merged Customer dimension to synchronize the data
providers, and Address can have more than one value for each customer,
the result is ambiguous because there is no common value around which
Web Intelligence can synchronize the data.

For example, Paul might have addresses in Liverpool and London, which
means that there is no unique ‘Paul’ row with which Web Intelligence can
synchronize Paul's telephone number. Paul has a different telephone
number for each address, and Web Intelligence does not know which
address to associate with the telephone number:
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Telephone NumberAddressCustomer

1234LondonJohn

5678#MULTIVALUEPaul

If the relationship between Customer and Address is one-to-one, Web
Intelligence can ignore Address in the synchronization. This removes the
ambiguity:

Telephone NumberAddressCustomer

1234LondonJohn

5678LiverpoolPaul

Incompatible objects and merged dimensions

As a general rule, Web Intelligence does not allow you to place dimensions
from different data providers in the same table. This is to avoid Cartesian
products (the display of all possible combinations of values from unrelated
objects) or other ambiguous results, depending on the universe structure.

You can always place measures from different data providers in a table. Web
Intelligence calculates the measure depending on what dimensions are
available. For example, if you place a measure in a table that contains no
dimensions from the same data provider as the measure, Web Intelligence
displays its total value in the table.

You can place a merged dimension in a table as long as the table contains
other dimensions from a data provider that participates in the merge. You
can also place details from different data providers in a table, as long as the
details are associated with dimensions that participate in a merged dimension.

In certain situations, it can be valid to place a dimension from another data
provider in a table, even when Web Intelligence does not permit this. This
occurs when the incompatible dimension has a one-to-one or one-to many
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relationship with a dimension already in the table. The important point is that
there is only one value of the incompatible dimension associated with the
dimension in the table (one-to-one). On the other hand, the same value of
the incompatible dimension can be associated with multiple values of the
dimension in the table (one-to-many).

In the table below, the relationship between Address and Name conforms
to these rules: Address has a one-to-one or one-to-many association with
Name. There is no one-to-many association in the other direction, between
Name and Address (one name with more than one address):

Incompatible dimension (Address)Dimension in table (Name)

LondonJohn

LondonPaul

LiverpoolGeorge

In this case the universe design is incorrect - the incompatible dimension
(Address) should be defined as a detail of the dimension in the table (Name).
If you encouter this situation, see your Business Objects administrator and
ask for a redesign of the universe.

If it is not practical to change the universe, create a variable at the report
level. Define this variable as a detail, associate it with the dimension in the
table, and supply the name of the incompatible dimension as the variable
definition. The variable simply returns the same values as the incompatible
dimension. Because it is defined as a detail of the dimension in the table,
Web Intelligence allows you to place it in the same table as the dimension.

Filtering merged dimensions

Merging dimensions has implications for the way in which Web Intelligence
applies filters.

Note:
You cannot apply a filter a on merged dimension. You apply filters on the
dimensions that make up the merged dimension.
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Report filters and merged dimensions

When you apply a report filter to a dimension that is part of a merged
dimension, Web Intelligence applies the filter to all data providers that are
synchronized through the merged dimension.

Example: Filtering a merged dimension

In this example you have a report with the following data providers, which
are merged on the Country dimension

RevenueResortCountry

835,420French RivieraFrance

971,444Bahamas BeachUS

1,479,660Hawaiian ClubUS

Future GuestsCountry

46France

56US

If you apply the filter Country= ?US ? to the first block, Web Intelligence
also filters the second block to give the following result:

Future GuestsCountry

56US

If the Country dimensions are not merged the second block is unaffected
by the filter.
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Section filters and merged dimensions

When a dimension that is part of a merged dimension is set as a section
header, any filter applied to the section also applies to blocks from
synchronized data providers within the section.

Related Topics
• Filtering a merged dimension on page 260

Block filters and merged dimensions

When you apply a block filter to a dimension that is part of a merged
dimension, Web Intelligence applies the filter to the block. Web Intelligence
does not apply the filter to other data providers synchronized through the
merged dimension.

Drilling on merged dimensions

When you merge dimensions, the new merged dimension belongs to the
hierarchies of all dimensions involved in the merge.

Extending the values returnedbymergeddimensions

Merged dimensions were a new concept in Web Intelligence XI R2.
Synchronizing data providers already existed in Desktop
Intelligence/BusinessObjects but it did not involve the creation of a new
merged dimension. BusinessObjects reports use the original dimensions
that make up a merged dimension in Web Intelligence.

You can use these original dimensions in a Web Intelligence report. When
you place them in the report, Web Intelligence returns by default only those
dimension values that have corresponding values in the data providers
synchronized through the merge. You need to be aware of this when migrating
reports from Desktop Intelligence and BusinessObjects because
BusinessObjects/Desktop Intelligence behaves differently.
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Example: Web Intelligence and Desktop Intelligence/BusinessObjects
behavior when dimensions are merged

You have a report with the following data providers:

RevenueCountry of origin

470Germany

RevenueCountry of origin

499Japan

If you include the Country of Origin dimension from Data Provider 1 and
the Revenue measure from Data Provider 2 in the same block, Web
Intelligence returns the following result:

RevenueCountry of origin

Germany

The same block in Desktop Intelligence/BusinessObjects returns the
following result:

RevenueCountry of origin

Germany

499Japan

The block is different in Desktop Intelligence/BusinessObjects because
BusinessObjects extends the values of the Country of Origin dimension
through the values returned by the Revenue measure.
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To extend dimension values

1. Right-click your report outside any blocks or charts and select Document
Properties on the shortcut menu.
The Document Properties pane appears on the right side of the report.

2. Check the Extend merged dimension values option.
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Ranking report data
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Ranking data
Ranking allows you to isolate the top and bottom records in a set based on
a variety of criteria. For example, if you have a block showing countries and
associated revenues, ranking allows you to rank the data in the block to show
the top 3 countries only, based on the revenue they generate.

Ranking allows you to answer business questions such as:

• Which 3 regions generate the most revenue?
• Which are the bottom 10% of stores in terms of revenue generation?
• What is the group of the best-performing stores that generates a combined

revenue of up to $10,000,000?

Web Intelligence allows you to rank data in many ways to answer these kinds
of business questions. You can:

• rank the top and/or bottom n records by dimension (for example Country)
based on the sum of a related measure (for example Revenue)

• rank the top and/or bottom n% of the total number of records by dimension
based on the value of a related measure as a percentage of the total
value of the measure

• rank the top and/or bottom n records by dimension based on the
cumulative sum of a related measure

• rank the top and/or bottom n records by dimension based on the value
of a related measure as a cumulative percentage of the total value of the
measure

Rankings and sorts
Web Intelligence sorts data as part of applying a ranking. For example, if
you rank the top 3 stores by revenue, Web Intelligence sorts the stores in
descending order by revenue generated.

The sorts that Web Intelligence applies in rankings take precendence over
sorts that you have previously applied to your data. For example, if you have
previously sorted the list of stores in alphabetical order, Web Intelligence
overrides this sort when applying the ranking.
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Tied rankings
Web Intelligence assigns equal ranking values to tied rankings and pushes
back the ranking values of the rows after the tie. This means that a bottom
n ranking can return more than n records.

Example: Top and bottom tied rankings

The following table shows a tied ranking. The Top 3 ranking column shows
how Web Intelligence ranks these records in a top 3 ranking; the Bottom 3
Ranking column shows how Web Intelligence ranks these records in a
bottom 3 ranking.

Bottom 3 Rank-
ingTop 3 RankingMeasureDimension

1410A

2320B

3130C

3130D

In each case Web Intelligence includes records up to and including rank
3. This results in the following for a top 3 ranking:

MeasureDimension

30D

30C

20B

It results in the following for a bottom 3 ranking:
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MeasureDimension

10A

20B

30C

30D
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Ranking parameters
DescriptionParameter

When the calculation mode is Count,
the ranking returns the top/bottom n
records based on the measure
specified in the Based on parameter.
For example, the top 3 countries by
revenue generated, the bottom 3
year/quarter combinations by rev-
enue generated.

When the calculation mode is Per-
centage, the ranking returns the
top/bottom n% of the total number of
records based on the measure
specified in the Based on parameter.
For example, if there are 100 records
and you rank the top 10%, the rank-
ing returns the top 10 records.

When the calculation mode is Cumu-
lative Sum, the ranking returns the
top/bottom records for which the cu-
mulative sum of the measure speci-
fied in Based on does not exceed n.

When the calculation mode is Cumu-
lative Percentage, the ranking returns
the top/bottom records for which the
cumulative sum of the measure
specified in Based on does not ex-
ceed n% of the total of the measure.

Top/bottom
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DescriptionParameter

When the calculation mode is Count
- the number of records to retrieve
based on the measure.

When the calculation mode is Per-
centage - the percentage of records
to retrieve based on the measure.

When the calculation mode is Cumu-
lative Sum - the cumulative sum that
the measure must not pass.

When the calculation mode is Cumu-
lative Percentage - the cumulative
sum of the measure, represented as
a percentage of the total, that the
measure must not pass.

n/n%

The measure on which the ranking is
based.Based on

The ranking dimension. If you specify
a ranking dimension, Web Intelligence
uses the aggregated values of the
Based on measure, calculated for the
dimension, to determine the ranking. If
you do not specify this dimension, Web
Intelligence uses the values of the
Based on measure calculated for all
dimensions in the block. (In other
words, Web Intelligence returns the
top/bottom X rows in the block based
on the measure.)

Ranked By

The type of calculation used to create
the ranking. See the description of the
Top/Bottom and n/n% parameters at
the top of this this table for more infor-
mation.

Calculation mode

270 Building Reports with Web Intelligence Rich Client

Ranking report data24 Ranking parameters



Example of a ranking

A table contains the following data:

RevenueQuarterYear

100Q12006

200Q22006

300Q32006

500Q42006

400Q12007

700Q22007

300Q32007

600Q42007

200Q12008

200Q22008

400Q32008

500Q42008

Total for Q1: 700

Total for Q2: 1100

Total for Q3: 1000

Total Q4: 1600

If you rank the top 2 of each Quarter based on Revenue, Web Intelligence
filters out all the rows for Q1 and Q3 because Q4 and Q2 have the highest
aggregate revenues.
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Ranking and data order
You cannot rank on an object whose values depend on the data order. This
is because the ranking changes the data order, which in turn changes the
object data, which then requires Web Intelligence to recalculate the ranking.
The result is a circular dependency between the ranking and the object that
Web Intelligence cannot resolve.

If you create a rank on a measure whose values depend on the data order,
for example a measure that that uses the Previous function or any of the
running aggregate functions such as RunningSum, Web Intelligence displays
the #RANK error message in all cells in the block.

Ranking workflows
There are two ways of ranking data in Web Intelligence. You can:

• create a ranking by using the Web Intelligence interface
• use the Rank function to return a ranking value

When you rank the data in a block by using the Web Intelligence interface,
you tell Web Intelligence to sort and filter the data in the block according to
the rank. For example, if you rank the top 3 countries in a block by revenue,
Web Intelligence sorts the countries in descending order by revenue, then
filters the block to remove all countries other than the 3 with the highest
revenue.

Note:
When you create a ranking using the interface, Web Intelligence uses the
Rank function behind the scenes to assign ranking values.

To create a ranking

1. Select the block that you want to rank.
2. Click Rank.

The "Create Rank" dialog box appears

3. Click Top and select the number of records if you want to rank the highest
records in the block.
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4. Click Bottom and select the number of records if you want to rank the
lowest records in the block .

5. Select the measure on which the ranking is based in the Based on list.
6. Click Ranked By and select the dimension on which the ranking is based

if you want to rank by a particular dimension rather than by all dimensions
in the block.

7. Select the rank calculation mode in the Calculation mode list.
8. Click OK.

Ranking examples
In the following examples, you have a dimension, Region, and a measure,
Revenue, which give the following values:

% of Total RevenueRevenueRegion

7%1000000South East

13%2000000South West

20%3000000North East

24%4000000North West

33%5000000Central

Example: Rank the top 3 regions by revenue generated

1000000

ValueParameter

TopTop/Bottom

3n/n%
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ValueParameter

Region (or unspecified because region
is the only dimension in the block and
therefore the default ranking dimen-
sion)

For Each

RevenueBased on

CountCalculation mode

This ranking gives the following result:

RevenueRegion

5000000Central

4000000North West

3000000North East

To calculate this ranking, Web Intelligence:

• sorts the records in descending order
• displays the top 3 records

Example: Rank the bottom 40% of regions by revenue

To perform this ranking you set the following parameters

ValueParameter

BottomTop/Bottom

40%n/n%

RegionFor Each
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ValueParameter

RevenueBased on

PercentageCalculation mode

This ranking gives the following result:

RevenueRegion

1000000South East

2000000South West

To calculate this ranking, Web Intelligence:

• sorts the records in ascending order
• works through the records until 40% of the total number of records are

displayed

Example: Rank the top regions whose cumulative revenue is less than or
equal to 10,000,000

To perform this ranking you set the following parameters:

ValueParameter

TopTop/Bottom

10000000n/n%

RegionFor Each

RevenueBased on

Cumulative sumCalculation mode

This ranking gives the following result:
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RevenueRegion

5000000Central

4000000North West

To calculate this ranking, Web Intelligence:
• sorts the records in descending order
• works through the records until it reaches the record that causes the

the cumulative total of the measure to pass 10,000,000
• includes those records that do not cause the cumulative total to pass

10,000,000

Example: Rank the bottom regionswhose cumulative revenue is less than
or equal to 30% of the total revenue

To perform this ranking you set the following parameters:

ValueParameter

BottomTop/Bottom

30%n/n%

RegionFor Each

RevenueBased on

Cumulative percentageCalculation mode

This ranking gives the following result:

RevenueRegion

1000000South East
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RevenueRegion

2000000South West

To calculate this ranking, Web Intelligence:
• sorts the records in ascending order
• works through the records until it reaches the record that causes the

cumulative total of the measure, expressed as a percentage of the overall
total of the measure, to exceed 30%

• displays those records that do not cause the cumulative percentage to
pass 30%
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Alerters defined
Alerters enable you to highlight results that meet or fail specific business
targets. You can create a simple alerter to highlight particularly high or low
results with a specific color or with a text comment, such as “High Performer".

An alerter can contain up to six conditions. This enables you to highlight
information that meets multiple business criteria. For example, you can define
an alerter that highlights high revenue for a specific business activity or
customer sector.

You can apply alerters to table body cells (by column or row), to section cells,
to header cells, and to free-standing cells. However, you cannot apply alerters
to entire tables or forms, or to charts.

Business Objects officially supports up to 30 alerters in a Web Intelligence
document. You can apply those alerters to a maximum of 20 table columns
or rows, free-standing cells, or section cells on the reports.

Business Objects officially supports up to 10 different alerters on a single
table column or row, free-standing cell, or section cell.

You can define alerters to activate the following formatting changes to the
selected table columns/rows or cells:

• text color, size and style
• cell border colors and style
• cell background display – specific colors, images, or hyperlinks to web

pages

You can also define alerters that display a text or formula, an image, or a
hyperlink. In this case, the results that meet the condition defined in the
alerter will be replaced by the text for formula.

If you define an alerter with multiple conditions, each condition generates
the same formatting changes. To generate different formatting changes for
different conditions, you must use sub-alerters.

Alerters are dynamic. This means that when you refresh reports with the
latest data on the database, the alerters highlight the new results accordingly.

If you apply an alerter to a table row or column with a break, the alerter is
only activated when the value that meets the condition in the alerter appears
on the first row of that break.
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Web Intelligence Interactive displays the formatting effects of alerters created
using the Java Report Panel or Web Intelligence Rich Client. You cannot
create new alerters in Web Intelligence Interactive.

Sub-alerters

An alerter can be made of multiple sub-alerters, each containing one or
multiple conditions. Sub-alerters allow you to apply different conditions and
different formatting to a single object.

You must use sub-alerters if you want different conditions to generate different
formats. If you define an alerter with multiple conditions, the alerter format
is applied to all of the conditions.

For example, in a single alerter defined for [Sales revenue], one sub-alerter
can highlight high results in green and a second sub-alerter can highlight
low results in red. You can include a maximum of eight sub-alerters in an
alerter.

To add, edit, duplicate, prioritize or
activate alerters

1. To display the "Alerters" dialog box, clickAlerters on the Reporting toolbar
(you can also selectReporting >Alerters in Web Intelligence Rich Client.)

2. To add an alerter, click New then build the alerter using the Alerter Editor.
3. To edit an alerter, select the alerter from the list, click Edit then use the

Alerter Editor to edit the alerter.
4. To duplicate an alerter, select the alerter from the list then click Duplicate.
5. To remove an alerter, select the alerter from the list than click Remove.
6. To activate or deactivate an alerter, select the alerter from the list then

check or uncheck the alerter.
7. To prioritize an alerter, select the alerter from the list then use the up or

down arrow buttons to change the priority of the alerter in the list.

To build an alerter
1. Type the alerter name in the Alerter name box in the Alerter Editor.
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2. Type the alerter description in the Description box.
3. Define the conditions that trigger the alerter as described in the following

four steps.
4. Select the cell or object whose value triggers the alerter in the Filtered

object or cell box.
If the cell on which you want to create an alerter contains date or numeric
type data (for example, a date or a calculation) you need to select an
object or variable instead of Cell contents. This is because Web
Intelligence considers any value you type into the Value text box as a
character string.
• To trigger the alerter using the data in whichever cell is currently

selected, click ..., then select Cell contents from the menu.
• To trigger the alerter using the value of an object or variable, click ...,

select Select Object or Variable on the menu, then select the object
or variable in the "Objects and Variables" dialog box.

5. Select the operator from the Operator list.
6. Enter the value that triggers the alerter in the Value box.

• To enter a value directly, type it in the box.
• To select a value from the list of values of the object you chose in the

Filtered object or cell box, click ... to the right of the Value box, click
Select Value on the menu, then select the value in the "List of Values"
dialog box.

• To select another object or variable as the value, click ... to the right
of the Value box, click Select Object or Variable on the menu, then
select the object or variable in the "Objects and Variables" dialog box.

• To clear the Value box, click ... to the right of the box, the select Empty
on the menu.

7. To add an additional condition that triggers the alerter, click + below the
existing conditions, then then choose the filtered cell or object, operator
and value as described above.

8. To remove a condition, click - next to the condition.
9. To trigger the alerter using a formula instead of conditions as described

above, click Formula, then type the formula in the box that appears or
click Fx to build the formula using the Formula Editor.
• Do not include quote marks before or after the text. For example, if

you want the alerter to display OVERDUE, then type: OVERDUE.
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• The formula must return True or False. True triggers the alerter; False
does not. For example, if the formula is RowIndex()=3, the alerter
formatting appears on the fourth row of the table.

10. To add an additional condition or set of conditions to the alerter, click Add
Sub-Alerter, then define the conditions or build a formula as described
above.

11. To remove a sub-alerter, click Remove Sub-Alerter.
12. To set the format that appears when the alerter is triggered, click Format

then use the Alerter Display dialog box to set the format.

To set the format of an alerter
1. Click Format in the Alerter Editor.

The "Alerter Display" dialog box appears.

2. Type the alerter text or the formula that the alerter uses to generate its
output in the Display box.
You can also build a formula by clicking Fx and using the Formula Editor.

3. Define the text format (font, font style color and alignment) in the Text
area.

4. Define the color and image of the alerter background in the Background
area.

5. Define the alerter border in the Border area.
6. Click OK to return to the Alerter Editor.

Using formulas to create advanced
alerters

You can build advanced alerters using the Web Intelligence formula language
rather than using the Filtered object or cell,Operator andOperand choices
offered by default.

You can create alerters that display text, formulas, or hyperlinks in the report
cells, where results meet the condition(s) defined in the alerter.

This enables you to display messages in cells, such as “UNPAID, ? or to
display formulas that change the results (for example, to display a text you
specify and the result of the object in the same cell), or to include links to
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other web pages that can be consulted easily whenever results meet the
business condition(s) set in the alerter.

Example: Highlighting three ranges of quarterly sales revenue results
calculated as percentages of the average sales revenue

In this example, you build three alerters to color-code sales revenues,
depending on their relationship to the average sales revenue. The table
includes results for three years, and this is the average to which you want
to compare each sales revenue result calculated per quarter per product
line.

Using the Formula option in the Alerter Editor, you build the following alerter,
which contains three sub-alerters.

Each sub-alerter has a single condition. Web Intelligence combines the
sub-alerters with the Or operator, as follows:

[Sales revenue] < ((Average([Sales revenue]) In Block) * 0.8)

Or

=[Sales revenue] < ((Average([Sales revenue]) In Block) * 1.2)

Or

=[Sales revenue] > ((Average([Sales revenue]) In Block) * 1.2)

The formula you specify for each sub-alerter is calculated as follows:
• The first sub-alerter will be activated on sales revenue results that are

< 0.8 (this means, less than 80%) of the average.
• The second sub-alerter will be activated on sales revenue results that

are < 1.2 (this means, less than 120%) of the average.
• The third sub-alerter will be activated on sales revenue results that are

> 1.2 (this means, greater than 120%) of the average.

You then use the formula pane in the Alerter Display dialog box, to specify
the conditional formatting you want displayed on the report cells. Here, you
specify an appropriate text string and format you want displayed, when the
results in a table cell meet the condition for one of the sub-alerters. You
specify the following:

• Report cells containing sales revenue results that are less than 80% of the
average revenue display the character string in red.
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• Report cells containing sales revenue results that are less then 20% above
the average revenue display in blue. Note that this alerter covers values
also covered by the first alerter. For example, if the average is 100, then 79
is both > 80% below the average and < 20% above the average. In this
case, the first alerter takes precedence.

• Report cells containing sales revenue results that are greater than 20%
above the average revenue display in green.

This formatting enables you to see at a glance which product lines are
generating above or below the total average sales revenue.
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Tracking changes in your data
To make informed and effective business intelligence decisions, you need
to understand how the data on which you base those decisions changes
over time. Web Intelligence allows you to track and display data changes to
help you focus your analysis on key areas and avoid wasting time exploring
irrelevant data.

When you track data changes, you select a particular data refresh as a
reference point. This data is known as the reference data. When you display
the data changes, Web Intelligence places your current data in context by
showing how it relates to the reference data.

Here are some examples of the usefulness of data tracking:

• If an outlet no longer appears in a list of the top outlets by sales, Web
Intelligence displays the outlet as deleted from the list. You can use this
information to investigate why the outlet is no longer a top performer.

• If sales have decreased in a region, data tracking displays the decrease.
You can then drill down into the data for the region to understand why
revenue is falling.

In both these cases, data tracking makes the current data more meaningful
by placing it in context with old data. Without this context it is much more
difficult to identify trends.

Types of data change
Web Intelligence allows you to track the following types of data change:

• added data
• removed data
• modified data
• increased data
• decreased data

You configure the display of these changes through the Web Intelligence
interface or the Web Intelligence formula language. The formula language
provides advanced users with additional power and flexibility in displaying
and formatting changed data.
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Data tracking modes

Automatic data tracking mode

In automatic data tracking mode, Web Intelligence always compares the
current data with the data before the last refresh. To do this, Web Intelligence
sets the current data as the reference data just before each refresh. The
reference data is always one refresh behind the current data.

Automatic data tracking is appropriate for scheduled documents when you
want to compare the current data with the data before the last refresh.

Manual data tracking mode

In manual data tracking mode, you select the reference data. Web Intelligence
continues to use this data as a reference point until you update the reference
point.

To activate data tracking
1. Click Track on the main toolbar to display the "Activate Data Tracking"

dialog box.
2. Select options in the dialog box.

DescriptionOption

The current data becomes the reference data
after each data refresh. The report always
shows the difference between the most re-
cent data and the data before the last refresh.

Auto-update the reference
data with each data refresh

The current data becomes the fixed reference
data and remains the reference data after
further data refreshes. The report always
shows the difference between the most re-
cent data and this fixed reference data.

Use the current data as ref-
erence data

3. Click "Refresh Now" to refresh the data when the dialog box closes.
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4. Click OK

To change the reference data
1. Click Data Tracking Options on the main toolbar, or click the

Auto-update/Fixed Data hyperlink in the status bar to display the "Data
Tracking Options" dialog box.

2. Select the Reference Data tab.
3. Select options.

DescriptionOption

The current data becomes the reference data
after each data refresh. The report always
shows the difference between the most re-
cent data and the data before the last refresh.

Auto-update the reference
data with each data refresh

The data you select becomes the fixed refer-
ence data and remains the reference data
after further data refreshes. The report al-
ways shows the difference between the most
recent data and this fixed reference data.

Use fixed reference data
from

Displaying changed data

To display or hide changed data

• Click Hide Changes/Show Changes (the button tooltip text varies
depending on whether changed data is currently visible) to the right of
Track on the main menu.

Configuring the appearance of changed data

You can configure the appearance (font style, size and color) of changed
data in your document. You can seperately configure the appearance of the
following changes:

• Inserted, deleted and changed dimension and detail values
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• Increased or decreased measure values

Measure values can also adopt the formatting of inserted or deleted
dimension values. For example, if a dimension value disappears from a list
of values in a block, and the block also shows a measure value for the
dimension, both the dimension and measure values appear as deleted data.

Your Business Objects administrator defines the default appearance of
changed data in the Central Management Server. When you configure the
appearance of changed data in Web Intelligence, you override the CMS
defaults.

To configure the appearance of changed data

1. Click Data Tracking Options on the main toolbar to display the "Data
Tracking Options" dialog box.

2. Select the Format tab.
3. Select each type of changed data you wish to display and click "Format"

to specify how you want the changes to appear.

How changed data is displayed in blocks

Example: Changed data in a simple block

This example uses a document with a block showing [Country], [Year] and
[Revenue]. The original data was as follows:

RevenueYearCountry

10002003France

20002004France

10002002Japan

12002002Poland

After a refresh, the data is as follows:

Building Reports with Web Intelligence Rich Client 291

26Tracking changes in data
Displaying changed data



RevenueYearCountry

30002004France

9002003Japan

8002002Poland

9002004UK

When data tracking is activated and data changes displayed, the block
appears as follows:

FormattingRevenueYearCountry

[deleted data format-
ting on all cells]10002003France

[increased data format-
ting on Revenue cell]30002004France

[deleted data format-
ting on all cells]10002002Japan

[inserted data format-
ting on all cells]9002003Japan

[decreased data format-
ting on Revenue cell]8002002Poland

[inserted data format-
ting on all cells]9002004UK

• The rows showing revenue for France in 2003 and Japan in 2002 represent
data that no longers exist after the refresh.

• The revenue for France in 2004 has increased.
• The revenue for Poland in 2002 has decreased.
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• The rows showing revenue for Japan in 2003 and the UK in 2004 appeared
after the refresh.

How changed data is displayed in reports with
merged dimensions

Web Intelligence displays a dimension as changed only if all the dimensions
that participate in the merge are changed.

Example: Changed data and merged dimensions

In this example, Country is a merged dimension containing the Country
dimensions from two data providers. Before data refresh, the data is as
follows:

Sales (DP2)Country (DP2)Revenue (DP1)Country (DP1)

5000US10000US

4000France

3000UK5000UK

1000Germany1000Germany

After a data refresh, the data becomes:

Sales (DP2)Country (DP2)Revenue (DP1)Country (DP1)

4000US10000US

3000France4000France

4000UK6000UK

2000Poland
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When displayed in a block with the merged Country dimension and data
changes displayed, the data appears as follows:

FormattingSalesRevenueCountry

[decreased data format-
ting on Sales cell]400010000US

[inserted data format-
ting on Revenue cell]30004000France

[increased data format-
ting on Revenue and
Sales cells]

40006000UK

[deleted data format-
ting on all cells]10001000Germany

[inserted data format-
ting on Country and
Revenue cells]

2000Poland

In the France row, France does not appear as inserted because a France
row was not inserted in both data providers. Revenue appears as inserted
because it is a new measure value after the data refresh.

In the Poland row, Poland appears as inserted because it is a new
dimension value after the data refresh.

How changed data is displayed in sections

Example: Changed data in a report with sections

In this example you have a document with a block showing [Country], [Year]
and [Revenue]. The original data was as follows:
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RevenueYearCountry

10002003France

20002004France

10002002Japan

12002002Poland

2003US

2004US

After a refresh, the data is as follows:

RevenueYearCountry

30002004France

9002003Japan

8002002Poland

9002004UK

If you create a section on [Country] and display data changes, the report
appears as follows:

France [no formatting]

FormattingRevenueYear

[deleted data formatting on all
cells]10002003
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FormattingRevenueYear

[increased data formatting on
Revenue cell]30002004

Japan [no formatting]

FormattingRevenueYear

[deleted data formatting
on all cells]10002002

[inserted data formatting
on all cells]9002003

Poland [no formatting]

FormattingRevenueYear

[decreased data format-
ting on Revenue cell]8002002

UK [inserted data formatting]

FormattingRevenueYear

[inserted data formatting
on all cells]9002004

Web Intelligence displays the data in the section header in either of two ways,
depending on the changes in the data in the section:

• If all the rows in the block in the section have changed in the same way,
the section header is displayed with the same formatting as the rows.
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• If the rows have changed in different ways, or only some rows have
changed, the section header retains its default format.

Howchangeddata is displayed in blockswith breaks

When a block contains a break and the Center value across break block
property is set, Web Intelligence displays the centered value according rules
similar to those for section headers.

• If all the rows in the break have changed in the same way, the centered
value is displayed with the same formatting as the rows.

• If the rows have changed in different ways, or only some rows have
changed, the centered value retains the default formatting.

How changed data is displayed in charts

When the data in a chart has changed, Web Intelligence displays a changed
data icon above the chart. When you click the icon, Web Intelligence changes
the chart to a table to allow you to see the details of the changes.

Data tracking limitations
If the data provider behind a document is changed, or if the document data
is cleared, Web Intelligence no longer displays changed data. If the data
provider is changed, the current version of the document is no longer
compatible with the reference version. If the data is cleared, the old data no
longer exists for comparison.

As a result, the following actions are incompatible with data tracking:

• Drill out of scope
• Query drill
• Deleting a query
• Any modification (including modifications to security rights) that changes

the SQL generated by a data provider
• Purging the document

When you perform any of these actions, Web Intelligence clears the data
history of the document. It does so because these actions are incompatible
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with the display of changed data. For example, if you modify a query, the
data in the document changes because of the modification. Any comparison
between this data and old data generated from a different query is misleading.

Data tracking and drill

When you use query drill or drill out of scope, Web Intelligence clears the
data history because these actions change the data provider. This should
not affect you because, when you start to drill, you have already identified
the data that requires further analysis. Data tracking has served its purpose
and you can now continue with your data analysis.

Data tracking and Refresh on Open

When a document is set to refresh its data on opening (when the Refresh
on open document property is selected), data tracking does not display the
difference between the data prior to the refresh and the data after the refresh.
Web Intelligence treats the data after the refresh as new data because the
refresh purges the document.

Using the Web Intelligence formula
language to track changed data

When you use the Web Intelligence interface to configure the display of
changed data, Web Intelligence builds special behind-the-scenes alerters
to display the changes. These special alerters do not appear in the list of
standard alerters.

The Web Intelligence formula language allows you to build your own custom
alerters for formatting data changes. You can also use the formula language
to include special calculations based on data changes. For example, you
can include a calculation to show the difference between the previous value
and the current value of a measure.
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The RefValue function

The Web Intelligence formula language provides access to changed data
throught the RefValue function. This function gives the value of the reference
data for a measure. If there is no reference data, the function returns null.

For example, if the [Revenue] measure currently has the value 1000, and
its reference value is 900, the formula RefValue([Revenue]) returns 900.

The RefValueDate function

The RefValueDate function returns the date of the reference data used for
data tracking.

Building formulas using the RefValue function

You can use the RefValue function to build formulas that give information
about the current data in relation to the reference data.

Example: Finding the difference between the reference value and the
current value

The following formula returns the difference between the reference value
and the current value of the [Revenue] measure:

=If(Not(IsNull([Revenue])) Or Not (IsNull(RefValue([Rev
enue]))); [Revenue]-RefValue([Revenue]))

The following table shows data before a data refresh:

RevenueCustomer

2000Johnson

3000Smith
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RevenueCustomer

3500Wilson

After refresh, the data changes as follows:

RevenueCustomer

3000Johnson

2500Smith

Placed in a third column, the formula returns the following figures:

DifferenceRevenueCustomer

10003000Johnson

-5002500Smith

3500Wilson

Changeddata and the calculation context
When data tracking is activated, Web Intelligence displays data as changed
only when the calculation context remains the same.

For example, if a measure value changes because you change the calculation
context of a block, the new value is not flagged as changed.
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Example: Changing the calculation context

In this example you have a block showing [City], [Customer] and [Revenue]
as follows:

RevenueCustomerCity

1000SmithSan Francisco

2000JonesSan Francisco

3000WilsonLos Angeles

4000HarrisLos Angeles

If you remove [Customer] from the block, Web Intelligence aggregates
revenue by city:

CustomerCity

3000San Francisco

7000Los Angeles

Web Intelligence does not display the revenues as increased because the
amount of revenue has not changed. Only the calculation context has
changed - revenues are now aggregated by city only, giving higher figures.

If, after a data refresh, Jones’ revenue falls to 1000 and Wilson’s revenue
rises to 4000, the data appears as follows:

CustomerCity

2000San Francisco

8000Los Angeles
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Web Intelligence now displays the data as changed because, independently
of the change of calculation context, the total revenue for San Francisco
has decreased and the total revenue for Los Angeles has increased.
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Publishing Web Intelligence content as
web services

You can make Web Intelligence content available outside Web Intelligence
documents by publishing Web Intelligence report blocks (tables, charts or
forms) as web services known as BI Services.

Web services provide a standardized mechanism for sharing data between
web-based applications. You publish Web Intelligence content to a server
where other Web applications can access the web services that supply the
content.

Each web service can publish multiple blocks which are made available to
web applications through functions that correspond to the blocks. For
example, a table published as a web service can be included in a dashboard
which can perform filtering and drilling operations on the table through the
web service functions.

The structure of a BI service is defined using using WSDL (Web Service
Definition Language), the standard format for describing web serivces. Web
applications interact with BI services (by passing parameters to them and
receiving data in return) using SOAP, a standard protocol for exchanging
structured information.

Related Topics
• BI service structure on page 311

To publish aWeb Intelligence report block as a web
service

You use the Publish Content wizard to publish a Web Intelligence report
block as a Web service.
1. Select the table, chart or form you want to publish, right-click and select

Publish Block to display the Publish Content wizard.
2. Click Next to move to the first publishing step.

Related Topics
• To identify duplicate content on page 305
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To identify duplicate content

If the report block you are publishing as a web service has already been
published, the Identify Duplicate Content screen of the Publish Content
highlights the duplicated blocks. The duplicate block appears in bold beneath
the web services that publish it.

• Click Next to move to the next step.

Related Topics
• To define the web service on page 305

To define the web service

Before publishing a block as a Web service, you use the Define Published
Content screen in the Publish Content wizard to name the table, make
filters available on the block data, and select the server where the block will
be published.

1. Type the name and description under which you want to publish the table
in the Name and Description boxes.

2. Click Set Filters and select the objects you want to make available for
filtering in the web service.

3. Select the server where you want to publish the content beneath Host
server.

4. To add, remove or edit servers in the list of host servers, click Manage
servers, then click Add, Edit or Remove and update the list of servers.

5. Click Next to move to the next step.

Related Topics
• To publish prompts on page 307
• To save and publish a web service on page 307

Making data available for filtering in a web service

When you publish a report block as a web service, you can make report
objects available that web applications can use to filter the data returned by
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the web service. For example, if you publish a table containing [Country],
[Region] and [Revenue], you can make the [Country] dimension available
as a filter. Web applications accessing the web service can then filter on the
[Country] dimension.

Filtering objects appear as FilterCondition parameters in the GetReport
Block_<block_name> function in the web service.

You make objects available for filtering in the Define published content
screen of the Publish Content wizard. The screen lists all the objects in the
report and selects the objects in the block you are publishing by default. You
can deselect these objects and select any object in the report to make it
available as a filter. For example, you can make the [Country] dimension
available as a filter when you publish a table containing the [Region] and
[Revenue] objects if the [Country] dimension appears in the report. You can
also choose not to make the [Region] and [Revenue] objects available as
filters.

You do not have to include any report objects as filters except for objects
that appear in section headers. These appear selected and you cannot
unselect them.

If you publish a block in a section, by default the web service filters on the
value of the section object corresponding to the block you selected. For
example, if you have a report containing [Country], [Region] and [Revenue]
with [Country] as the section header, and you publish the block in the section
where [Country]="France", the web service uses "France" as the default
value of [Country]. A web application accessing the web service can supply
a different value for [Country] and the data returned by the web service
changes to correspond with the filter.

If you publish a block in a report containing report filters, the objects on which
report filters are defined are selected by default in the screen. You can
unselect these objects. If you publish the block without making the objects
available as filters, the web service filters data according to the values of the
report filters. If you make the objects available, web applications can apply
the report filters using different values.

Related Topics
• GetReportBlock_blockname on page 312
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To publish prompts

1. Select or unselect the prompts you want to include or exclude in the list
of prompts.

2. Click Select all to select all prompts or Clear all to clear all prompts.
3. Click Next to move to the next step.

Publishing prompts in web services

You use the Choose Prompts screen in the Publish Content wizard to
choose which prompts to publish in the web service when the content you
want to publish has related prompts.

If you do not publish a prompt, the web service uses the prompt value
supplied when the document was last refreshed and saved. For example, if
a user answers "US" to a prompt on [Country], then saves the document,
the web service filters data on [Country]="US" the next time it is called with
therefresh=true parameter.

If a web service publishes prompts, web applications must supply values for
the prompts if they call the web service with the refresh=true parameter.

To save and publish a web service

You use the Create Web Service screen in the Publish Content wizard to
save and publish the Web service to a host server.

1. To re-publish an existing web service, select the web service, click
Publish, then click OK to exit the wizard.

2. To publish a new web service, select the folder where you want to publish
the content and click Create to display the Publish Web Service dialog
box.

Note:
Click Add Folder to add a new folder.

3. Type the name of the web service in the Web service name box and the
service description in the Description box.
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4. Select the authentication method for the web service from the
Authentication list.

5. Click OK to close the dialog box and save and publish the web service.
6. Click Finish.

Viewing and managing published Web
Intelligence content

You can browse the Web Intelligence content published on different Web
servers by using the Web Service Publisher pane in Web Intelligence. The
Web Service Publisher pane also allows you to edit published Web services
and import QaaWS (Query as a Web Service) queries, which you can then
republish as Web Intelligence content.

To view and manage published content

1. Display the Web Service Publisher pane by selecting Show Published
Content on the main toolbar.

2. Select the server from the Host server list.
3. To add, remove or edit servers in the list of host servers, click Manage

servers, then click Add, Edit or Remove and update the list of servers.
4. Select Views and select the way you want the content to be organized

from the menu.
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DescriptionOption

Published content is organized as web service > blockView by web
services

Published content is organized as Web Intelligence doc-
ument > web service > block

View by docu-
ment and web
service

Published content is organized as Web Intelligence doc-
ument > block > web service

View by docu-
ment and block

QaaWS (Query as a Web Service) queries appear below
the published Web Intelligence content. (QaaWS queries
are stored in the same repository folder as BI services.)

Show QaaWS
queries

5. To edit a published block, select the block and click Edit to launch the
Publish Content wizard.

6. To delete published content, select the published block or the Web service
and click Delete.

7. To rename a web service, select the web service, click Rename and type
the new name.

8. To refresh the list of published content, click Refresh.
9. To search the list of web services, type the text you want to search for in

the search box and select your search options from the menu at the left
of the search box.

DescriptionOption

Match case when searchingMatch case

Ignore case when searchingIgnore case

Return only those web services or blocks whose name
starts with the search text

Match from
start

Return only those web services or blocks whose name
contains the search text

Match any-
where

Related Topics
• Importing and converting QaaWS (Query as a Web Service) queries on

page 310
• To publish a Web Intelligence report block as a web service on page 304
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To test published content

You can test published Web Intelligence content and examine the structure
of the Web service that publishes it.

1. Display the Web Service Publisher by selectingShowPublishedContent
on the main toolbar.

2. Select the Web service you want to test and click Test web service.
3. Select the web service function you want to test from the Operation

drop-down list.
4. Select the parameters and operators for which you want to specify values

in the Input pane and type their values on the right of the pane benath
Value.

5. Click Send to call the web service with the values you specified.
The data returned by the web service appears in the Server response
pane.

6. Click Change to tree view/Change to table view to toggle the web
service data between a tree view and table format.

Importing and convertingQaaWS (Query
as a Web Service) queries

You can import QaaWS queries and run them to produce a block that Web
Intelligence inserts in a new report. When you import a QaaWS query, Web
Intelligence builds a Web Intelligence query based on the structure of the
QaaWS query, then runs this query and inserts the resulting block in a new
report. Web Intelligence does not modify the original QaaWS query.

Because Web Intelligence does not support the publication of QaaWS queries
directly, you can use this workflow to publish QaaWS queries as BI services
by publishing the resulting block as a BI service.

Note:
Web Intelligence does not support sorts defined on QaaWS queries. When
you run the QaaWS query, any sorts it contains are lost.
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To publish a QaaWS query

1. Open the Web Service Publisher pane by selecting Show Published
Content on the main toolbar.

2. Select View > Display QaaWS queries to display QaaWS queries.
3. Select the QaaWS query you want to import and click Import QaaWS

query.
Web Intelligence adds the QaaWS query to the document as a Web
Intelligence query. Web Intelligence also adds a report tab with the same
name as the QaaWS query. The report tab contains a table corresponding
to the query objects.

4. Refresh the added query to display the QaaWS data.
5. Right-click the added table and select Publish Block to publish the table

as a web service.

Related Topics
• To publish a Web Intelligence report block as a web service on page 304

BI service structure
External web applications access Web Intelligence content published as web
services by calling two functions:
• GetReportBlock_blockname

• Drill_blockname

In both these function calls, blockname is the name of the block as defined
in the web service.

Web applications use the SOAP protocol to call the functions and receive
the function output which they can then parse.
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GetReportBlock_blockname

Function name

GetReportBlock_blockname

Input parameters

Mandatory?DescriptionName

Yes, unless sessionID or
serializedSession is
specified.

CMS loginlogin

Yes, unless sessionID or
serializedSession is
specified .

CMS passwordpass-
word

Yes when the report block
contains section entries; no
otherwise. Blocks with sec-
tions therefore have a mix of
mandatory and optional re
portfilter parameters.

One or more report filters. See
the table below for more infor-
mation.

reportfil-
ter

Yes when refresh = true and
the prompt is mandatory;
nofalse otherwise.

Prompt values. See below for
more information on LovIn
dexValue parameters

prompt

No - default value is false.Re-opens the document when
the web service is called, reset-
ting drills and filters.

reset-
State

No - default value is false.Forces document refresh.refresh

No - default value is true.Retrieves data from the latest
document instance.

get-
From-
Latest-
Docu-
mentIn-
stance
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Mandatory?DescriptionName

No - default value is false.Retrieves data from user inbox
if the document has been
published.

getFro-
mUserIn-
stance

No - default value is false.Turns the output to a vertical
table.

Note:
If the block is a chart it is al-
ways turned to a vertical table
even if this parameter is set to
false.

turnOut-
put-
ToVTable

No.Session token to avoid submit-
ting login/password. Increases
the session count when submit-
ted.

session-
ID

No.Serialized session to avoid
submitting login/password.
Does not increase the session
count when submitted.

serial-
ized-
Ses-
sion

reportfilter parameter

reportfilter paremeters contain two elements:
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ValuesDescriptionName

AnyThe value used
to filter the data

filter-
ing_value

EQUAL (default)¦ GREATER ¦
GREATER_OR_EQUAL ¦ LESS ¦
LESS_OR_EQUAL ¦ NOT_EQUAL ¦ INLIST ¦
NOT_INLIST

The filter opera-
tor

filtering_op-
erator

Example of reportFilter parameter

The filter [Country]="US" is specified as follows:

<Country>
<value>US</value>
<operator>EQUAL</operator>

</Country>

Output parameters

DescriptionTypeName

Table cellsTTabletable

Table headersTHeaderheaders

Table footersTFooterfooters

Login used by the web service callstringuser

The web service description supplied by the
service designer

stringdocumentation

The document namestringdocumentname

The date of the last document refreshdateTimelastrefreshdate

The date the web service was createddateTimecreationdate

User name of the web service creatorstringcreator

Specifies if document is scheduledbooleanisScheduled

The schedule start time if the document is
scheduled

dateTimescheduleStart-
Time
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DescriptionTypeName

The schedule end time if the document is
scheduled

dateTimescheduleEnd-
Time

The table typestringtableType

The number of columns in the output tableintnbColumns

The number of rows in the output tableintnbLines

Related Topics
• Drill_blockname on page 315
• Sample BI service return data on page 319

Drill_blockname

Function name

Drill_blockname

Input parameters

The syntax of the Drill_<block_name> function is similar to GetReport
Block_<block_name>, with the following differences:
• there are no reportfilter parameters
• there are additional drillpath parameters
• there is an additional drillfilter parameters

Mandatory?DescriptionName

YesSpecifies a drill instructiondrillpath

NoSpecifies a filter to apply when
drilling

drillfilter

drillpath parameter

drillpath parameters are of type DrillPath. They contain three elements:

Building Reports with Web Intelligence Rich Client 315

27Sharing Web Intelligence content with other Web applications
BI service structure



ValuesDescriptionName

Any.The dimension to drillfrom

AnyThe value to drill onvalue

UP ¦ DOWNThe type of drill operationdrilloperation

Note:
• As well as single values (for example "Los Angeles"), value can pass

definitions such as "All Cities".
• If the drill instruction is invalid, the web service returns the original table

data.
• At the end of the drill hierarchy, the web services returns the last available

values in the drill hierarchy.
• You can supply more than one drillpath parameter providing that the

parameters do not refer to different levels in the same drill hierarchy.

drillfilter parameter

drillpath parameters allow you to apply drill filters at the same time as drilling:

ValuesDescriptionName

Any.The dimen-
sion to filter

dimension

AnyThe value to
filter on

value

EQUAL ¦ GREATER ¦ GREATER_OR_EQUAL ¦
LESS ¦ LESS_OR_EQUAL ¦ NOT_EQUAL ¦ INLIST
¦ NOT_INLIST

The filter op-
erator

operator

Note:
• As well as single values (for example "Los Angeles"), value can pass

definitions such as "All Cities"
• If the drill instruction is invalid, the web service returns the original table

data
• At the end of the drill hierarchy, the web services returns the last available

values in the drill hierarchy
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• You can supply more than one drillpath parameter providing that the
parameters do not refer to different levels in the same drill hierarchy.

Related Topics
• GetReportBlock_blockname on page 312

BI Services output parameters

The following table lists the output parameters returned by a BI Service:

DescriptionTypeName

Table cellsTTabletable

Table headersTHeaderheaders

Table footersTFooterfooters

Login used by the web service callstringuser

The web service description supplied by the
service designer

stringdocumentation

The document namestringdocumentname

The date of the last document refreshdateTimelastrefreshdate

The date the web service was createddateTimecreationdate

User name of the web service creatorstringcreator

Specifies if document is scheduledbooleanisScheduled

The schedule start time if the document is
scheduled

dateTimescheduleStart-
Time

The schedule end time if the document is
scheduled

dateTimescheduleEnd-
Time
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DescriptionTypeName

The table typestringtableType

The number of columns in the output tableintnbColumns

The number of rows in the output tableintnbLines

Example of table parameter

<table>
<row>

<cell xsi:type="xsd:string">Australia</cell>
<cell xsi:type="xsd:string">Accommodation</cell>

<cell xsi:type="xsd:string">Bungalow</cell>
<cell xsi:type="xsd:double">172980</cell>

</row>
<row>

<cell xsi:type="xsd:string">Australia</cell>
<cell xsi:type="xsd:string">Accommodation</cell>

<cell xsi:type="xsd:string">Hotel Room</cell>
<cell xsi:type="xsd:double">345510</cell>

</row>
...
</table>

Example of headers parameter

<headers>
<row>

<cell xsi:type="xsd:string">Country</cell>
<cell xsi:type="xsd:string">Service Line</cell>

<cell xsi:type="xsd:string">Service</cell>
<cell xsi:type="xsd:string">Revenue</cell>

</row>
</headers>

Example of footers parameter

???

Related Topics
• Sample BI service return data on page 319
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Sample BI service return data

Web services return data using SOAP. The following is a sample SOAP file
returned by a web service:

<soap:Envelope xmlns:xsi="http://www.w3.org/2001/XMLSchema-in
stance...>

<soap:Body>
<GetReportBlock_Block1BeachResponse xmlns="multidocmul

tiuniversesmultime">
<table>

<row>
<cell xsi:type="xsd:string">Australia</cell>

<cell xsi:type="xsd:string">Accommodation</cell>

<cell xsi:type="xsd:string">Bungalow</cell>
<cell xsi:type="xsd:double">172980</cell>

</row>
<row>

<cell xsi:type="xsd:string">Australia</cell>
<cell xsi:type="xsd:string">Accommodation</cell>

<cell xsi:type="xsd:string">Hotel Room</cell>
<cell xsi:type="xsd:double">345510</cell>

</row>
<row>

<cell xsi:type="xsd:string">Australia</cell>
<cell xsi:type="xsd:string">Accommodation</cell>

<cell xsi:type="xsd:string">Hotel Suite</cell>
<cell xsi:type="xsd:double">464850</cell>

</row>
<row>

<cell xsi:type="xsd:string">Australia</cell>
<cell xsi:type="xsd:string">Food &amp;

Drinks</cell>
<cell xsi:type="xsd:string">Fast Food</cell>
<cell xsi:type="xsd:double">19530</cell>

</row>
<row>

<cell xsi:type="xsd:string">Australia</cell>
<cell xsi:type="xsd:string">Food &amp;

Drinks</cell>
<cell xsi:type="xsd:string">Poolside Bar</cell>

<cell xsi:type="xsd:double">27073</cell>
</row>
<row>

<cell xsi:type="xsd:string">Australia</cell>
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<cell xsi:type="xsd:string">Food &amp;
Drinks</cell>

<cell xsi:type="xsd:string">Restaurant</cell>
<cell xsi:type="xsd:double">41160</cell>

</row>
<row>

<cell xsi:type="xsd:string">Australia</cell>
<cell xsi:type="xsd:string">Recreation</cell>
<cell xsi:type="xsd:string">Activities</cell>
<cell xsi:type="xsd:double">59820</cell>

</row>
<row>

<cell xsi:type="xsd:string">Australia</cell>
<cell xsi:type="xsd:string">Recreation</cell>
<cell xsi:type="xsd:string">Excursion</cell>
<cell xsi:type="xsd:double">113170</cell>

</row>
<row>

<cell xsi:type="xsd:string">Australia</cell>
<cell xsi:type="xsd:string">Recreation</cell>
<cell xsi:type="xsd:string">Sports</cell>
<cell xsi:type="xsd:double">69575</cell>

</row>
<row>

<cell xsi:type="xsd:string">Australia</cell>
<cell xsi:type="xsd:string">Travels</cell>
<cell xsi:type="xsd:string">Car Rent</cell>
<cell xsi:type="xsd:double">49160</cell>

</row>
<row>

<cell xsi:type="xsd:string">Australia</cell>
<cell xsi:type="xsd:string">Travels</cell>
<cell xsi:type="xsd:string">Travel Reserva

tion</cell>
<cell xsi:type="xsd:double">63300</cell>

</row>
<row>

<cell xsi:type="xsd:string">France</cell>
<cell xsi:type="xsd:string">Accommodation</cell>

<cell xsi:type="xsd:string">Bungalow</cell>
<cell xsi:type="xsd:double">126240</cell>

</row>
<row>

<cell xsi:type="xsd:string">France</cell>
<cell xsi:type="xsd:string">Accommodation</cell>

<cell xsi:type="xsd:string">Hotel Room</cell>
<cell xsi:type="xsd:double">116790</cell>

</row>
<row>

<cell xsi:type="xsd:string">France</cell>
<cell xsi:type="xsd:string">Accommodation</cell>
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<cell xsi:type="xsd:string">Hotel Suite</cell>
<cell xsi:type="xsd:double">320220</cell>

</row>
<row>

<cell xsi:type="xsd:string">France</cell>
<cell xsi:type="xsd:string">Food &amp;

Drinks</cell>
<cell xsi:type="xsd:string">Fast Food</cell>
<cell xsi:type="xsd:double">28440</cell>

</row>
<row>

<cell xsi:type="xsd:string">France</cell>
<cell xsi:type="xsd:string">Food &amp;

Drinks</cell>
<cell xsi:type="xsd:string">Poolside Bar</cell>

<cell xsi:type="xsd:double">46320</cell>
</row>
<row>

<cell xsi:type="xsd:string">France</cell>
<cell xsi:type="xsd:string">Food &amp;

Drinks</cell>
<cell xsi:type="xsd:string">Restaurant</cell>
<cell xsi:type="xsd:double">32640</cell>

</row>
<row>

<cell xsi:type="xsd:string">France</cell>
<cell xsi:type="xsd:string">Recreation</cell>
<cell xsi:type="xsd:string">Activities</cell>
<cell xsi:type="xsd:double">9000</cell>

</row>
<row>

<cell xsi:type="xsd:string">France</cell>
<cell xsi:type="xsd:string">Recreation</cell>
<cell xsi:type="xsd:string">Excursion</cell>
<cell xsi:type="xsd:double">120050</cell>

</row>
<row>

<cell xsi:type="xsd:string">France</cell>
<cell xsi:type="xsd:string">Recreation</cell>
<cell xsi:type="xsd:string">Sports</cell>
<cell xsi:type="xsd:double">35720</cell>

</row>
<row>

<cell xsi:type="xsd:string">Nepal</cell>
<cell xsi:type="xsd:string">Accommodation</cell>

<cell xsi:type="xsd:string">Bungalow</cell>
<cell xsi:type="xsd:double">323231</cell>

</row>
<row>

<cell xsi:type="xsd:string">Nepal</cell>
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<cell xsi:type="xsd:string">Accommodation</cell>

<cell xsi:type="xsd:string">Hotel Room</cell>
<cell xsi:type="xsd:double">330240</cell>

</row>
<row>

<cell xsi:type="xsd:string">Nepal</cell>
<cell xsi:type="xsd:string">Accommodation</cell>

<cell xsi:type="xsd:string">Hotel Suite</cell>
<cell xsi:type="xsd:double">320754</cell>

</row>
<row>

<cell xsi:type="xsd:string">Nepal</cell>
<cell xsi:type="xsd:string">Food &amp;

Drinks</cell>
<cell xsi:type="xsd:string">Fast Food</cell>
<cell xsi:type="xsd:double">32960</cell>

</row>
<row>

<cell xsi:type="xsd:string">Nepal</cell>
<cell xsi:type="xsd:string">Food &amp;

Drinks</cell>
<cell xsi:type="xsd:string">Poolside Bar</cell>

<cell xsi:type="xsd:double">37915</cell>
</row>
<row>

<cell xsi:type="xsd:string">Nepal</cell>
<cell xsi:type="xsd:string">Food &amp;

Drinks</cell>
<cell xsi:type="xsd:string">Restaurant</cell>
<cell xsi:type="xsd:double">32980</cell>

</row>
<row>

<cell xsi:type="xsd:string">Nepal</cell>
<cell xsi:type="xsd:string">Recreation</cell>
<cell xsi:type="xsd:string">Activities</cell>
<cell xsi:type="xsd:double">78200</cell>

</row>
<row>

<cell xsi:type="xsd:string">Nepal</cell>
<cell xsi:type="xsd:string">Recreation</cell>
<cell xsi:type="xsd:string">Excursion</cell>
<cell xsi:type="xsd:double">96440</cell>

</row>
<row>

<cell xsi:type="xsd:string">Nepal</cell>
<cell xsi:type="xsd:string">Recreation</cell>
<cell xsi:type="xsd:string">Sports</cell>
<cell xsi:type="xsd:double">102720</cell>

</row>
<row>
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<cell xsi:type="xsd:string">Nepal</cell>
<cell xsi:type="xsd:string">Travels</cell>
<cell xsi:type="xsd:string">Car Rent</cell>
<cell xsi:type="xsd:double">56370</cell>

</row>
<row>

<cell xsi:type="xsd:string">Nepal</cell>
<cell xsi:type="xsd:string">Travels</cell>
<cell xsi:type="xsd:string">Travel Reserva

tion</cell>
<cell xsi:type="xsd:double">74495</cell>

</row>
<row>

<cell xsi:type="xsd:string">US</cell>
<cell xsi:type="xsd:string">Accommodation</cell>

<cell xsi:type="xsd:string">Bungalow</cell>
<cell xsi:type="xsd:double">368870</cell>

</row>
<row>

<cell xsi:type="xsd:string">US</cell>
<cell xsi:type="xsd:string">Accommodation</cell>

<cell xsi:type="xsd:string">Hotel Room</cell>
<cell xsi:type="xsd:double">746828</cell>

</row>
<row>

<cell xsi:type="xsd:string">US</cell>
<cell xsi:type="xsd:string">Accommodation</cell>

<cell xsi:type="xsd:string">Hotel Suite</cell>
<cell xsi:type="xsd:double">842046</cell>

</row>
<row>

<cell xsi:type="xsd:string">US</cell>
<cell xsi:type="xsd:string">Food &amp;

Drinks</cell>
<cell xsi:type="xsd:string">Fast Food</cell>
<cell xsi:type="xsd:double">66330</cell>

</row>
<row>

<cell xsi:type="xsd:string">US</cell>
<cell xsi:type="xsd:string">Food &amp;

Drinks</cell>
<cell xsi:type="xsd:string">Poolside Bar</cell>

<cell xsi:type="xsd:double">88508</cell>
</row>
<row>

<cell xsi:type="xsd:string">US</cell>
<cell xsi:type="xsd:string">Food &amp;

Drinks</cell>
<cell xsi:type="xsd:string">Restaurant</cell>
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<cell xsi:type="xsd:double">331860</cell>
</row>
<row>

<cell xsi:type="xsd:string">US</cell>
<cell xsi:type="xsd:string">Recreation</cell>
<cell xsi:type="xsd:string">Activities</cell>
<cell xsi:type="xsd:double">207950</cell>

</row>
<row>

<cell xsi:type="xsd:string">US</cell>
<cell xsi:type="xsd:string">Recreation</cell>
<cell xsi:type="xsd:string">Excursion</cell>
<cell xsi:type="xsd:double">170305</cell>

</row>
<row>

<cell xsi:type="xsd:string">US</cell>
<cell xsi:type="xsd:string">Recreation</cell>
<cell xsi:type="xsd:string">Sports</cell>
<cell xsi:type="xsd:double">74060</cell>

</row>
<row>

<cell xsi:type="xsd:string">US</cell>
<cell xsi:type="xsd:string">Travels</cell>
<cell xsi:type="xsd:string">Car Rent</cell>
<cell xsi:type="xsd:double">34580</cell>

</row>
<row>

<cell xsi:type="xsd:string">US</cell>
<cell xsi:type="xsd:string">Travels</cell>
<cell xsi:type="xsd:string">Travel Reserva

tion</cell>
<cell xsi:type="xsd:double">43200</cell>

</row>
</table>
<headers>

<row>
<cell xsi:type="xsd:string">Country</cell>
<cell xsi:type="xsd:string">Service Line</cell>

<cell xsi:type="xsd:string">Service</cell>
<cell xsi:type="xsd:string">Revenue</cell>

</row>
</headers>
<footers />
<user>Administrator</user>
<documentation></documentation>
<documentname>_DaaWSDivers1</documentname>
<lastrefreshdate>2009-02-20T14:19:01.0</lastrefresh

date>
<creationdate>2009-02-20T14:43:21.109</creationdate>
<creator>Administrator</creator>
<isScheduled>false</isScheduled>
<tableType>Vertical Table</tableType>
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<nbColumns>4</nbColumns>
<nbLines>42</nbLines>

</GetReportBlock_Block1BeachResponse>
</soap:Body></soap:Envelope>

BI service WSDL definition

<?xml version="1.0" encoding="utf-16"?>
<definitions xmlns:http="http://schemas.xmlsoap.org/wsdl/http/"
xmlns:soap="http://schemas.xmlsoap.org/wsdl/soap/"
xmlns:s="http://www.w3.org/2001/XMLSchema" xmlns:s0="zozo2"
xmlns:tns1="dsws.businessobjects.com" targetNamespace="zozo2"
xmlns="http://schemas.xmlsoap.org/wsdl/" name="BIServices">
<types>

<s:schema elementFormDefault="qualified" targetNames
pace="zozo2">

<s:simpleType name="Operator">
<s:restriction base="s:string">

<s:enumeration value="EQUAL" />
<s:enumeration value="GREATER" />
<s:enumeration value="GREATER_OR_EQUAL" />
<s:enumeration value="LESS" />
<s:enumeration value="LESS_OR_EQUAL" />
<s:enumeration value="NOT_EQUAL" />
<s:enumeration value="INLIST" />
<s:enumeration value="NOT_INLIST" />

</s:restriction>
</s:simpleType>
<s:complexType name="FilterCondition">

<s:sequence>
<s:element name="value" type="s:string" />
<s:element name="operator" type="s0:Operator"

/>
</s:sequence>

</s:complexType>
<s:complexType name="LovValueIndex">

<s:sequence>
<s:element name="valueofPrompt" type="s:string"

/>
<s:element name="index" type="s:string" />

</s:sequence>
</s:complexType>
<s:complexType name="DrillFilter">

<s:sequence>
<s:element name="dimension" type="s:string" />
<s:element name="value" type="s:string" />
<s:element name="operator" type="s0:Operator"

/>
</s:sequence>
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</s:complexType>
<s:element name="GetReportBlock_Block1">

<s:complexType>
<s:sequence>

<s:element name="login" type="s:string"
minOccurs="0" nillable="true" />

<s:element name="password" type="s:string"
minOccurs="0" nillable="true" />

<s:element name="Country" type="s0:FilterCon
dition" />

<s:element name="Resort" type="s0:FilterCon
dition" minOccurs="0" maxOccurs="unbounded" nillable="true" />

<s:element name="Service_Line" type="s0:Fil
terCondition" minOccurs="0" maxOccurs="unbounded" nill
able="true" />

<s:element name="Revenue" type="s0:FilterCon
dition" minOccurs="0" maxOccurs="unbounded" nillable="true" />

<s:element name="Enter_value_s__for_Country_"
type="s0:LovValueIndex" minOccurs="0" maxOccurs="unbounded"
nillable="true" />

<s:element name="resetState" type="s:boolean"
minOccurs="0" nillable="true" />

<s:element name="refresh" type="s:boolean"
minOccurs="0" nillable="true" />

<s:element name="getFromLatestDocumentIn
stance" type="s:boolean" minOccurs="0" nillable="true" />

<s:element name="getFromUserInstance"
type="s:boolean" minOccurs="0" nillable="true" />

<s:element name="turnOutputToVTable"
type="s:boolean" minOccurs="0" nillable="true" />

</s:sequence>
</s:complexType>

</s:element>
<s:element name="GetReportBlock_Block1ff">

<s:complexType>
<s:sequence>

<s:element name="login" type="s:string"
minOccurs="0" nillable="true" />

<s:element name="password" type="s:string"
minOccurs="0" nillable="true" />

<s:element name="Country" type="s0:FilterCon
dition" minOccurs="0" maxOccurs="unbounded" nillable="true" />

<s:element name="Resort" type="s0:FilterCon
dition" minOccurs="0" maxOccurs="unbounded" nillable="true" />

<s:element name="Service_Line" type="s0:Fil
terCondition" minOccurs="0" maxOccurs="unbounded" nill
able="true" />

<s:element name="Revenue" type="s0:FilterCon
dition" minOccurs="0" maxOccurs="unbounded" nillable="true" />
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<s:element name="Enter_value_s__for_Country_"
type="s0:LovValueIndex" minOccurs="0" maxOccurs="unbounded"
nillable="true" />

<s:element name="resetState" type="s:boolean"
minOccurs="0" nillable="true" />

<s:element name="refresh" type="s:boolean"
minOccurs="0" nillable="true" />

<s:element name="getFromLatestDocumentIn
stance" type="s:boolean" minOccurs="0" nillable="true" />

<s:element name="getFromUserInstance"
type="s:boolean" minOccurs="0" nillable="true" />

<s:element name="turnOutputToVTable"
type="s:boolean" minOccurs="0" nillable="true" />

</s:sequence>
</s:complexType>

</s:element>
<s:element name="GetReportBlock_Bloc1">

<s:complexType>
<s:sequence>

<s:element name="login" type="s:string"
minOccurs="0" nillable="true" />

<s:element name="password" type="s:string"
minOccurs="0" nillable="true" />

<s:element name="State" type="s0:FilterCondi
tion" minOccurs="0" maxOccurs="unbounded" nillable="true" />

<s:element name="City" type="s0:FilterCondi
tion" minOccurs="0" maxOccurs="unbounded" nillable="true" />

<s:element name="Sales_revenue"
type="s0:FilterCondition" minOccurs="0" maxOccurs="unbounded"
nillable="true" />

<s:element name="resetState" type="s:boolean"
minOccurs="0" nillable="true" />

<s:element name="refresh" type="s:boolean"
minOccurs="0" nillable="true" />

<s:element name="getFromLatestDocumentIn
stance" type="s:boolean" minOccurs="0" nillable="true" />

<s:element name="getFromUserInstance"
type="s:boolean" minOccurs="0" nillable="true" />

<s:element name="turnOutputToVTable"
type="s:boolean" minOccurs="0" nillable="true" />

</s:sequence>
</s:complexType>

</s:element>
<s:simpleType name="DrillOperation">

<s:restriction base="s:string">
<s:enumeration value="UP" />
<s:enumeration value="DOWN" />

</s:restriction>
</s:simpleType>
<s:complexType name="DrillPath">

<s:sequence>
<s:element name="from" type="s:string" />
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<s:element name="value" type="s:string" />
<s:element name="drillOperation"

type="s0:DrillOperation" />
</s:sequence>

</s:complexType>
<s:element name="Drill_Block1">

<s:complexType>
<s:sequence>

<s:element name="login" type="s:string"
minOccurs="0" nillable="true" />

<s:element name="password" type="s:string"
minOccurs="0" nillable="true" />

<s:element name="drillPath" type="s0:Drill
Path" minOccurs="0" maxOccurs="unbounded" nillable="true" />

<s:element name="filter" type="s0:DrillFilter"
minOccurs="0" maxOccurs="unbounded" nillable="true" />

<s:element name="Enter_value_s__for_Country_"
type="s0:LovValueIndex" minOccurs="0" maxOccurs="unbounded"
nillable="true" />

<s:element name="resetState" type="s:boolean"
minOccurs="0" nillable="true" />

<s:element name="refresh" type="s:boolean"
minOccurs="0" nillable="true" />

<s:element name="getFromLatestDocumentIn
stance" type="s:boolean" minOccurs="0" nillable="true" />

<s:element name="getFromUserInstance"
type="s:boolean" minOccurs="0" nillable="true" />

<s:element name="turnOutputToVTable"
type="s:boolean" minOccurs="0" nillable="true" />

</s:sequence>
</s:complexType>

</s:element>
<s:element name="Drill_Block1ff">

<s:complexType>
<s:sequence>

<s:element name="login" type="s:string"
minOccurs="0" nillable="true" />

<s:element name="password" type="s:string"
minOccurs="0" nillable="true" />

<s:element name="drillPath" type="s0:Drill
Path" minOccurs="0" maxOccurs="unbounded" nillable="true" />

<s:element name="filter" type="s0:DrillFilter"
minOccurs="0" maxOccurs="unbounded" nillable="true" />

<s:element name="Enter_value_s__for_Country_"
type="s0:LovValueIndex" minOccurs="0" maxOccurs="unbounded"
nillable="true" />

<s:element name="resetState" type="s:boolean"
minOccurs="0" nillable="true" />

<s:element name="refresh" type="s:boolean"
minOccurs="0" nillable="true" />

<s:element name="getFromLatestDocumentIn
stance" type="s:boolean" minOccurs="0" nillable="true" />

<s:element name="getFromUserInstance"
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type="s:boolean" minOccurs="0" nillable="true" />
<s:element name="turnOutputToVTable"

type="s:boolean" minOccurs="0" nillable="true" />
</s:sequence>

</s:complexType>
</s:element>
<s:element name="Drill_Bloc1">

<s:complexType>
<s:sequence>

<s:element name="login" type="s:string"
minOccurs="0" nillable="true" />

<s:element name="password" type="s:string"
minOccurs="0" nillable="true" />

<s:element name="drillPath" type="s0:Drill
Path" minOccurs="0" maxOccurs="unbounded" nillable="true" />

<s:element name="filter" type="s0:DrillFilter"
minOccurs="0" maxOccurs="unbounded" nillable="true" />

<s:element name="resetState" type="s:boolean"
minOccurs="0" nillable="true" />

<s:element name="refresh" type="s:boolean"
minOccurs="0" nillable="true" />

<s:element name="getFromLatestDocumentIn
stance" type="s:boolean" minOccurs="0" nillable="true" />

<s:element name="getFromUserInstance"
type="s:boolean" minOccurs="0" nillable="true" />

<s:element name="turnOutputToVTable"
type="s:boolean" minOccurs="0" nillable="true" />

</s:sequence>
</s:complexType>

</s:element>
<s:complexType name="TRow">

<s:sequence>
<s:element name="cell" type="s:anyType" maxOc

curs="unbounded" nillable="true" />
</s:sequence>

</s:complexType>
<s:complexType name="TTable">

<s:sequence>
<s:element name="row" maxOccurs="unbounded"

type="s0:TRow" />
</s:sequence>

</s:complexType>
<s:complexType name="THeader">

<s:sequence>
<s:element name="row" maxOccurs="unbounded"

type="s0:TRow" />
</s:sequence>

</s:complexType>
<s:complexType name="TFooter">

<s:sequence>
<s:element name="row" maxOccurs="unbounded"

type="s0:TRow" />
</s:sequence>
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</s:complexType>
<s:element name="GetReportBlock_Block1Response">

<s:complexType>
<s:sequence>

<s:element name="table" type="s0:TTable" />
<s:element name="headers" type="s0:THeader"

/>
<s:element name="footers" type="s0:TFooter"

/>
<s:element name="user" type="s:string" />
<s:element name="documentation"

type="s:string" />
<s:element name="documentname" type="s:string"

/>
<s:element name="lastrefreshdate"

type="s:dateTime" />
<s:element name="creationdate" type="s:date

Time" />
<s:element name="creator" type="s:string" />

<s:element name="isScheduled" type="s:boolean"
/>

<s:element name="scheduleStartTime"
type="s:dateTime" />

<s:element name="scheduleEndTime"
type="s:dateTime" />

<s:element name="tableType" type="s:string"
/>

<s:element name="nbColumns" type="s:int" />
<s:element name="nbLines" type="s:int" />

</s:sequence>
</s:complexType>

</s:element>
<s:element name="Drill_Block1Response">

<s:complexType>
<s:sequence>

<s:element name="table" type="s0:TTable" />
<s:element name="headers" type="s0:THeader"

/>
<s:element name="footers" type="s0:TFooter"

/>
<s:element name="user" type="s:string" />
<s:element name="documentation"

type="s:string" />
<s:element name="documentname" type="s:string"

/>
<s:element name="lastrefreshdate"

type="s:dateTime" />
<s:element name="creationdate" type="s:date

Time" />
<s:element name="creator" type="s:string" />

<s:element name="isScheduled" type="s:boolean"
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/>
<s:element name="scheduleStartTime"

type="s:dateTime" />
<s:element name="scheduleEndTime"

type="s:dateTime" />
<s:element name="tableType" type="s:string"

/>
<s:element name="nbColumns" type="s:int" />
<s:element name="nbLines" type="s:int" />

</s:sequence>
</s:complexType>

</s:element>
<s:element name="GetReportBlock_Block1ffResponse">

<s:complexType>
<s:sequence>

<s:element name="table" type="s0:TTable" />
<s:element name="headers" type="s0:THeader"

/>
<s:element name="footers" type="s0:TFooter"

/>
<s:element name="user" type="s:string" />
<s:element name="documentation"

type="s:string" />
<s:element name="documentname" type="s:string"

/>
<s:element name="lastrefreshdate"

type="s:dateTime" />
<s:element name="creationdate" type="s:date

Time" />
<s:element name="creator" type="s:string" />

<s:element name="isScheduled" type="s:boolean"
/>

<s:element name="scheduleStartTime"
type="s:dateTime" />

<s:element name="scheduleEndTime"
type="s:dateTime" />

<s:element name="tableType" type="s:string"
/>

<s:element name="nbColumns" type="s:int" />
<s:element name="nbLines" type="s:int" />

</s:sequence>
</s:complexType>

</s:element>
<s:element name="Drill_Block1ffResponse">

<s:complexType>
<s:sequence>

<s:element name="table" type="s0:TTable" />
<s:element name="headers" type="s0:THeader"

/>
<s:element name="footers" type="s0:TFooter"

/>
<s:element name="user" type="s:string" />
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<s:element name="documentation"
type="s:string" />

<s:element name="documentname" type="s:string"
/>

<s:element name="lastrefreshdate"
type="s:dateTime" />

<s:element name="creationdate" type="s:date
Time" />

<s:element name="creator" type="s:string" />

<s:element name="isScheduled" type="s:boolean"
/>

<s:element name="scheduleStartTime"
type="s:dateTime" />

<s:element name="scheduleEndTime"
type="s:dateTime" />

<s:element name="tableType" type="s:string"
/>

<s:element name="nbColumns" type="s:int" />
<s:element name="nbLines" type="s:int" />

</s:sequence>
</s:complexType>

</s:element>
<s:element name="GetReportBlock_Bloc1Response">

<s:complexType>
<s:sequence>

<s:element name="table" type="s0:TTable" />
<s:element name="headers" type="s0:THeader"

/>
<s:element name="footers" type="s0:TFooter"

/>
<s:element name="user" type="s:string" />
<s:element name="documentation"

type="s:string" />
<s:element name="documentname" type="s:string"

/>
<s:element name="lastrefreshdate"

type="s:dateTime" />
<s:element name="creationdate" type="s:date

Time" />
<s:element name="creator" type="s:string" />

<s:element name="isScheduled" type="s:boolean"
/>

<s:element name="scheduleStartTime"
type="s:dateTime" />

<s:element name="scheduleEndTime"
type="s:dateTime" />

<s:element name="tableType" type="s:string"
/>

<s:element name="nbColumns" type="s:int" />
<s:element name="nbLines" type="s:int" />

</s:sequence>
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</s:complexType>
</s:element>
<s:element name="Drill_Bloc1Response">

<s:complexType>
<s:sequence>

<s:element name="table" type="s0:TTable" />
<s:element name="headers" type="s0:THeader"

/>
<s:element name="footers" type="s0:TFooter"

/>
<s:element name="user" type="s:string" />
<s:element name="documentation"

type="s:string" />
<s:element name="documentname" type="s:string"

/>
<s:element name="lastrefreshdate"

type="s:dateTime" />
<s:element name="creationdate" type="s:date

Time" />
<s:element name="creator" type="s:string" />

<s:element name="isScheduled" type="s:boolean"
/>

<s:element name="scheduleStartTime"
type="s:dateTime" />

<s:element name="scheduleEndTime"
type="s:dateTime" />

<s:element name="tableType" type="s:string"
/>

<s:element name="nbColumns" type="s:int" />
<s:element name="nbLines" type="s:int" />

</s:sequence>
</s:complexType>

</s:element>
<s:element name="QaaWSHeader">

<s:complexType>
<s:sequence>

<s:element name="sessionID" type="s:string"
minOccurs="0" maxOccurs="1" nillable="true" />

<s:element name="serializedSession"
type="s:string" minOccurs="0" maxOccurs="1" nillable="true" />

</s:sequence>
</s:complexType>

</s:element>
</s:schema>

</types>
<message name="GetReportBlock_Block1SoapIn">

<part name="parameters" element="s0:GetReportBlock_Block1"
/>

<part name="request_header" element="s0:QaaWSHeader" />
</message>
<message name="GetReportBlock_Block1SoapOut">
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<part name="parameters" element="s0:GetReport
Block_Block1Response" />

</message>
<message name="Drill_Block1SoapIn">

<part name="parameters" element="s0:Drill_Block1" />
<part name="request_header" element="s0:QaaWSHeader" />

</message>
<message name="Drill_Block1SoapOut">

<part name="parameters" element="s0:Drill_Block1Response"
/>
</message>
<message name="GetReportBlock_Block1ffSoapIn">

<part name="parameters" element="s0:GetReport
Block_Block1ff" />

<part name="request_header" element="s0:QaaWSHeader" />
</message>
<message name="GetReportBlock_Block1ffSoapOut">

<part name="parameters" element="s0:GetReport
Block_Block1ffResponse" />

</message>
<message name="Drill_Block1ffSoapIn">

<part name="parameters" element="s0:Drill_Block1ff" />
<part name="request_header" element="s0:QaaWSHeader" />

</message>
<message name="Drill_Block1ffSoapOut">

<part name="parameters" element="s0:Drill_Block1ffRe
sponse" />

</message>
<message name="GetReportBlock_Bloc1SoapIn">

<part name="parameters" element="s0:GetReportBlock_Bloc1"
/>

<part name="request_header" element="s0:QaaWSHeader" />
</message>
<message name="GetReportBlock_Bloc1SoapOut">

<part name="parameters" element="s0:GetReportBlock_Bloc1Re
sponse" />

</message>
<message name="Drill_Bloc1SoapIn">

<part name="parameters" element="s0:Drill_Bloc1" />
<part name="request_header" element="s0:QaaWSHeader" />

</message>
<message name="Drill_Bloc1SoapOut">

<part name="parameters" element="s0:Drill_Bloc1Response"
/>
</message>
<portType name="BIServicesSoap">

<operation name="GetReportBlock_Block1">
<documentation />
<input message="s0:GetReportBlock_Block1SoapIn" />
<output message="s0:GetReportBlock_Block1SoapOut" />

</operation>
<operation name="Drill_Block1">

<documentation />
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<input message="s0:Drill_Block1SoapIn" />
<output message="s0:Drill_Block1SoapOut" />

</operation>
<operation name="GetReportBlock_Block1ff">

<documentation />
<input message="s0:GetReportBlock_Block1ffSoapIn" />
<output message="s0:GetReportBlock_Block1ffSoapOut"

/>
</operation>
<operation name="Drill_Block1ff">

<documentation />
<input message="s0:Drill_Block1ffSoapIn" />
<output message="s0:Drill_Block1ffSoapOut" />

</operation>
<operation name="GetReportBlock_Bloc1">

<documentation />
<input message="s0:GetReportBlock_Bloc1SoapIn" />
<output message="s0:GetReportBlock_Bloc1SoapOut" />

</operation>
<operation name="Drill_Bloc1">

<documentation />
<input message="s0:Drill_Bloc1SoapIn" />
<output message="s0:Drill_Bloc1SoapOut" />

</operation>
</portType>
<binding name="BIServicesSoap" type="s0:BIServicesSoap">

<soap:binding transport="http://schemas.xml
soap.org/soap/http" style="document" />

<operation name="GetReportBlock_Block1">
<documentation />
<soap:operation soapAction="zozo2/GetReport

Block_Block1" style="document" />
<input>

<soap:header message="s0:GetReport
Block_Block1SoapIn" part="request_header" use="literal">

<soap:headerfault message="s0:GetReport
Block_Block1SoapIn" part="request_header" use="literal" />

</soap:header>
<soap:body use="literal" parts="parameters" />

</input>
<output>

<soap:body use="literal" />
</output>

</operation>
<operation name="Drill_Block1">

<documentation />
<soap:operation soapAction="zozo2/Drill_Block1"

style="document" />
<input>

<soap:header message="s0:Drill_Block1SoapIn"
part="request_header" use="literal">

<soap:headerfault message="s0:Drill_Block1SoapIn"
part="request_header" use="literal" />
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</soap:header>
<soap:body use="literal" parts="parameters" />

</input>
<output>

<soap:body use="literal" />
</output>

</operation>
<operation name="GetReportBlock_Block1ff">

<documentation />
<soap:operation soapAction="zozo2/GetReport

Block_Block1ff" style="document" />
<input>

<soap:header message="s0:GetReportBlock_Block1ff
SoapIn" part="request_header" use="literal">

<soap:headerfault message="s0:GetReport
Block_Block1ffSoapIn" part="request_header" use="literal" />

</soap:header>
<soap:body use="literal" parts="parameters" />

</input>
<output>

<soap:body use="literal" />
</output>

</operation>
<operation name="Drill_Block1ff">

<documentation />
<soap:operation soapAction="zozo2/Drill_Block1ff"

style="document" />
<input>

<soap:header message="s0:Drill_Block1ffSoapIn"
part="request_header" use="literal">

<soap:headerfault message="s0:Drill_Block1ff
SoapIn" part="request_header" use="literal" />

</soap:header>
<soap:body use="literal" parts="parameters" />

</input>
<output>

<soap:body use="literal" />
</output>

</operation>
<operation name="GetReportBlock_Bloc1">

<documentation />
<soap:operation soapAction="zozo2/GetReportBlock_Bloc1"

style="document" />
<input>
<soap:header message="s0:GetReportBlock_Bloc1SoapIn"

part="request_header" use="literal">
<soap:headerfault message="s0:GetReport

Block_Bloc1SoapIn" part="request_header" use="literal" />
</soap:header>
<soap:body use="literal" parts="parameters" />

</input>
<output>

<soap:body use="literal" />
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</output>
</operation>
<operation name="Drill_Bloc1">

<documentation />
<soap:operation soapAction="zozo2/Drill_Bloc1"

style="document" />
<input>

<soap:header message="s0:Drill_Bloc1SoapIn"
part="request_header" use="literal">

<soap:headerfault message="s0:Drill_Bloc1SoapIn"
part="request_header" use="literal" />

</soap:header>
<soap:body use="literal" parts="parameters" />

</input>
<output>

<soap:body use="literal" />
</output>

</operation>
</binding>
<service name="zozo2">

<documentation />
<port name="BIServicesSoap" binding="s0:BIServicesSoap">

<soap:address location="http://noux:8080/dswsbob
je/qaawsservices/queryasaservice?&cuid=AduDhWyVezRPn
nJM_FDS4S0&authType=secEnterprise&locale=en_US&timeout=60" />

</port>
</service>

</definitions>

Building Reports with Web Intelligence Rich Client 337

27Sharing Web Intelligence content with other Web applications
BI service structure



338 Building Reports with Web Intelligence Rich Client

Sharing Web Intelligence content with other Web applications27 BI service structure



Linking to other documents

28



Linking to other documents
Cells in Web Intelligence documents can be defined as hyperlinks. Web
Intelligence hyperlinks are similar to the hyperlinks found on the World Wide
Web that allow you to open a different web page from the page you are
currently viewing.

When you click a cell that contains a hyperlink, Web Intelligence opens the
target document specified in the link. The target document can be a Web
Intelligence document, a Crystal Reports document, a site on the world wide
web, or any resource accessible through a hyperlink.

Hyperlinks can be either static or dynamic. A static hyperlink always links to
the same document in the same way. A dynamic hyperlink can link differently
depending on the data in the document containing the hyperlink.

You can create different types of hyperlink:

• A cell where the cell text is the hyperlink text.
• A cell with an associated hyperlink.
• A link to another document in the CMS.

Cell text defined as a hyperlink

When you define the text in a cell as a hyperlink, the cell text itself becomes
the hyperlink text. For example, if you define a free-standing cell containing
the text http://www.businessobjects.com as a hyperlink, clicking on the
cell takes you to the Business Objects web page.

This method is best suited for static hyperlinks, where the text in the cell
always remains the same and links to the same resource in the same way.

Note:
It is possible to make this type of hyperlink dynamic by using the Web
Intelligence formula language to change the cell text based on report data.

To define cell text as a hyperlink

1. Type the hyperlink text in the cell.
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2. If you are using Web Intelligence Interactive, right-click the cell and select
Hyperlink > Read content as hyperlink from the menu.

Note:
You can also right-click the cell and select Format > Cell from the menu
to display the "Format Cells" dialog box, then select Read content as
and select Hyperlink from the list.

3. If you are using the Java Report Panel, click the cell then set the Display
> Read cell content as cell property to Hyperlink.

A hyperlink associated with a cell

When you associate a hyperlink with a cell, you define a hyperlink that Web
Intelligence uses to link to the source document when the cell is clicked. The
cell text itself is not the hyperlink.

This is the recommended method for creating dynamic hyperlinks, for the
following reasons:

• It is specially tailored for working with the parameters in dynamic
hyperlinks.

• It shields you from the complexity of hyperlink syntax - you define your
hyperlink using a graphical interface and Web Intelligence generates and
manages the hyperlink behind the scenes.

• It allows you to define hyperlink text that is different from the cell text.

To add a hyperlink to a cell

1. Right-click the cell and select Hyperlink > New to display the "Create
Hyperlink" dialog box.

2. Select Link to web page on the left of the dialog box. (Web Intelligence
Interactive only.)

3. Type or paste the hyperlink text into the box.
4. Click Parse to extract the hyperlink parameters into the Customize URL

parameters area (which is not visible until you click Parse).

Building Reports with Web Intelligence Rich Client 341

28Linking to other documents
Linking to other documents



Dynamic hyperlinks contain parameters whose values can change.
Parameters appear as name=value parts at the end of the hyperlink after
the question mark. For example, the URL

http://salesandproductreport/default.asp?reportname=products

contains one parameter, reportname, whose value is “products ?.

After you click Parse, each parameter appears on a separate line with
the parameter name on the left and the parameter value on the right. The
static part of the hyperlink (the part without the parameters) appears in
the Main section.

5. To tell Web Intelligence to supply data from formulas or variables as
parameter values, click the arrow next to each parameter value and select
an option.

DescriptionOption

You build a formula in the Formula Editor to supply the for-
mula output as the parameter value.

Build formu-
la

You choose the object from the list in the "Select Object"
dialog box to supply its value as the parameter value.

Select object

Note:
When you modify a parameter, Web Intelligence modifies the full hyperlink
syntax in the box at the top of the screen.

6. To add or remove a parameter, modify the hyperlink syntax, then click
Parse.

Note:
You cannot add or remove parameters directly in the parameter list in the
Customize URL parameters area. You must modify the URL syntax
directly.

7. Click the arrow next to Cell content to change the text displayed in the
hyperlink cell and choose one of the options.
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DescriptionOption

You build a formula in the Formula Editor to supply the for-
mula output as the cell content.

Build formu-
la

You choose the object from the list in the "Select Object"
dialog box to supply its value as the cell content.

Select object

8. Type the tooltip text in the Tooltip box or build a dynamic tooltip by using
the Build formula or Select variable options.

DescriptionOption

You build a formula in the Formula Editor to supply the for-
mula output as the tooltip.

Build formu-
la

You choose the object from the list in the "Select Object"
dialog box to supply its value as the tooltip.

Select object

The tooltip appears when you hover your mouse pointer over the cell
containing the hyperlink.

9. Click the arrow next to Target window to define how the target URL
appears.

DescriptionOption

The target URL replaces the Web Intelligence document
containing the hyperlink in the current window.

Current win-
dow

The target URL opens in a new browser window.New window

A link to another document in the CMS

You link to another document in the CMS using the "Create Hyperlink" dialog
box (Web Intelligence Interactive only). When you create the link, Web
Intelligence builds a formula using the OpenDocument function based on the
choices you make in the dialog box.
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Note:
You can work with the OpenDocument function directly by typing the syntax
into a cell.

To link to another document in the CMS

1. Right-click the cell where you want to create the link and select Hyperlink
> New from the menu to display the "Create Hyperlink" dialog box.

2. Select Link to a document on the left of the dialog box.
3. Click Browse and select the target document in the Choose Document

dialog box, or type the document ID in the Document ID box.
4. Click Refresh on open if you want Web Intelligence to refresh the data

of the target document when the hyperlink is selected.
5. Click Link to document instance, then select an option from the drop

down-list , to link to an instance of the selected document.

DescriptionOption

The hyperlink opens the most recent instance.

Note:
You cannot specify parameter values in the hyperlink
when you choose this option.

Most recent

The hyperlink opens the most recent instance owned
by the current user.

Note:
You cannot specify parameter values in the hyperlink
when you choose this option.

Most recent - cur-
rent user

The hyperlink opens the most recent instance whose
prompt values correspond to the values passed by
the hyperlink.

This option is useful when you want to link to a
large document that contains prompts.

Most recent -
matching prompt
values

6. Click Report name and select the name of the report to link to a specific
report.
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7. Click Report part, then click Select and right-click the report part (for
example a table), to link to a specific part of a report.

8. If you selected Report part, select Display report part only open the
report part only in the target document, or Position at report part (full
document available) to focus on the report part but display the whole
report in the target document.

9. For each prompt in the Document prompts section, select one of the
following options from the drop-down list:

DescriptionOption

You use the Formula Editor to build a formula to pass a
value to the prompt.

Build formula

You select an object whose value is passed to the prompt.Select object

The user specifies a value for the prompt when they click
the hyperlink.

Prompt user
at runtime

You configure the hyperlink to not pass a parameter to the
target document, and the target document opens with the
default value for the prompt. The default value is either the
last value specified for the prompt, or the default specified
in the document.

Usedocument
default

10. Choose Build Formula or Select Variable from the Cell content list to
specify the content of the hyperlink cell.

DescriptionOption

You build a formula in the Formula Editor to supply the for-
mula output as the cell content.

Build Formu-
la

You choose a variable from the list in the "Select an Object"
dialog box to supply its value as the cell content.

Select Vari-
able

11. Type the tooltip text in the Tooltip box or build a dynamic tooltip by using
the Build formula or Select object options.
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DescriptionOption

You build a formula in the Formula Editor to supply the for-
mula output as the tooltip.

Build formu-
la

You choose the variable from the list in the "Select an Object"
dialog box to supply its value as the tooltip.

Select object

The tooltip appears when you hover your mouse pointer over the cell
containing the hyperlink.

12. Select New window or Current window from the Target window list to
determine how the target document opens.

DescriptionOption

The document opens in a new browser window.New window

The document opens in the current browser window and
replaces the document containing the hyperlink.

Target win-
dow

Document instances and values passed to prompts

Hyperlinks supply values to prompts in the target document in two ways: by
passing values directly to prompts, or by opening a document instance based
on passed values.

In the first case, the hyperlink feeds values directly to the prompts in the
target document. In the second case, Web Intelligence opens the document
instance whose stored prompt values correspond to the values passed by
the hyperlink.

It is more efficient to choose a document instance based on passed
parameters if the target document is large.

Certain combinations of instance and parameter settings are incompatible
or mutually dependent, as described in the following table:
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Impact on parameter settingInstance setting

The hyperlink does not pass parame-
ter values. All parameters are set to
Use document default and cannot
be modified.

Most recent

The hyperlink does not pass parame-
ter values. All parameters are set to
Use document default and cannot
be modified.

Most recent - current user

You must specify at least one param-
eter value. Without at least one
specified value, the hyperlink returns
an error when clicked.

The error occurs because the hyper-
link is designed to retrieve an in-
stance based on parameter values,
but no value is provided for compari-
son against the instance.

Most recent - matching prompt values

Related Topics
• Linking to large documents on page 347

Linking to large documents

When the target document contains a large amount of data, it is more efficient
to link to an instance than to open and retrieve the document with a passed
parameter value. You can schedule and pre-retreive multiple instances with
different parameter values. This allows the document to be scheduled and
pre-retrieved in advance with different parameter values.

When you click the hyperlink, Web Intelligence opens the appropriate
pre-retrieved instance rather than using the passed value to open the
document and retrieve the data.
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Example: Linking to a large sales report

In this example you link to a large sales report that retrieves sales by region.
The report has a parameter that allows the user to select the region. There
are four regions - North, South, East, and West.

Your source document has a [Region] dimension. You do the following:

• Configure the hyperlink to pass the value of [Region] as a parameter
• Create four instances of the sales report, one for each value of [Region]
• Schedule these instances for pre-retrieval
• Configure the hyperlink to open the latest instance whose parameter value

matches the value passed by the hyperlink

Assuming that the document has a [Region] dimension, the settings are as
follows:

Latest value matchLink to document instance setting

[Region]Most recent - matching prompt values

Working with hyperlinks

To link to another document from a hyperlink

To link to another document from a hyperlink, the hyperlink must first have
been created.

1. Hover your mouse pointer over the cell to display the tooltip if a tooltip is
defined.

Note:
If you used the Hyperlink dialog box to define the link and the Formula
Bar is displayed, the hyperlink syntax generated by Web Intelligence
appears in the Formula Bar. Do not modify this syntax directly - use the
Hyperlink dialog box if you need to update it.

2. Click the hyperlink to open the target document.
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Depending on how the hyperlink is configured the target document opens
in a new browser window, or it replaces the current document in the
current browser window.

To edit a hyperlink

1. Right-click the cell containing the hyperlink and select Hyperlink > Edit
from the menu to display the "Hyperlink" dialog box.

2. Edit the hyperlink using the "Hyperlink" dialog box.

To delete a hyperlink

• Right-click the cell containing the hyperlink and selectHyperlink >Delete
from the menu.

Formatting hyperlink colors

You can define the colors that Web Intelligence uses to display hyperlinks
that have already been clicked (visited hyperlinks) and hyperlinks that have
not been clicked (unvisited hyperlinks).

To set hyperlink colors

1. Right-click a blank area on the report that contains hyperlinks and select
Format Report on the menu.

2. Click the General tab.
3. In the Hyperlink color section, click the arrows next to Visited and

Unvisited, then either select a predefined color or click More colors to
define a custom color.

4. Click OK.
Web Intelligence applies the color settings you selected to the hyperlinks
in the report.
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URL Reporting using openDocument
URL reporting using openDocument provides URL access to multiple
document types by passing a URL string to a BusinessObjects Enterprise
server. openDocument provides commands to control how reports are
generated and displayed.

You can use openDocument in BusinessObjects Enterprise to create
cross-system links to and from the following document types:

• .wid: Web Intelligence documents

• .rep: Desktop Intelligence documents

• .rpt: Crystal reports

• .car: OLAP Intelligence reports

Structuring an openDocument URL

The next sections explain how to use the openDocument function, and how
to construct the URL.

An openDocument URL is generally structured as follows:

http://<servername>:<port>/OpenDocument/opendoc/<platformSpe
cific>?<parameter1>&<parameter2>&...&<parameterN>

The exact syntax of the <platformSpecific> parameter depends on your
implementation:

• For Java implementations, use openDocument.jsp in place of the
<platformSpecific> parameter.

• For .NET implementations, use opendocument.aspx in place of the
<platformSpecific> parameter.

The URL is constructed using the parameters listed in openDocument
parameter overview on page 353
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Joining parameters

Join parameters with the ampersand (&). Do not place spaces around the
ampersand. For example: sType=wid&sDocName=Sales2003

The ampersand is always required between parameters.

Spaces and special characters in parameter values

Because some browsers cannot interpret spaces, the parameters of the link
cannot contain spaces or other special characters that require URL encoding.
To avoid the misinterpretation of special characters, you can define a
URLEncoded string in the source database to replace the special character
with an escape sequence. This will allow the database to ignore the special
character and correctly interpret the parameter value. Note that certain
RDBMS have functions that allow you to replace one special character with
another.

By creating an escape sequence for the plus sign (+), you can instruct the
database to interpret the plus sign as a space. In this case, a document title
Sales Report for 2003 would be specified in the DocName parameter as:
&sDocName=Sales+Report+for+2003&

This syntax prevents the database from misinterpreting the spaces in the
title.

Trailing spaces in parameter values

Trim trailing spaces at the end of parameter values and prompt names. Do
not replace them with a plus sign (+). The viewer may not know whether to
interpret the plus sign (+) as part of the prompt name or as a space. For
example, if the prompt name displays:

Select a City:_

(where _ represents a space), enter the following text in the link:

lsSSelect+a+City:=Paris

where the spaces within the prompt name are replaced with the plus sign,
and the trailing space is trimmed off.

For details on prompt parameters of the link, refer to openDocument
parameter overview on page 353 .
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Capitalization

All of the openDocument parameters are case sensitive.

Link length limit

The encoded URL cannot exceed 2083 total characters.

Parameter values in links to sub-reports

You cannot pass parameter values to a sub-report of a target Crystal report.

Using the lsS parameter with OLAP Intelligence reports

If the target document is an OLAP Intelligence report (.car) you can use the
IsS parameter to specify prompts. The parameters are passed in as a
URL-encoded string using the unique name of the parameter set up in the
OLAP Intelligence report.

Example: Opening a report to a specific page

If 23CAA3C1-8DBB-4CF3-BA%2CB8%2CD7%2CF0%2C68%2CEF%2C9C%2C6F is
the URL-encoded unique name for the page parameter in the OLAP
Intelligence report, you would use the following URL to open the OLAP
Intelligence report to page 2:

http://<servername>:<port>/OpenDocument/<platformSpecif
ic>?sType=car&sIDType=InfoObject&iDocID=440&lsS23CAA3C1-8DBB-
4CF3-BA%2CB8%2CD7%2CF0%2C68%2CEF%2C9C%2C6F=2

Example: Opening a cube parameter

If 8401682C-9B1D-4850-8B%2C5E%2CD9%2C1F%2C20%2CF8%2C1%2C62 is
the URL-encoded unique name for the cube parameter opening the
warehouse cube in the catalogue FoodMart 2000 on MSAS, you would use
the following URL to open this cube parameter:

http://<servername>:<port>/OpenDocument/<platformSpecif
ic>?sType=car&sIDType=InfoObject&lsS8401682C-9B1D-4850-
8B%2C5E%2CD9%2C1F%2C20%2CF8%2C1%2C62=CATALOG%3DFood
Mart%202000,CUBE%3Dwarehouse&iDocID=616
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Using the lsM parameter with OLAP Intelligence reports

If the target document is an OLAP Intelligence report (.car) you can use the
IsM parameter to specify prompts. The parameters are passed in as a
URL-encoded string using the unique name of the parameter set up in the
OLAP Intelligence report.

As was the case for the lsS parameter, lsM parameters are also passed in
as a URL-encoded string using the unique name of the parameter set up in
the OLAP Intelligence report.

Example: Opening a report

http://<servername>:<port>/OpenDocument/<platformSpecif
ic>?sType=car&sIDType=InfoObject&lsMADC216EA-D9A5-42B5-
AE%2C21%2C84%2CA9%2CF9%2C6E%2C31%2C7=[%5BCustomers%5D.%5BCoun
try%5D.%26%5BMexico%5D],[%5BCustomers%5D.%5BCoun
try%5D.%26%5BCanada%5D]&iDocID=544

This is a memberset parameter opening up a report with Customers >
Country > Mexico and Customers > Country > Canada in the view.

openDocument parameter overview

This section provides a brief overview of openDocument and includes a list
of available parameters. Details about the available parameters, their specific
uses, and relevant examples are also provided.

Note:
The document containing the openDocument link is called the parent
document, and it resides on the parent system. The document to which the
link points is called the target document, and it resides on the target system.

Table 28-3: Platform Parameters

DescriptionParameter

Document identifier.iDocID on page 357
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DescriptionParameter

Document name.sDocName on page 358

Crystal object type.sIDType on page 358

The file type of target Desktop Intelligence
document.sKind on page 359

The name of the folder and subfolder contain-
ing the target document.sPath on page 359

The file type of target document or report.sType on page 360

A valid logon token for the current CMS ses-
sion.token on page 360

Table 28-4: Input Parameters

DescriptionParameter

Specifies a contextual prompt if there is an
ambiguity during SQL generation (Business
Objects and Web Intelligence documents on-
ly).

lsC on page 361

Specifies multiple values for a prompt, [NAME]
is the text of the promptlsM[NAME] on page 362
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DescriptionParameter

Specifies a range of values for a prompt,
[NAME] is the text of the prompt.lsR[NAME] on page 363

Specifies a value for a single prompt. [NAME]
is the text of the prompt.lsS[NAME] on page 364

Indicates which specific instance of the target
report to open.sInstance on page 365

In Crystal Reports, a report part is associated
to a data context.sPartContext on page 365

Indicates whether a refresh should be forced
when the target document or report is opened.sRefresh on page 366

For Crystal targets only, indicates whether
the link should open the full target report or
just the report part specified in sReportPart.

sReportMode on page 367

Indicates which report to open if target docu-
ment is multi-report.sReportName on page 367

Indicates which specific part of the target re-
port to open.sReportPart on page 368
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Table 28-5: Output Parameters

DescriptionParameter

Forces the display of the prompt selection
page.NAII on page 369

Indicates the format in which the target docu-
ment is opened.sOutputFormat on page 370

Indicates the selected report viewer (CR &
CA only).sViewer on page 370

Indicates whether the target report will open
in the current browser window or whether a
new window will be launched.

sWindow on page 371

openDocument platform parameters

This section details the openDocument platform parameters that are available
and gives examples on how to use the commands.

An openDocument URL is generally structured as follows:

http://<servername>:<port>/OpenDocument/opendoc/<platformSpe
cific>?<parameter1>&<parameter2>&...&<parameterN>

The exact syntax of the <platformSpecific> parameter depends on your
implementation:

• For Java implementations, use openDocument.jsp in place of the
<platformSpecific> parameter.

• For .NET implementations, use opendocument.aspx in place of the
<platformSpecific> parameter.
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Note:
Variables are denoted with angle brackets. You must substitute the proper
value for these variables. For example, you must use the name of your server
in place of <servername> where it is contained in the code samples below,
and you must use your port number in place of <port>.

iDocID

ValuesMandatory?DescriptionSyntax

Document identifier (In-
foObjectID).Yes*Document identifier.iDocID

Note:
*One of sDocName or iDocID is mandatory.

Example:

http://<servername>:<port>/OpenDocument/opendoc/<platformSpe
cific>?sType=wid&sDocName=SalesReport&iDocID=2010

Note:
To obtain the document ID, navigate to the document within the Central
Management Console (CMC). The properties page for the document
contains the document ID and the CUID. Use this value for the iDocID
parameter.
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sDocName

ValuesMandatory?DescriptionSyntax

Document name.Yes*

Document name without
extension

If multiple documents
have the same name,
specify the correct docu-
ment with iDocID.

sDocName

Note:
*One of sDocName or iDocID is mandatory.

Example:

http://<servername>:<port>/OpenDocument/opendoc/<platformSpe
cific>?sPath=[Sales+Reports]&sDocName=Sales+in+200

sIDType

ValuesMandatory?DescriptionSyntax

• CUID

• GUID

• RUID

• ParentID

• InfoObjectID (de-
fault)

Yes*
Central Management
Server (CMS) object
identifier type.

sIDType

Note:
*Only mandatory if the target is a Crystal report or OLAP Intelligence report
(sType=rpt or sType=car) in an Object Package. Otherwise, use sPath and
sDocName.
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Example:

http://<servername>:<port>/OpenDocument/opendoc/<platformSpe
cific>?iDocID=2010&sIDType=CUID

sKind

ValuesMandatory?DescriptionSyntax

• FullClientYes*
The file type of target
Desktop Intelligence doc-
ument.

sKind

Note:
*Only mandatory if the target is a Desktop Intelligence document. Otherwise,
use sType.

Example:

http://<servername>:<port>/OpenDocument/opendoc/<platformSpe
cific>?sKind=FullClient

sPath

ValuesMandatory?DescriptionSyntax

Folder and/or subfolder:

[folder],[subfolder]
Yes*

The name of the folder
and subfolder containing
the target document.

sPath

Note:
*Only mandatory if a value is specified for sDocName and is not unique.
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Example:

http://<servername>:<port>/OpenDocument/opendoc/<platformSpe
cific>?sPath=[Sales+Reports]&sDocName=Sales+in+2005

sType

ValuesMandatory?DescriptionSyntax

• wid

• rpt

• car

YesThe file type of target
document or report.sType

Note:
This parameter is ignored for agnostic documents.

Example:

http://<servername>:<port>/OpenDocument/opendoc/<platformSpe
cific>?sType=wid

token

ValuesMandatory?DescriptionSyntax

The logon token for the
current CMS session.NoA valid logon token for

the current CMS session.token

Example:

http://<servername>:<port>/OpenDocument/opendoc/<platformSpe
cific>?sType=wid&sDocName=Sales+in+2003&token=<logonToken>
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openDocument input parameters

This section details the openDocument input parameters that are available
and gives examples on how to use the commands.

An openDocument URL is generally structured as follows:

http://<servername>:<port>/OpenDocument/opendoc/<platformSpe
cific>?<parameter1>&<parameter2>&...&<parameterN>

The exact syntax of the <platformSpecific> parameter depends on your
implementation:

• For Java implementations, use openDocument.jsp in place of the
<platformSpecific> parameter.

• For .NET implementations, use opendocument.aspx in place of the
<platformSpecific> parameter.

Note:
Variables are denoted with angle brackets. You must substitute the proper
value for these variables. For example, you must use the name of your server
in place of <servername> where it is contained in the code samples below,
and you must use your port number in place of <port>.

lsC

ValuesMandatory?DescriptionSyntax

A prompt value that re-
solves the ambiguity in
the SQL generation.

No

Specifies a contextual
prompt if there is an ambi-
guity during SQL genera-
tion (Business Objects
and Web Intelligence
documents only).

Note:
Not supported by OLAP
Intelligence

lsC
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Example:

http://<servername>:<port>/OpenDocument/opendoc/<platformSpe
cific>?sType=wid&sDocName=SalesReport&iDocID=2010&lsC=Sales

lsM[NAME]

ValuesMandatory?DescriptionSyntax

• Multiple prompt val-
ues, separated by a
comma. If the target is
a Crystal report, each
value must be en-
closed in square
brackets. If the target
is a OLAP Intelligence
report, use the MDX
WITH clause (refer to
Using the lsS parame-
ter with OLAP Intelli-
gence reports on
page 352 and Using
the lsM parameter
with OLAP Intelli-
gence reports on
page 353).

• no_value (only for
optional parameters)

No
Specifies multiple values
for a prompt. [NAME] is
the text of the prompt.

lsM[NAME]

Note:
You can remove an optional parameter from the prompt by setting it to
no_value in the openDocument query string. If you leave an optional
parameter out of the openDocument query string, a default parameter value
will be applied.
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Example:

http://<servername>:<port>/OpenDocument/opendoc/<platformSpe
cific>?sType=rpt&sDocName=SalesReport&lsMSe
lect+Cities=[Paris],[London]

lsR[NAME]

ValuesMandatory?DescriptionSyntax

• A range of values for
the prompt, separated
by a double period (..).
If the target is a Crys-
tal report, the range
must be enclosed in
square brackets
and/or parentheses
(use a square bracket
next to a value to in-
clude it in the range,
and parentheses to
exclude it).

• no_value (only for
optional parameters)

No

Specifies a range of val-
ues for a prompt. [NAME]
is the text of the prompt.

Note:
Not supported by OLAP
Intelligence

lsR[NAME]

Note:
You can remove an optional parameter from the prompt by setting it to
no_value in the openDocument query string. If you leave an optional
parameter out of the openDocument query string, a default parameter value
will be applied.

Example:

http://<servername>:<port>/OpenDocument/opendoc/<platformSpe
cific>?sType=rpt&sDocName=SalesReport&lsRTime+Peri
od:=[2000..2004)
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lsS[NAME]

ValuesMandatory?DescriptionSyntax

• A single prompt value
(refer to Using the lsS
parameter with OLAP
Intelligence reports on
page 352 and Using
the lsM parameter
with OLAP Intelli-
gence reports on
page 353).

• no_value (only for
optional parameters)

No
Specifies a value for a
single prompt. [NAME] is
the text of the prompt.

lsS[NAME]

Note:
You can remove an optional parameter from the prompt by setting it to
no_value in the openDocument query string. If you leave an optional
parameter out of the openDocument query string, a default parameter value
will be applied.

Example:

http://<servername>:<port>/OpenDocument/opendoc/<platformSpe
cific>?sType=wid&sDocName=SalesReport&iDocID=2010&lsSSe
lect+a+City=Paris
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sInstance

ValuesMandatory?DescriptionSyntax

• User (Link to latest in-
stance owned by cur-
rent user)

• Last (Link to latest in-
stance for report)

• Param (Link to latest
instance of report with
matching parameter
values)

No
Indicates which specific
instance of the target re-
port to open.

sInstance

Note:
Use this parameter in combination with sDocName.

Example:

http://<servername>:<port>/OpenDocument/opendoc/<platformSpe
cific>?sPath=[Sales+Reports]&sDocName=Sales+in+2003&sReport
Part=Part1&sInstance=User

sPartContext

ValuesMandatory?DescriptionSyntax

Data context of the report
part.Yes*

In Crystal Reports, a re-
port part is associated to
a data context.

sPartContext

Note:
*Only mandatory if a value is specified for sReportPart.
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Example:

http://<servername>:<port>/OpenDocument/opendoc/<platformSpe
cific>?sPath=[Sales+Reports]&sDocName=Sales+in+2005&sReport
Part=Part1&sPartContext=0-4-0

Note:
The sReportPart and sPartContext parameters are supported with the
regular DHML viewer (sViewer=html). Instead of the first page of the report,
the DHTML viewer displays the page and context containing the part with
the part highlighted.

sRefresh

ValuesMandatory?DescriptionSyntax

• Y (forces the docu-
ment’s refresh)

• N (note that the re-
fresh on open feature
overrides this value)

No

Indicates whether a re-
fresh should be forced
when the target docu-
ment or report is opened.

sRefresh

Example:

http://<servername>:<port>/OpenDocument/opendoc/<platformSpe
cific>?sType=wid&sDocName=SalesReport&iDocID=2010&sRefresh=Y
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sReportMode

ValuesMandatory?DescriptionSyntax

• Full

• PartNo

For Crystal targets only,
indicates whether the link
should open the full tar-
get report or just the re-
port part specified in sRe
portPart.

sReportMode

Note:
Defaults to Full if this parameter is not specified. Only applies if a value is
specified for sReportPart.

Example:

http://<servername>:<port>/OpenDocument/opendoc/<platformSpe
cific>?sPath=[Sales+Reports]&sDocName=Sales+in+2003&sReport
Part=Part1&sReportMode=Part

sReportName

ValuesMandatory?DescriptionSyntax

Report name for Web In-
telligence documents,
sub-report for Crystal Re-
ports, pages for OLAP
Intelligence reports.

No
Indicates which report to
open if target document
is multi-report.

sReportName

Note:
Defaults to the first report if this parameter is not specified.
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Example:

http://<servername>:<port>/OpenDocument/opendoc/<platformSpe
cific>?sType=wid&sDocName=Sales+in+2003&sReportName=First+Re
port+Tab

sReportPart

ValuesMandatory?DescriptionSyntax

Name of the report part.No
Indicates which specific
part of the target report to
open.

sReportPart

Example:

http://<servername>:<port>/OpenDocument/opendoc/<platformSpe
cific>?sPath=[Sales+Reports]&sDocName=Sales+in+2003&sReport
Part=Part1

Note:
The sReportPart and sPartContext parameters are supported with the
regular DHML viewer (sViewer=html). Instead of the first page of the report,
the DHTML viewer displays the page and context containing the part with
the part highlighted.

openDocument output parameters

This section details the openDocument output parameters that are available
and gives examples on how to use the commands.

An openDocument URL is generally structured as follows:

http://<servername>:<port>/OpenDocument/opendoc/<platformSpe
cific>?<parameter1>&<parameter2>&...&<parameterN>

The exact syntax of the <platformSpecific> parameter depends on your
implementation:
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• For Java implementations, use openDocument.jsp in place of the
<platformSpecific> parameter.

• For .NET implementations, use opendocument.aspx in place of the
<platformSpecific> parameter.

Note:
Variables are denoted with angle brackets. You must substitute the proper
value for these variables. For example, you must use the name of your server
in place of <servername> where it is contained in the code samples below,
and you must use your port number in place of <port>.

NAII

ValuesMandatory?DescriptionSyntax

• Y (all prompts whose
values are passed
with lsS, lsM or lsR
are pre-selected)

No

Forces the display of the
prompt selection page.

Note:
Only supported by Web
Intelligence documents.

NAII

Note:
• If the document prompt values are purged, then NAII=Y raises the prompt

for any values not specified in the URL.
• If the document prompt values are not purged, then NAII=Y raises the

prompt for any values not specified in the URL and pre-selects the default
values.

• If all prompt values are specified in the URL, the prompt window does
not appear even if NAII=Y is specified.

Example:

http://<servername>:<port>/OpenDocument/opendoc/<platformSpe
cific>?sType=wid&sDocName=SalesReport&iDocID=2010&NAII=YsRe
fresh=Y
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sOutputFormat

ValuesMandatory?DescriptionSyntax

• H (HTML)
• P (PDF)
• E (Excel)
• W (Word)

No
Indicates the format in
which the target docu-
ment is opened.

sOutputFormat

Note:
Defaults to HTML if this parameter is not specified.

Example:

http://<servername>:<port>/OpenDocument/opendoc/<platformSpe
cific>?sPath=[Sales+Reports]&sDocName=Sales+in+2003&sOutput
Format=E

sViewer

ValuesMandatory?DescriptionSyntax

• html

• part (Crystal reports
only)

• actx (Crystal reports
only)

• java (Crystal reports
only)

No
Indicates the viewer that
is used to view the docu-
ment.

sViewer
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Example:

http://<servername>:<port>/OpenDocument/opendoc/<platformSpe
cific>?sPath=[Sales+Reports]&sDocName=Sales+in+2003&sView
er=html

Example:

Note:
In order to use parameters in the URL with the ActiveX viewer, :connect must
be appended to the URL, followed by the parameters.

http://<servername>:<port>/OpenDocument/opendoc/<platformSpe
cific>?sPath=[Sales+Reports]&sDocName=Sales+in+2003&sViewer=ac
tx:connect&IsMCountry=[Thailand],[Norway]

sWindow

ValuesMandatory?DescriptionSyntax

• Same (current browser
window)

• New (new browser
window is launched)

No

Indicates whether the
target report will open in
the current browser win-
dow or whether a new
window will be launched.

sWindow

Example:

http://<servername>:<port>/OpenDocument/opendoc/<platformSpe
cific>?sType=wid&sDocName=SalesReport&iDocID=2010&sWindow=New

Contextual report linking

The openDocument feature allows you to create contextual links between
Crystal reports, OLAP Intelligence reports and Web Intelligence documents.
To do this, you construct a URL using the openDocument syntax and then
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insert the URL into a Crystal report, OLAP Intelligence report or Web
Intelligence document.

Contextual report linking allows report designers to specify associations for
documents residing in either a Crystal Reports environment (unmanaged)
or a BusinessObjects Enterprise environment (managed). Once these
associations are created, users follow the resulting navigational paths
embedded in the linked documents.

This feature enables you to invoke Business Objects and Web Intelligence
documents from Crystal Reports and vice versa. This feature relies on
functionality that allows the user to do the following:

• Link Web Intelligence or Business Objects documents within the document
domain.

• Link report objects in Crystal Reports.

Click the appropriate link to jump to that section:

• To insert a link into a Crystal report on page 372

• To create a link to another report or document from an OLAP Intelligence
report on page 373

• Creating links in Web Intelligence documents on page 374

To insert a link into a Crystal report

You can use openDocument to create hyperlinks in Crystal Reports. To
create a link to another report or document, use the Hyperlink Tab of the
field Format Editor.

1. Open the source report in Crystal Reports.
2. Right-click the field in which you want to insert the openDocument link

and select Format from the shortcut menu.
3. In the Format Editor, select the Hyperlink tab.
4. Select A website on the Internet.
5. In the “Hyperlink information ? area, leave the Website Address field

empty and click the Format Formula Editor button.
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6. Enter the openDocument link in the following format:

"http://[openDocument parameters]"+{Article_lookup.Fami
ly_name}

Where [openDocument parameters] are described in openDocument
parameter overview on page 353, and the {Article_lookup.Family_name}
enables the report to pass context-dependent data.

Note:
Test your link in a browser window before inserting it into a report or
document.

7. Click Save and Close to leave the Formula Workshop.
8. Click OK in the Formula Editor to save the link.

To create a link to another report or document from an OLAP
Intelligence report

You can use openDocument to create hyperlinks in OLAP Intelligence reports.

1. Open the source report in the OLAP Intelligence designer.
2. On the Tools menu, select Action Manager .
3. Click New to create a new action.
4. Enter an action name.
5. Select the area to which the action (the link) will apply.
6. Enter the openDocument link using the parameters and syntax described

in this document.

Tip:
Test your link in a browser window before inserting it into a report or
document.

7. Click OK to save the link.
8. Close the Action Manager dialog box.
9. Create an Analysis Button on the source report.
10. Right-click the Analysis Button.
11. In the drop-down menu, select Properties and then Edit .
12. Select Launch an action .
13. Select the action that corresponds to the openDocument link created in

steps 3 through 6.
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14. Click OK .

Creating links in Web Intelligence documents

You can define objects in a universe that allow Web Intelligence and
BusinessObjects users to create reports whose returned values include links
to other reports and documents.

When these reports are exported to the repository, users can click returned
values displayed as hyperlinks to open another related document stored in
the document domain of the repository.You create these links using the
openDocument function in the definition of an object in Designer.

More information

For full information on creating links in Web Intelligence reports, see the
Building Reports Using the WebIntelligence Java Report Panel guide.

You enable report linking in a universe by creating an object (the link object)
whose returned values are the same as the values used as input to a prompt
in an existing report (the target report).

The openDocument function allows the values for the link object to be
returned as hyperlinks. When the user clicks the hyperlink, its value is used
as the prompt input for the target report.

You can create documents using the link object as you would with any other
object. Users can then click the hyperlinks to access more detailed documents
related to the link object.

To create a link object, use the openDocument function in the object’s Select
statement. The Select statement for a link object follows this order:

'<a href="http://<servername>:<port>/OpenDocument/<platformSpe
cific>?sDocName=<document name>&sType=<document type>&iDo
cID=<document id>&lsS<prompt message>='+object SELECT+'">'+ob
ject SELECT+'</a>'

The concatenation operator (+) applies for Microsoft Access databases. Use
the operator appropriate to your target RDBMS.

For more details on the Select statement, creating link objects, and using
link objects in InfoView, refer to the Designer’s Guide.
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Working with documents

29



To create a Web Intelligence document
from InfoView

1. Click Document List on the InfoView toolbar.
2. Click New > Web Intelligence Document
3. Select the universe on which you want to create the document and click

OK.

Note:
If your InfoView Web Intelligence preferences specify a default universe,
this step is omitted and the Web Intelligence query editor opens and
displays the objects in the default universe.

4. The Web Intelligence query editor specified in the InfoView Web
Intelligence preferences opens and displays the objects in the universe
you selected.

5. Build and run the query using the query editor.

To open a Web Intelligence document
from InfoView

1. Click Document List to show the documents available in InfoView.
2. Navigate to the folder containing your document.
3. Select the document and select Action > View or Action Modify

depending on whether you want to view or modify the document.
The document opens in the view format or document editing tool selected
in your InfoView Web Intelligence options.

Related Topics
• Web Intelligence document creation and viewing options on page 29

To delete a Web Intelligence document
from InfoView

1. From the InfoView home page, navigate to the folder that contains the
document you want to delete.
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2. Select the check box next to the name of the document you want to delete.
3. Click Delete.

Saving documents

To save a newWeb Intelligence document in
InfoView

1. With the document open in the Java Report Panel or Web Intelligence
HTML, click Save on the main toolbar.
The Save Document dialog box opens.

2. Click Folders or Categories to display the repository by folders or by
categories.

3. In the Name box, type the name of the document.
4. Click Advanced to display additional document options.
5. In the Description box, type a meaningful description of the document

(optional).
6. In the Keywords box, type keywords that you or other users can use to

search for the document in the future (optional).
7. Select Refresh on open to refresh the document each time it is opened.
8. Select Permanent Regional Formatting to preserve the document

regional formatting with the document.
9. Click OK.

The document is saved in InfoView.

To save a Web Intelligence document as an Excel
spreadsheet

1. With the document open, click Document > Save to my computer as
> Excel (in Web Intelligence HTML) or click the arrow next to Save, then
select Save to my computer as, then click Excel (in the Java Report
Panel).
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Note:
You can save the current report to Excel format in Web Intelligence HTML
by selecting Save report to my computer as > Excel from the menu.

The File Download dialog box appears.

2. Type a file name or accept the default name displayed.
3. Select Save this file to disk, then click OK.
4. Select a file location on your computer, then click Save.

Web Intelligence saves a copy of your document in Microsoft Excel format
to the location you specified on your computer. Each report within the
Web Intelligence document converts to a separate Excel worksheet within
the Excel file.

Some Web Intelligence chart formats do not exist in Excel. These charts
are automatically converted to the closest corresponding chart format
available in Excel.

Web Intelligence starts a new Excel worksheet for each 65K rows of
exported data.

To save a Web Intelligence document as a PDF file

1. With the document open, click Document > Save to my computer as
> PDF (in Web Intelligence HTML), or click the arrow next to Save, then
select Save to my computer as, then select PDF (in the Java Report
Panel).
The File Download dialog box appears.

2. Type a file name or accept the default name displayed.
3. Select Save this file to disk, then click OK.
4. Select a file location on your computer, then click Save.

Web Intelligence saves a copy of your document in Adobe Acrobat PDF
format to the location you specified on your computer.
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To save a Web Intelligence document as a CSV file

1. With the document open, click Document on the toolbar above the
displayed reports (in Web Intelligence HTML), or click the arrow next to
Save (in the Java Report Panel).

2. Select Save to my computer as > CSV to save the document with the
default options or Save to my computer as > CSV (with options) to
choose the options.

3. If you chose CSV (with options), choose the text qualifier, column
delimiter and character set in the "Save as CSV - Options" dialog box.

4. Select Set as default values in the "Save as CSV - Options" dialog box
if you want the options you chose in the previous step to be the default
options when you save to CSV.

5. Click OK to close the "Save as CSV - Options" dialog box.
The File Download dialog box appears.

6. Select Save this file to disk, then click OK.
7. Type a file name or accept the default name displayed.
8. Select a file location on your computer, then click Save.

Web Intelligence saves a copy of your document in CSV format to the
location you specified on your computer.

Automatic saving and recovery

Saving documents automatically

If Web Intelligence is configured for autosave, and if you have the appropriate
security rights, Web Intelligence saves your documents automatically in the
My Favorites/~Web Intelligence folder as you work. Web Intelligence
uses the document name prefixed by the document ID and followed by the
autosaved document ID to name autosaved documents. (If the document ID
is -1, the document was not saved before being autosaved.)

Note:
Web Intelligence Rich Client does not save documents automatically.
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Web Intelligence saves documents at a regular interval, which is defined in
the CMC. This interval is reset each time you save a document manually,
and each time Web Intelligence saves a document automatically. Web
Intelligence also deletes the autosaved document when you save a document
manually.

In addition to regular autosaving, Web Intelligence saves documents when
your Web Intelligence session times out.

Note:
If you lose a Web Intelligence document before you can save it, check the
folder immediately for the autosaved version. The My Favorites/~Web
Intelligence folder is not a permanent storage location for autosaved
documents.

For more information on the settings and security rights that impact automatic
saving, see the documentation for the Central Management Console.

Related Topics
• How Web Intelligence manages autosaved documents on page 381
• Recovering autosaved documents on page 380

Recovering autosaved documents

If your session times out while you are working on a document, Web
Intelligence automatically saves the document in the My Favorites/~Web
Intelligence folder and displays a dialog box explaining that the session
has ended.

If you select Restore on the dialog box, Web Intelligence launches a new
session and re-opens the autosaved document. The next time you save the
document manually, Web Intelligence saves it in its original folder.

If you select Close, you are redirected to the InfoView home page. The
autosaved document is available in the My Favorites/~Web Intelligence
folder.

In some cases, Web Intelligence cannot link to the autosaved document after
a server timeout or connection loss. In this case Web Intelligence does not
offer you the option to restore the autosaved document. You must check the
My Favorites/~Web Intelligence folder immediately for your autosaved
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document. Web Intelligence regularly deletes documents from the folder
based on the autosave settings.

Related Topics
• Saving documents automatically on page 379
• How Web Intelligence manages autosaved documents on page 381

How Web Intelligence manages autosaved documents

Web Intelligence saves documents automatically in the My Favorites/~Web
Intelligence folder.

Whenever you save a document manually, Web Intelligence also updates
the autosaved document with the changes. As a general rule, Web
Intelligence handles autosaving transparently and you do not access
autosaved documents directly. You need to access them directly when your
Web Intelligence session timed out, and Web Intelligence was unable to
reopen your autosaved document.

Note:
If you need to access an autosaved document directly, check the My
Favorites/~Web Intelligence folder immediately. This folder is not a
permanent storage location for autosaved documents.

The My Favorites/~Web Intelligence folder has a maximum size limit,
which is set in the CMC. When the total size of the documents in the folder
exceeds this limit, Web Intelligence deletes as many of the oldest documents
in the folder as necessary to make way for the latest document.

Web Intelligence also deletes all documents from the folder at a defined
interval, which is set in the CMC.

If you navigate away from your Web Intelligence document in your browser
without saving the document, the document is lost and Web Intelligence
clears the contents of the My Favorites/~Web Intelligence folder.

Related Topics
• Saving documents automatically on page 379
• Recovering autosaved documents on page 380
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Printing Web Intelligence documents
You print Web Intelligence documents report-by-report. You can print one
or multiple reports from a single document.

Web Intelligence prints reports from left to right, and then top to bottom. If a
report is wider than the width of the paper size defined in the Report Page
Layout, Web Intelligence inserts page breaks for the printout.

The paper size and page orientation for printing can be different from the
paper size and page orientation set for the reports when you view them in
the Java Report Panel or Web Intelligence Rich Client. This enables users
using different printers to specify the appropriate layout when they print.

Web Intelligence prints documents directly in the Java Report Panel and
Web Intelligence Rich Client. Web Intelligence HTML exports the document
to PDF file that you can then print.

To print a document

1. Click the report tab you want to print.
2. Click the Print this document button on the Report toolbar.

The "Print" dialog box appears.

3. Under the Print Range option, you specify whether you want to print the
entire selected report or just some of the report pages.
You can specify the paper size of the report or page(s) for the printout.
The paper size you set for printing overrides the paper size defined for
the report in the Report Properties Page Layout tab.

4. To change the paper size, click the arrow next to the list box below Paper
Size,and then select a different paper size from the list.

5. Under the Orientation options, select the page orientation that suits the
report page layout.

6. Under the Margins options, select the margin sizes.
7. Under the Copies options, select the number of copies to print.
8. Click OK.
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Editing document properties
The Web Intelligence document properties are divided into groups in the
Document Properties pane. To expand a group to see the properties it
contains, click the down arrow button next to the group name. When you
expand a group, the down arrow button changes to an up arrow button. Click
this button to contract the group.

You display the Document Properties pane by right-clicking a report outside
all report components and selecting Document Properties from the menu.

DescriptionPropertyGroup

The document creator.Created byDocument Information

The last user to modify
the document.Last modified by

The date the document
was created.Creation date

The document name.Name

The document descrip-
tion.Description

The document keywords.Keywords

The document formatting
locale.Locale

Indicates whether data
tracking is activated.Data tracking

Tells Web Intelligence to
refresh the document
when it is opened.

Refresh on openDocument Options

Optimizes the document
appearing for on-screen
viewing.

Enhanced Viewing
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Tells Web Intelligence to
drill in query drill mode.Use query drill

Permanently associates
the current document lo-
cale with the document.

Permanent regional for-
matting

Tells Web Intelligence to
synchronize data
providers by merging di-
mensions automatically
under certain conditions.

Auto-merge dimensionsData Synchronization
Options

Tells Web Intelligence to
extend dimension values
in reports with synchro-
nized data providers.

Extend merged dimen-
sion values

Sets the report order in a
document.Report Order

To display document properties

• Right-click a report outside all report components and select Document
Properties from the menu, or click ... next to the General > Document
Properties property on the Data tab.

To purge data from a document
1. Click Purge Data on the main toolbar.

Web Intelligence purges the data from the document.

2. If the document contains multiple queries and you want to purge the data
from a specific query, click the arrow at the right of the Purge Data button
and select Purge <Query name> from the menu.
Web Intelligence purges the data from the query.
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More Information

A



LocationInformation Resource

http://www.sap.comSAP BusinessObjects product
information

Select http://help.sap.com > SAP BusinessObjects.

You can access the most up-to-date documentation cover-
ing all SAP BusinessObjects products and their deployment
at the SAP Help Portal. You can download PDF versions
or installable HTML libraries.

Certain guides are stored on the SAP Service Marketplace
and are not available from the SAP Help Portal. These
guides are listed on the Help Portal accompanied by a link
to the SAP Service Marketplace. Customers with a mainte-
nance agreement have an authorized user ID to access
this site. To obtain an ID, contact your customer support
representative.

SAP Help Portal

http://service.sap.com/bosap-support > Documentation
• Installation guides: https://service.sap.com/bosap-inst

guides
• Release notes: http://service.sap.com/releasenotes

The SAP Service Marketplace stores certain installation
guides, upgrade and migration guides, deployment guides,
release notes and Supported Platforms documents. Cus-
tomers with a maintenance agreement have an authorized
user ID to access this site. Contact your customer support
representative to obtain an ID. If you are redirected to the
SAP Service Marketplace from the SAP Help Portal, use
the menu in the navigation pane on the left to locate the
category containing the documentation you want to access.

SAP Service Marketplace

https://boc.sdn.sap.com/

https://www.sdn.sap.com/irj/sdn/businessobjects-sdklibrary
Developer resources
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LocationInformation Resource

https://www.sdn.sap.com/irj/boc/businessobjects-articles

These articles were formerly known as technical papers.

SAP BusinessObjects articles
on the SAP Community Net-
work

https://service.sap.com/notes

These notes were formerly known as Knowledge Base ar-
ticles.

Notes

https://www.sdn.sap.com/irj/scn/forumsForums on the SAP Communi-
ty Network

http://www.sap.com/services/education

From traditional classroom learning to targeted e-learning
seminars, we can offer a training package to suit your
learning needs and preferred learning style.

Training

http://service.sap.com/bosap-support

The SAP Support Portal contains information about Cus-
tomer Support programs and services. It also has links to
a wide range of technical information and downloads.
Customers with a maintenance agreement have an autho-
rized user ID to access this site. To obtain an ID, contact
your customer support representative.

Online customer support

http://www.sap.com/services/bysubject/businessobjectscon
sulting

Consultants can accompany you from the initial analysis
stage to the delivery of your deployment project. Expertise
is available in topics such as relational and multidimensional
databases, connectivity, database design tools, and cus
tomized embedding technology.

Consulting
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Index
#MULTVALUE error message

and detail objects 256
#RANK error message 272

2D bar charts
varying the data markers on 185

2D charts 175
drilling on 238

2D line charts
varying the data markers on 185

3D charts 174
drilling on 238

3D look
applying to charts 180

3D surface charts
incompatibility with drilling on measures 240

508 compliance
and the HTML Report Panel 26

A
accessing universes in Connected mode 53
accessing universes in Offline mode 53
accessing universes in Standalone mode 53
activating alerters 281
activating data tracking 289
activating query drill 245
Active Server Pages (ASP)

and the Java Report Panel 25
added data

tracking 288
adding alerters 281
adding charts to reports 23, 176
adding columns to tables 140, 141
adding custom query filters 79

adding drill filters 242
adding formulas to reports 23
adding input controls 210
adding rows to tables 140, 141
adding tables to reports 23
adding titles to charts 180
aggregating duplicate rows 150
aggregation

avoiding for duplicate rows 150
alerters

activating 281
adding 281
and data tracking 298
building 281
deactivating 281
defined 280
duplicating 281
editing 281
extent of support for in Web Intelligence

280
formatting data using 283
prioritizing 281
removing 281
sub-alerters defined 281
using formulas to create 283

aligning elements on reports 45
Allow Other Users to Edit All Queries property

71
ambiguous queries 69
Analysis panel

organizing input controls on 213
analyzing data using drill 224
And operator 88
answering cascading prompts 93
answering prompts 206
answering prompts with dates 206
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applying 3D look to charts 180
applying alerters to cells, tables or sections 280
applying custom formats 193
applying custom sorts to data 169
applying different formats using sub-alerters

281
applying different templates to tables 139, 140
applying formatting with the Format Painter 146
applying predefined formats 188
applying security in Connected mode 41
applying security in Offline mode 42
applying sorts to data 169
applying using values from another query 81
area charts 173
ascending sort order 168
ascending sorts

applying to data 169
associating hyperlinks with cells 341
associating lists of values with input controls

210, 212
associating report elements with input controls

210, 212
associating report objects with input controls

210, 212
autofit height

effect of with autofit width 146
effect of with wrap text 146

autofit height cell property 145
autofit width

effect of with autofit height 146
effect of with wrap text 146

autofit width cell property 145
automatic data tracking mode 289
autosaved documents

how Web Intelligence manages 381
autosaving documents 379
Average standard calculation

inserting in tables 218
avoiding duplicate row aggregation 150
avoiding page breaks in breaks 166
avoiding page breaks in charts 181
avoiding page breaks in sections 164

avoiding page breaks in tables 151
axes

defining value frequency on 184
displaying logarithmically 185
formatting labels on in charts 182
formatting numbers on 183
formatting text on 183
showing labels on in pie charts 182
showing value ranges on 184

axes grid
formattig on charts 182
hiding on charts 182
showing on charts 182

axis legends
drilling on 241

axis scales
linear 185
logarithmic 185

B
background color

setting on charts 180
background colors

selecting for tables 143
bar charts 172

drilling on measures in 239
bars

drilling on in bar charts 239
Between operator 85, 95, 199
BI services 307

making data available for filtering in 305
testing 310

BI Services
output parameters 317

block filters
and merged dimensions 261

blocks
synchronizing drill on 34

boimg protocol
displaying images using 144
displaying skins using 144
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boolean formats
custom 188, 189
predefined 188

boolean values
formatting 188, 189

borders
formatting on tables/cells 144
modifying on charts 181

Both operator 86, 97
breaks

avoid page breaks in 166
centering values across 166
compared to sections 164
default sort order in 165
defined 164
displaying subtotals using 164
effect on alerters 280
inserting 165
organizing data with 164
prioritizing 165
removing 167
removing duplicate values from 166
repeating footers in 166
repeating headers in 166
repeating values on new page 166
showing break footers 166
showing break headers 166
starting on new page 166

Bring Forward layering option 147
Bring To Front layering option 147
building a subquery 110, 112
building advanced alerters using formulas 283
building alerters 281
building charts 172
building combined queries 104
building complex queries using subqueries 110
building formulas using the Formula Editor 220
building queries on CSV files 60
building queries on Excel files 60
building queries on local data sources 60
building queries on universes 58

business intelligence
and Web Intelligence 22
offline 22
over the web 22

C
calculation context

and data tracking 300
calculations

adding to reports 218
improving performance of 25
including merged dimensions in 251
removing standard calculations 219
standard 255

Cartesian product 258
cascading prompts 93

answering 206
cell properties

autofit height 145
autofit width 145

cells
applying alerters to 280
applying custom formats to 193
applying predefined formats to 188
associating hyperlinks with 341
clearing the contents of 142
creating sections using 161
defining text of as hyperlinks 340
deleting from reports 155
effects of autofit height in 146
effects of autofit width in 146
effects of wrap text in 146
formatting 155
formatting boolean values in 188
formatting borders 144
formatting currencies in 188
formatting dates in 188, 189
formatting numbers in 188, 189
formatting text in 145
free-standing 154
inserting in reports 155
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cells (continued)
layering 147
merging in tables 148
removing section cells 162
setting height and width of 145

Center Value Across Break property
and data tracking 297

centering values across breaks 166
Central Management Console (CMC)

and autosaving 379, 381
configuring Quick Display mode in 127

changed data
and the Center Value Across Break property

297
display of in blocks with breaks 297
display of in charts 297
display of in merged dimensions 293
display of in sections 294
display of in tables 291
formatting 290, 291

changing the chart type 177, 178
changing the drill hierarchy when drilling 234, 

236
changing the order of prompts 72, 100
changing the password 47
changing the reference data for data tracking

290
changing the table type 139, 140
changing variable values using input controls

210
character strings

alphabetical order 165
default sort order on 165

chart axes
defining value frequency on 184
displaying logarithmically 185
drilling on 238
formatting labels on 182
formatting numbers on 183
formatting text on 183
showing labels on in pie charts 182
showing value ranges on 184

chart axis scales
linear 185
logarithmic 185

chart types
changing 178

charts
2D charts 175
3D charts 174
adding titles to 180
adding to reports 23, 176
area charts 173
avoiding page breaks in 181
axis labels 172
bar charts 172
building 172
changing the type of using drag and drop

177
changing the type of using Turn To 178
copying to other applications 177
copying within reports 177
defining axis value frequency 184
display of changed data in 297
displaying when empty 183
displaying with 3D look 180
displaying Y axes logarithmically 185
drilling on 238
drilling on axis legends 241
drilling on chart axes 238
drilling on measures in 239, 240
fine-tuning the formatting of 126
formatting axis labels on 182
formatting axis values 183
formatting floors 181
formatting legends on 181
formatting the axes grid on 182
formatting titles of 180
formatting walls 181
hiding the axes grid on 182
inserting and formatting titles 180
limitations when drilling on measures in 240
limitations when saving as Excel 377
line charts 173

392 Building Reports with Web Intelligence Rich Client

Index



charts (continued)
linear axis scales defined 185
logarithmic axis scales defined 185
modifying borders on 181
pie charts 174
polar charts 174
publishing as web services 304
radar charts 174
removing 177
resizing 179
scatter charts 174
selecting floors 181
selecting walls 181
setting the background color on 180
setting the position of 147, 178
setting the relative position of 179
showing a range of axis values 184
showing axis labels on pie charts 182
showing legends on 181
showing or hiding values on 184
showing the axes grid on 182
specifying a color palette for data in 183
synchronizing drill across 237
types of 172
using as input controls 213
varying data markers on 185
X-Axis 174, 175
Y-Axis 174, 175
Z-Axis 174, 175

choosing a drill path 230
choosing a query context 70
choosing which dimensions to merge 248
classes

relationship with objects 59
role of 59

classic measures 60
Clear Contexts query property 72
clearing query contexts 72
clearing the contents of cells 142
CMC

and autosaving 379, 381
configuring Quick Display mode in 127

CMS 22
and Local Security Information (LSI) files

42, 53
connecting to in Connected mode 41, 49
connecting to in Offline mode 42
importing universes from 54
linking to documents in 343, 344
restrictions on importing documents from

43
working with documents in 41

colors
selecting alternate for rows/columns 143
selecting table background color 143
setting the background color on charts 180
specifying a palette for chart data 183

columns
adding to tables 140, 141
creating crosstabs by moving 149
hiding when empty 149
moving in tables 141
removing from tables 141
replacing in tables 142
selecting alternate colors for 143
showing when empty 149
swapping in tables 141

combined queries
and SQL 104
building 104
compared with multiple queries 65
compared with synchronized queries 65
defined 102
example of 105
how to structure 105
how Web Intelligence generates 104
intersection 102
minus 102
precedence in 106, 107
setting precedence in 108
union 102
uses of 103

combining prompts 92, 100
combining prompts with query filters 100
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combining query filters 88
example of 87

combining report filters 202
comma-separated values (CSV)

saving documents as 379
Connected mode

accessing universes in 53
applying security in 41, 48, 49
connecting to a CMS in 41
launching Web Intelligence Rich Client from

InfoView in 48
launching Web Intelligence Rich Client in

41
launching Web Intelligence Rich Client in

locally 49
connecting to a CMS 41, 42
connecting to a CMS in Connected mode 48, 

49
Connection Server

and Offline mode 50, 53
contexts

and universes 70
choosing when running queries 70
clearing 72
defined 70
resetting on refresh 72

copying charts to other applications 177
copying charts within reports 177
copying free-standing cells 155, 156
copying SQL to clipboard 66
copying tables as text 152
copying tables to other applications 151, 152
copying tables within reports 151
Count standard calculation

inserting in tables 218
creating

creating variables 219
creating a database ranking 118
creating a prompt 98
creating an optional prompt 98
creating documents 24
creating documents from InfoView 376

creating quick query filters 79
creating quick report filters 201
creating report filters using the Filter Editor 201
creating sections using table cells 161
creating sections using the Data tab 161
creating simple report filters 203
creating subsections using table cells 162
creating subsections using the Data tab 162
creating tables using drag and drop 137
creating tables using table templates 138
creating variables from formulas 221
creating variables using the Variable Editor 221
crosstabs 135

displaying object names in headers 150
drilling up in 233
inserting standard calculations in 218
prioritizing breaks in 165
transforming tables to 148, 149

CSV
saving documents as 379

CSV files
building queries on 60
options when used as local data sources

61
currency formats

custom 188, 189
predefined 188

currency values
formatting 188, 189

custom date and time formats 188, 189
custom formats

applying 193
defining 192

custom number formats 188, 189
custom query filters 77, 79

adding and removing 79
custom scope of analysis level 68, 226
custom sort order 168
custom sorts

applying to data 169
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D
data

analyzing 23
analyzing using drill 224
changes to in charts 297
changes to in merged dimensions 293
changes to in sections 294
changes to in tables 291
comparing in bar charts 172
displaying 132
displaying date of last refresh 154
displaying in crosstabs 135
displaying in forms 136
displaying in horizontal tables 135
displaying in vertical tables 134
displaying segments of 174
displaying total amounts of 173
displaying trends over time in 173
displaying using the Document Locale 36
displaying using the Preferred Viewing

Locale 37
drilling down on 231
example of ranking at database level 119
examples of ranking at report level 273
examples of report-level ranking of 271
filtering 23
filtering at query level 77, 197
filtering at report level 77, 197
filtering using input controls 210, 214
filtering using quick report filters 201
filtering using report filters 196
filtering using simple report filters 203
filtering using the Filter Editor 201
filtering with drill filters 242
formatting changes to 290, 291
grouping with sections 158
hiding 132
hiding changes to 290
highlighting ranges of using alerters 283
highlighting using alerters 280, 281, 283
prioritizing multiple sorts on 170

data (continued)
purging from data providers 384
purging from documents 384
ranking at database level 116, 118
ranking at the report level 266
ranking using the Rank function 272
ranking using the Web Intelligence interface

272
refreshing 206, 289
refreshing in drilled reports containing

prompts 243
returning reference data using RefValue

299
returning the date of the reference data 299
setting as reference data 288
showing changes to 290
sorting 23, 168, 169
specifying a color palette for in charts 183
synchronizing from different sources 248
tracking changes to 288
tracking changes to using formulas 298

data markers
drilling on in line charts 239
drilling on in radar line charts 239

data providers
purging data from 384
synchronizing with different aggregation

levels 255
data sampling

and Query - HTML 72
and the Java Report Panel 72

Data tab 122
creating sections using 161
creating subsections using 162

data tracking
activating 289
and alerters 298
and charts 297
and merged dimensions 293
and sections 294
and table breaks 297
and tables 291
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data tracking (continued)
and the calculation context 300
and the Center Value Across Break property

297
automatic mode 289
changing the reference data for 290
defined 288
formatting changed data 290
hiding changed data 290
incompatibility with drilling out of scope

297, 298
incompatibility with purging documents 297
incompatibility with query drill 297
incompatibility with Refresh on Open

property 298
incompatibility with SQL changes 297
manual mode 289
returning reference data using RefValue

299
showing changed data 290
types of data change 288
viewing whether activated 383, 384

data tracking options
Auto-update the reference data 289, 290
Use the current data as reference data

289, 290
database rankings

advantages of 116
and SQL 116
creating 118
example of 119
parts of 117

databases
and Web Intelligence queries 66
sampling support in 72

date and time formats
custom 188, 189
predefined 188

date and time values
formatting 188

date prompts 98

dates
answering prompts with 206

dates and times
formatting 188, 189

deactivating alerters 281
decreased data

tracking 288
default sort order 168

in breaks 165
on character strings 165
on numeric values 165

Default standard calculation
inserting in tables 218

default universe 32
defining cell text as hyperlinks 340
defining custom formats 192
defining filters for web services 305
defining how input controls filter data 210, 212
defining merged dimensions 254
defining sections as empty 163
defining value frequency on chart axes 184
deleting documents from InfoView 376
deleting free-standing cells from reports 155
deleting hyperlinks 349
deleting merged dimensions 255
deleting report filters 203
deleting variables 222
descending sort order 168
descending sorts

applying to data 169
detail objects

and #MULTVALUE 256
and merged dimensions 256
defined 59
relationship with dimensions 59, 256, 258

Different From operator 84, 94, 198
Different From Pattern operator 86, 97
dimension objects

defined 59
dimensions

choosing which dimensions to merge 248
creating sections using 161
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dimensions (continued)
defining merged dimensions 254
deleting merged dimensions 255
displaying in crosstabs 135
drilling by 236
drilling down on 233
drilling on 231
drilling on in charts 238, 239, 241
drilling on merged dimensions 261
drilling up on 233
editing merged dimensions 254
extending merged values of 383, 384
extending values returned by 261, 263
merged dimensions defined 248
merging 253
merging automatically 254, 383, 384
merging when detail objects are associated

256
ranking dimensions 117
restrictions on placing in tables 258
understanding the effects of merging 255
when to merge 248

dispaying report data 132
displaying added queries in documents 62
displaying charts when empty 183
displaying charts with 3D look 180
displaying data using the Document Locale 36
displaying data using the Preferred Viewing

Locale 37
displaying default values in prompts 98
displaying empty sections 163
displaying footers 126
displaying headers 126
displaying hierarchical lists of values 94
displaying images/skins in tables 144
displaying lists of values in prompts 98
displaying object names in crosstab headers

150
displaying page margins 126
displaying prompts 206
displaying subtotals using breaks 164
displaying the current page number 154

displaying the document name 154
displaying the drill filters in a report 154
displaying the Formula toolbar 219
displaying the grid on reports 45
displaying the last refresh date 154
displaying the welcome wizard on startup 44
displaying Y axes logarithmically 185
document creation and viewing options 29
document instances

linking to in the CMS 344, 346
document locale

using to format data 46
Document Locale

defined 35, 36
displaying data using 36

document properties
editing 383, 384
Refresh on Open 298

DocumentName function 154
documents

applying security to 41, 42
creating from InfoView 376
deleting from InfoView 376
displaying added queries in 62
displaying the names of 154
displaying the queries in 154
editing properties of 383, 384
how Web Intelligence manages autosaving

381
linking to large documents using hyperlinks

347
linking to using hyperlinks 340, 343, 344, 

348
navigating 23
opening from InfoView 376
optimizing for on-screen viewing 383, 384
permanently associating a locale with 383, 

384
permanently associating locales with 37
printing 23, 382
recovering autosaved documents 380
Refresh on Open property 298
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documents (continued)
refreshing on open 383, 384
saving as CSV 379
saving as Excel 44, 377
saving as PDF 378
saving automatically 379
saving in drill mode 243
saving in InfoView 377
selecting creation and viewing options 29
selecting default universe for 44
selecting folder for 44
selecting the default universe for 32
tools for creating and editing 24
viewing 23
viewing the creation date of 383, 384
viewing the creator of 383, 384
viewing the description of 383, 384
viewing the keywords associated with 383, 

384
viewing the locale of 383, 384
viewing the name of 383, 384

Draft mode
defined 126

drill
activating query drill 245
adding and removing drill filters 242
and data tracking 298
and drill paths 227
changing values on drill toolbar 242
choosing a drill path 230
defined 224
drill by 234, 236
drill filters 241
Drill toolbar 241
drilling down 231
drilling down on dimensions 233
drilling down on measures 236
drilling on axis legends 241
drilling on chart axes 238
drilling on charts 238
drilling on dimensions 231
drilling on measures 236

drill (continued)
drilling on measures in charts 240
drilling on merged dimensions 261
drilling out of scope 229
drilling up 233
drilling up on dimensions 233
drilling up on measures 237
hiding the drill toolbar 33
hiding the Drill toolbar 46
limitations when drilling on charts 240
prompting if additional data required for 46
query drill defined 243
retrieving more levels of data 229
setting options 33
snapshots 23
starting 34
starting on duplicate report 34, 46
starting on existing report 46
switching to drill mode 228
synchronizing across charts 237
synchronizing across tables 237
synchronizing on blocks 34, 46
taking drill snapshots 230
viewing drill hierarchies 228

drill by 236
drill filters 241

adding and removing 242
and drill down 231
and prompts 243
and query drill 243
changing on Drill toolbar 242
displaying 154
hiding 46
saving reports with 243

Drill Filters function 154
drill hierarchies

and drill by 234
viewing 228

drill mode
and input controls 213
and the scope of analysis 67, 225
switching to 228
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drill options
hide drill toolbar option 33
prompt for additional data option 33
setting 33
start drill on duplicate report option 34
start drill on existing report option 34
start drill session option 34
synchronize drill on report blocks option 34

drill out of scope
prompting before 46

drill paths
and universe hierarchies 227
choosing between 230
selecting 227

drill snapshots 23
and query drill 246
incompatibility with query drill 245, 246
taking 230

Drill toolbar 241
adding and removing filters on 242
changing filter values on 242
filters on during drill down 231
hiding 33, 46

drill up
using query drill 245

DrillFilters function 243
drilling by different hierarchies 234, 236
drilling down 231
drilling down on dimensions in sections 233
drilling down on dimensions in tables 233
drilling down on measures 236
drilling down using query drill 243, 245
drilling on axis legends in charts 241
drilling on chart axes 238
drilling on charts 238
drilling on data 224
drilling on dimensions in sections 231
drilling on dimensions in tables 231
drilling on measures in charts 239, 240
drilling on measures in sections 236
drilling on measures in tables 236
drilling on merged dimensions 261

drilling on reports 23
drilling out of scope 229

incompatibility with data tracking 297, 298
drilling up 233
drilling up in crosstabs 233
drilling up on dimensions 233
drilling up on measures 237
drilling up using query drill 243, 245
drilling using query drill 243
duplicate rows

aggregating 150
duplicating alerters 281
duplicating queries 64
duplicating tables 139

E
editing alerters 281
editing document properties 383, 384
editing documents 24
editing hyperlinks 349
editing input controls 212
editing merged dimensions 254
editing queries 64
editing report filters 202
editing report filters from the repory map 203
editing the query SQL 66
editing variables 222
effects of report filters on merged dimensions

260
empty charts

displaying 183
Enhanced Viewing mode

defined 129
selecting 129

entering formulas using the Formula toolbar
220

Equal To operator 78, 83, 94, 197, 198
error messages

#RANK 272
example of a combined query 105
example of a database ranking 119

Building Reports with Web Intelligence Rich Client 399

Index



example of a subquery 112
example of cascading prompt 93
example of merged dimensions 249
examples of report-level rankings 271, 273
Excel

saving documents as 377
Excel document format

prioritizing data processing in 44
prioritizing formatting in 44

Excel files
building queries on 60

Except operator 86, 97
extending merged dimension values 383, 384
extending the scope of analysis 229
extending the values returned by 263
extending the values returned by merged

dimensions 261, 263

F
filltering data with drill filters 242
Filter Editor

creating report filters using 201
filtering blocks containing merged dimensions

261
filtering data 23
filtering data in queries 77, 197
filtering data in reports 77, 197
filtering data using input controls 210, 214
filtering data using simple report filters 203
filtering data using the Filter Editor 201
filtering data with quick report filters 201
filtering merged dimensions 259, 260
filtering queries on values from other queries

81
filtering sections 196, 261
filters

adding custom query filters 79
combining report filters 202
creating quick query filters 79
creating quick report filters 201
custom query filters 77

filters (continued)
deleting report filters 203
editing report filters 202
hiding drill filters 46
nesting query filters 89
predefined query filters 77
query filters defined 76
quick query filters 77
removing custom query filters 79
report filters 196
report filters and merged dimensions 260
selecting a predefined query filter 78
viewing report filters 204

fine-tuning the formatting of reports 126
fixed data sampling 72
floors

formatting on charts 181
selecting on charts 181

footers
displaying 126
repeating on every page 151
showing and hiding in tables 150

ForceMerge function
example of 251

Format Painter
applying formatting with 146

formats
applying custom formats 193
applying predefined formats 188
defining custom formats 192

formatting
applying with the Format Painter 146

formatting axis values on charts 183
formatting boolean values 188
formatting changed data 291
formatting chart axis labels 182
formatting chart floors 181
formatting chart legends 181
formatting chart titles 180
formatting chart walls 181
formatting currency values 188, 189
formatting data using alerters 283
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formatting data with the document locale 46
formatting data with the formatting locale 46
formatting dates and times 188
formatting decreased data 290
formatting free-standing cells 155
formatting increased data 290
formatting inserted data 290
formatting locale

selecting 46
using to format data 46

formatting numbers 188
formatting numbers and dates 189
formatting removed data 290
formatting table and cell borders 144
formatting text in cells 145
formatting the axes grid on charts 182
Formatting toolbar 122
forms 136
Formula Editor

building formulas using 220
opening 219

Formula toolbar
displaying 219
entering formulas using 220

formulas
adding to reports 218
building alerters using 283
building using the Formula Editor 220
creating variables from 221
entering using Formula toolbar 220
example using RefValue 299
including in reports 23
typing in the Formula toolbar 220
using to track data changes 298
validating 219

free-standing cells 154
and section headers 164
applying alerters to 280
copying as text 155, 156
copying to other applications 155, 156
copying within reports 155
deleting from reports 155

free-standing cells (continued)
formatting 155
inserting in reports 155
restrictions on copying 155

functions
DocumentName 154
DrillFilters 154, 243
ForceMerge 251
GetContentLocale 36
GetLocale 35
GetPreferredViewingLocale 37
If 299
LastExecutionDate 154
NumberOfPages 154
Page 154
PromptSummary 154
QuerySummary 154
Rank 272
RefValue 299
RefValueDate 299
ReportFilterSummary 154

G
GetContentLocale function 36
GetLocale function 35
GetPreferredViewingLocale function 37
Greater Than operator 84, 95, 198
Greater Than Or Equal To operator 84, 95, 

198
grouping data with sections 158

H
headers

displaying 126
displaying object names in 150
repeating on every page 151
showing and hiding in tables 150

height
setting on cells 145

hiding changed data 290
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hiding drill filters 46
hiding empty columns 149
hiding empty rows 149
hiding empty sections 163
hiding empty tables 149
hiding footers in tables 150
hiding headers in tables 150
hiding report data 132
hiding the axes grid on charts 182
hiding the drill toolbar 33
hiding the Drill toolbar 46
hiding values on charts 184
highlighting data ranges using alerters 283
highlighting data using alerters 280, 281, 283
highlighting input control dependencies 212
horizontal records per page

changing in the Java Report Panel 128
changing in Web Intelligence Interactive

128
restricting 127

horizontal tables 135
prioritizing breaks in 165

how to structure combined queries 105
how Web Intelligence merges prompts 93
HTML Report Panel

and 508 compliance 26
and JSP 26
defined 26
selecting as document creation tool 29

hyperlinks
associating with cells 341
defining cell text as 340
deleting 349
editing 349
linking to document instances with 346
linking to documents with 348
linking to large documents with 347
passing values to prompts with 346
setting colors 349

I
If function 299
images

displaying from a URL 144
displaying in tables 144
displaying using boimg protocol 144

importing universes from a CMS 54
improving calculation performance 25
In List operator 78, 85, 96, 200
including database rankings in queries 116
including merged dimensions in calculations

251
incompatible objects

and merged dimensions 258
placing in tables 258

increased data
tracking 288

InfoView 22
accessing Web Intelligence from 28
creating documents from 376
deleting documents from 376
installing Web Intelligence Rich Client from

40
launching Rich Client in Connected mode

from 48
logging in to 28
logging out of 29
opening documents from 376
saving documents in 377
selecting document creation and viewing

options in 29
selecting the default universe in 32
selecting the document view format in 32
selecting the query editor in 32
setting drill options in 33
setting locale options in 35
setting the Preferred Viewing Locale in 37
setting the Product Locale in 35

input controls
adding 210
associating lists of values with 210
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input controls (continued)
associating report elements with 210, 212
associating report objects with 210
changing variable values using 210
defined 210
editing 212
filtering data using 214
highlighting dependencies 212
organizing 213
using charts as 213
using tables as 213
viewing the map of 213

inserting breaks in tables 165
inserting free-standing cells in reports 155
inserting standard calculations in tables 218
installing Web Intelligence Rich Client 40
installing Web Intelligence Rich Client from

InfoView 40
interface locale

selecting 46
setting 35

interrupting queries 62
intersection combined queries 102
Is Not Null operator 200
Is Null operator 200

J
Java Report Panel

and data sampling 72
and the scope of analysis 68, 226
and Web Intelligence Rich Client 25
availability of report filters in 197
defined 25
reporting interface described 122
selecting as document creation and viewing

tool 29
Java Server Pages (JSP)

and interactive view format 29
and on-report analysis 23
and Query - HTML 24
and the HTML Report Panel 26

Java Server Pages (JSP) (continued)
and the Java Report Panel 25

L
LastExecutionDate function 154
launching Web Intelligence Rich Client 47
launching Web Intelligence Rich Client in

Connected mode 48, 49
launching Web Intelligence Rich Client in Offline

mode 50
launching Web Intelligence Rich Client in

Standalone mode 51
layering options

Bring Forwards 147
Bring To Front 147
Send Backwards 147
Send To Back 147

layering tables and cells 147
legends

formatting on charts 181
showing on charts 181

Less Than operator 84, 95, 199
Less Than Or Equal To operator 84, 95, 199
limitations when drilling on charts 240
line charts 173

drilling on measures in 239
linear axis scales 185
linking to document instances using hyperlinks

346
linking to documents in the CMS 343, 344
linking to documents using hyperlinks 340, 348
linking to large documents using hyperlinks

346, 347
lists of values

associating with input controls 210, 212
displaying in prompts 98
hierarchical 94
restricting prompt responses to 98

local data providers
default search locations for 65
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local data sources
building queries on 60
CSV file options 61
Excel file options 61

locales
defined 35
Document Locale 35, 36
permanently associating documents with

383, 384
permanently associating with documents

37
Preferred Viewing Locale 35, 37
Product Locale 35
selecting the formatting locale 46
selecting the interface locale 46
using document locale to format data 46
using formatting locale to format data 46

logarithmic axis scales 185
logging in as a different user 52
logging in to InfoView 28
logging out of InfoView 29
LSI (Local Security Information) files 42

in Offline mode 42, 53

M
Main toolbar 122
making SQL editable 66
managing host servers for web services 305
managing published web services 308
manual data tracking mode 289
Map tab 122

editing report filters from 203
Matches Pattern operator 85, 96
Max Retrieval Time query property 71
Max Rows Retrieved query property

compared to Sample Result Set property
71

Maximum standard calculation
inserting in tables 218

measure objects
defined 60

measures
and query drill 244
displaying in crosstabs 135
drilling down on 236
drilling on in charts 239, 240
drilling on in sections 236
drilling on in tables 236
drilling up on 237
formatting decreases in 290
formatting increases in 290
limitations on drill in charts 240
restrictions on calculating 255
restrictions on in pie charts 174

merged dimensions
and block filters 261
and detail objects 256
and incompatible objects 258
and section filters 261
choosing which dimensions to merge 248
creating 253
defined 248
defining 254
deleting 255
display of changed data in 293
drilling on 261
editing 254
example of 249
extending values returned by 261, 263
filtering 259, 260
including in calculations with ForceMerge

251
merging automatically 254
placing in tables 258
understanding the effects of 255
when to merge 248

merging cells in tables 148
merging dimensions 253
merging dimensions automatically 254, 383, 

384
merging prompts 93
middleware

and Offline mode 42
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middleware (continued)
and Standalone mode 43, 53

Minimum standard calculation
inserting in tables 218

minus combined queries 102
modified data

tracking 288
modifying chart borders 181
modifying reports using Results View 137
modifying reports using Structure View 137
moving rows or columns in tables 141
multiple queries 64

compared with combined queries 65
compared with synchronized queries 65

multiple reports
and query drill 246

N
naming sections 163
nesting prompts 92
nesting query filters 88, 89
Not Between operator 85, 96, 199
Not Equal To operator 83, 94, 198
Not In List operator 85, 96, 200
number formats

custom 188, 189
predefined 188

NumberOfPages function 154
numbers

formatting 188, 189
formatting on chart axes 183

O
objects

applying different formats to using
sub-alerters 280, 281

applying formats to using alerters 280, 281
classic measure 60
detail 59
dimension 59

objects (continued)
displaying names of in crosstab headers

150
measure 60
relationship with classes 59
smart measure 60

Offline mode
accessing universes in 53
and Connection Server 53
applying security in 53
launching Web Intelligence Rich Client in

50
Offlline mode

applying security in 42
OLAP

and query drill 244
on-report analysis 23
online help

referencing from server 44
selecting folder for 44

openDocument 350
intput parameters 361
output parameters 368
parameter overview 353
platform parameters 356
syntax 350

OpenDocument
linking to documents using 343, 344

opening documents from InfoView 376
opening the Formula Editor 219
operators

And 88
Between 85, 95, 199
Both 86, 97
Different From 84, 94, 198
Different From Pattern 86, 97
Equal To 78, 83, 94, 198
Except 86, 97
Greater Than 84, 95, 198
Greater Than Or Equal To 84, 95, 198
In List 78, 85, 96, 200
Is Not Null 200
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operators (continued)
Is Null 200
Less Than 84, 95, 199
Less Than Or Equal To 84, 95, 199
Matches Pattern 85, 96
Not Between 85, 96, 199
Not Equal To 83, 94, 198
Not In List 85, 96, 200
Or 88

optimizing documents for on-screen viewing
383, 384

optional prompts 206
and SQL 66
creating 98
defined 92

Or operator 88
organizing data using breaks 164
organizing input controls 213

P
page breaks

avoiding in charts 181
avoiding in sections 164
avoiding in tables 151

Page function 154
page margins

displaying 126
Page mode 126

defined 126
Page Navigation toolbar 122

changing horizontal records per page using
128

changing vertical records per page using
128

page-to-page navigation 23
pages

displaying the current page number 154
displaying the total number of 154
setting minimum height of 127
setting minimum width of 127
starting sections on new 164

parameters
openDocument 356, 361, 368
openDocument overview 353

parts of a database ranking 117
parts of a report-level ranking 269
parts of a subquery 112
passing values to prompts in hyperlinks 346
password

changing 47
PDF

saving documents as 378
PDF mode

defined 126
Percentage standard calculation

inserting in tables 218
permanently associating a locale with

documents 383, 384
pie charts 174

drilling on measures in 239
showing axis labels on 182

polar charts 174
Portable Document Format (PDF) 23

saving documents as 378
viewing documents as 29
viewing reports in 126

positioning sections 164
precedence in combined queries 106, 107
predefined boolean formats 188
predefined currency formats 188
predefined date and time formats 188
predefined formats

applying 188
predefined number formats 188
predefined query filters 77, 78
Preferred Viewing Locale

defined 35, 37
setting 37

Previous function
and report-level rankings 272

printing documents 382
printing reports 23, 126, 382
prioritizing alerters 281
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prioritizing breaks 165
prioritizing data processing in Excel format 44
prioritizing formatting in Excel format 44
prioritizing sorts 170
Product Locale

defined 35
setting 35

prompt operators
Between 85, 95, 199
Both 86, 97
Different From 84, 94, 198
Different From Pattern 86, 97
Equal To 83, 94, 198
Except 86, 97
Greater Than 84, 95, 198
Greater Than Or Equal To 84, 95, 198
In List 85, 96, 200
Less Than 84, 95, 199
Less Than Or Equal To 84, 95, 199
Matches Pattern 85, 96
Not Between 85, 96, 199
Not Equal To 83, 94, 198
Not In List 85, 96, 200

prompting if drill requires additional data 46
prompts

answering 206
answering cascading prompts 93
answering with dates 206
changing the order of 72, 100
combining 100
combining with query filters 100
creating 98
defined 92
displaying 206
displaying a default value in 98
displaying a summary of 154
displaying hierarchical lists of values in 94
displaying lists of values in 98
displaying the previously-selected value in

98
example of cascading prompt 93
merging 93

prompts (continued)
optional prompts 206
passing values to in hyperlinks 346
publishing in web services 307
refreshing data in reports containing 243
removing 98

PromptSummary function 154
Properties tab 122

using to set section properties 164
publishing prompts in 307
publishing prompts in web services 307
publishing QaaWS (Query as a Web Service

310
publishing QaaWS (Query as a Web Service)

311
publishing tables as web services 304
purging data from documents 384
purging documents

incompatibility with data tracking 297

Q
QaaWS

publishing 310, 311
queries
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